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Spine Toolbox is an application, which provides means to define, manage, and execute complex data processing and
computation tasks, such as energy system models.

You can either start reading from the first page onwards or go straight to the Getting Started section to get you started
quickly. If you need help understanding the terms we use throughout the app and this User Guide, please check the
Terminology section. If you want to contribute to this project, please see the Contribution Guide for Spine Toolbox.
The last section contains the complete code reference of Spine Toolbox.

Contents: 1
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CHAPTER 1

Getting Started

Welcome to the Spine Toolbox’s getting started guide. In this guide you will learn two ways of running a “Hello,
World!” program on Spine Toolbox. The following topics are touched (although not exhaustively covered):

* Spine Toolbox Interface

* Creating a Project

* Creating a Tool specification

* Adding a Tool item to the project

* Executing a Tool

» Editing a Tool specification

* Adding a Data Connection item to the project

* Adding data files to a Data Connection

» Connecting project items

1.1 Spine Toolbox Interface

The central element in Spine Toolbox’s interface is the Design View, where you can visualize and manipulate your
project in a pictorial way. Alongside Design View there are a few ‘dock widgets’ that provide additional functionality:

* Project provides a more concise view of your project, including:

— Items currently in the project, grouped by category: Data Stores, Data Connections, Tools, Views, Im-
porters and Exporters.

— Tool specifications available in the project.

* Properties provides an interface to interact with the currently selected project item.
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» Event Log shows relevant messages about every performed action.
* Process Log shows the output of executed Tools.

* Julia console provides an interface to interact with the Julia programming language, and also allows Spine
Toolbox to execute Julia Tools.

* Python console provides an interface to interact with the Python programming language, and also allows Spine
Toolbox to execute Python Tools.

Tip: You can drag-and-drop the Dock Widgets around the screen, customizing the interface at your will. Also,
you can select which ones are shown/hidden using either the View/Dock Widgets menu, or the main menu toolbar’s
context menu. Spine Toolbox remembers your configuration between sessions. Selecting Restore Dock Widgets from
the View/Dock Widgets menu restores the widgets back to their default location.

Tip: Most elements in the Spine Toolbox’s interface are equipped with fool tips. Leave your mouse cursor over an
element (button, view, etc.) for a moment to make the tool tip appear.

1.2 Creating a Project

To create a new project, please do one of the following:
A) From the application main menu, select File -> New project...
B) Press Ctrl+N.

The Select project directory (New project. .. ) dialog will show up. Browse to a folder of your choice and create a new
directory called ‘hello world’ there. Then select the ‘hello world’ directory. Spine Toolbox will populate that directory
with some files and directories it needs to store the project’s data.

Congratulations, you have created a new project.

1.3 Creating a Tool specification

Note: Spine Toolbox is designed to run and connect multiple tools, which are specified using Tool specifications. You
may think of a Tool specification as a self-contained program specification including a list of source files, required and
optional input files, and expected output files. Once a Tool specification is added to a project, it can then be associated
to a Tool item for its execution as part of the project workflow.

In the Project dock widget, click on the ‘add tool specification button’ () just below the Tool specifications list, and
select New from the popup menu. The Edit Tool specification form will appear. Follow the instructions below to create
a minimal Tool specification:

* Type ‘hello_world’ in the Type name here. .. field.
* Select ‘Python’ from the Select type... dropdown list,

* Click on the button right next to the field that reads Add main program file here. .., and select the option Make
new main program from the popup menu.

¢ A file browser dialog should open. Name the file hello_world.py and save it in a folder of your choice, e.g. in
‘hello world’

4 Chapter 1. Getting Started
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After this, the Edit Tool specification form should be looking similar to this:

+ Edit Tool Specification — O x

hello_world e Python -

Execute in work directory

Type description here...

|C:,.’da13f5pine Toolbox Projectsfhello worldhello_world. py

oK

Type command line arguments here... %
Additional source files Input files

Bl 51 M g 1

Optional input files Output files

B SR

Main program directory C:\data\Spine Toolbox Projects\hello world

Click Ok at the bottom of the form. A new system dialog will appear, allowing you to select a file name and location to
save the Tool specification we’ve just created. Don’t change the default file name, which should be hello_world.json.
Just select a folder from your system (it can be the same where you saved the main program file) and click Save.

Now you should see the new tool specification in the Project widget, Tool specifications list.

Tip: Saving the Tool specification into a file allows you to add and use the same Tool specification in another project.
To do this, you just need to click on the add tool button (), select Add existing... from the popup menu, and then
select the tool specification file from your system.

Congratulations, you have just created your first Tool specification.

However, the main program file hello_world.py was created empty, so for the moment this Tool specification does
absolutely nothing. To change that, we need to add instructions to that program file so it actually does something when
executed.

Right click on the ‘hello_world’ item in the Tool specifications list and select Edit main program file... from the

1.3. Creating a Tool specification 5
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context menu. This will open the file hello_world.py in your default editor.

Enter the following into the file’s content:

print ("Hello, World!™)

Save the file.

Now, whenever hello_world.py is executed, the sentence ‘Hello, World!” will be printed to the standard output.

1.4 Adding a Tool item to the project

Note: The Tool item is used to run Tool specifications available in the project.

Let’s add a Tool item to our project, so that we’re able to run the Tool specification we created above. To add a Tool
item drag-and-drop the Tool icon () from the Drag & Drop Icon toolbar onto the Design View.

The Add Tool form will popup. Type ‘say hello world’ in the name field, select ‘hello_world’ from the dropdown list
just below, and click Ok. Now you should see the newly added Tool item as an icon in the Design View, and also as
an entry in the Project dock widget, Items list, under the “Tools’ category. It should look similar to this:

Project & M | Design View

Items
[rata Stores
[Data Connections
* Tools
say hello world say helle world

Views o]
Importers i /\ i

Exporters

Tool spedifications

hello_world

A K ’

1.5 Executing a Tool

As long as the ‘say hello world” Tool item is selected, you will be able to see its Properties on the right part of the
window, looking similar to this:

6 Chapter 1. Getting Started
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Design View Tool Properties g X

say hello world

Spedification | hello_world bl ﬁ

m
a}
vl

m
i

[Tm]
L

say hello world |‘:-:- Specification

Tool specification

/\ j % Source files

[# hello_world.py

R Input files
Opticnal input files
Cutput files
Execute in
(® Work directory () Source directory =

< >

Press execute project button on the toolbar. This will execute the Tool specification ‘hello world’, which in turn will
run the main program file hello_world.py in a dedicated process.

You can see more details about execution in the Event Log. Once it’s finished, you will see its output in the Process
Log or in the Python Console depending on your settings (See Settings).

Event Log & % | Process Log a2 X

Note: If you encounter the following message in Event Log when trying to execute a Python Tool.
Couldn’t determine Python version. Please check the Python interpreter option in Settings.

Please see Setting up External Tools for help.

Congratulations, you just ran your first Spine Toolbox project.

1.5. Executing a Tool 7
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1.6 Editing a Tool specification

To make things more interesting, we will now specify an input file for our ‘hello_world’ Tool specification.

Note: Input files specified in the Tool specification can be used by the program source files, to obtain some relevant
information for the Tool’s execution. When executed, a Tool item looks for input files in Data Connection and Data
Store items connected to its input.

Click on the ‘Tool specification options’ button () in ‘say hello world” Properties, and select Edit Tool specification
from the popup menu. This will open the ‘Edit Tool specification’ form pre-filled with data from the ‘hello_world’
specification.

Click the add input files and/or directories button right below the Input files list. A dialog will appear that lets you
enter a name for a new input file. Type ‘input.txt’ and click Ok. The form should now look like this:

8 Chapter 1. Getting Started



Spine Toolbox Documentation, Release 0.5.0-beta.0

« Edit Tool Specification — O *
hello_waorld| 2 | python w
Execute in work directory

Type description here...
|C:1|,da13‘|5|:line Toolbax Projectsthells worldVhelo_warld. py o | ‘
Type command line arguments here. .. %
Additional source files Input files

El inputted

B 51 W gl W

Optional input files Output files

g W@ gl W

Main program directory C:\data\Spine Toolbox Projects\hello world

Click OK at the bottom of the form.

Note: See Tool specification editor for more information on editing Tool specifications.

So far so good. Now let’s use this input file in our program. Click on the ‘Tool specification options’ button () again,
and this time select Edit main program file... from the popup menu. This will open the file hello_world.py in your
default editor.

Delete whatever it’s in the file and enter the following instead:

with open("input.txt") as input_file:
print (input_file.read())

1.6. Editing a Tool specification 9
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Save the file.

Now, whenever hello_world.py is executed, it will look for a file called ‘input.txt’ in the current directory, and print its
content to the standard output.

Try executing the tool by pressing in the toolbar. The execution will fail. This is because the file ‘input.txt’ is not
made available for the Tool:

Event Log g X

L e Ty

ion hello_world source file
on hello_world program files

tion hello_world in work directory
cification requirements ===

..n':arn:l'uir_ug for reguired input files

[6-03-2020 10:03:36] DAG 1/1 failed W

1.7 Adding a Data Connection item to the project

Note: The Data Connection item is used to hold generic data files, so that other items, notably Importer and Tool
items, can make use of that data.

Let’s add a Data Connection item to our project, so that we’re able to pass the file ‘input.txt’ to ‘say hello world’. To
add a Data Connection item drag-and-drop the Data Connection icon () from the main window toolbar onto the Design
View.

The Add Data Connection form will show up. Type ‘pass input txt’ in the name field and click Ok. Now you should
see the newly added Data Connection item as an icon in the Design View, and also as an entry in the Project dock
widget, Items list, under the ‘Data Connections’ category. It should look similar to this:

10 Chapter 1. Getting Started
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Project g X

Ttems

Data Stores
* Data Connections
pass input txt
¥ Tools
say hello world
Views
Importers
Exporters

Tool specdifications

hello_world

M+

Design View

pass input xt

1.8 Adding data files to a Data Connection

say hello world

As long as the ‘pass input txt” Data Connection item is selected, you will be able to see its Properties on the right part
of the window, looking similar to this:

Design View

€

Data Connection Properties g X
pass input
References
+ =B
Data
~» Datapackage
—)
>

Right click anywhere within the Data box and select New file... from the context menu. When prompted to enter a

name for the new file, type ‘input.txt’ and click Ok.

Now you should see the newly created file in the Data list:

1.8. Adding data files to a Data Connection
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Data Connection Properties g X

pass input o

References

+ - B
Data
|j ~ofldy.spinetoolboxiitems\pass_input_t\input.bd

+» Datapackage

Double click on this file to open it in your default text editor. Then enter the following into the file’s content:

’Hello again, World!

Save the file.

1.9 Connecting project items

As mentioned above, a Tool item looks for input files in Data Connection and Data Store items connected to its input.
Thus, what we need to do now is create a connection from ‘pass input txt’ to ‘say hello world’, so the file ‘input.txt’

gets passed.

To do this, click on one of the connector slots at the edges of ‘pass input txt’ in the Design view, and then on a similar
slot in ‘say hello world’. This will create an arrow pointing from one to another, as seen below:
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Design View
pass input bxt say hello wordd
1] :
h ! '\ i
B -
[] -
< >

Press on the toolbar. The Tool will run successfully this time:

Event Log & X ProcessLlog g X

ected Acyclic Graphs Hello again, World!
Starting DAG 1/1
Ordh input txt - orld

ting Data Coni pass input bt

ting Tool say hello world

ents ==+
ed input *
ion hello_world source files k directory

WO WD

(T

[
[
[
[
g
[
[
[

world__wrbzrgwow
progr =

(=]

BEEE

w

That’s all for now. I hope you’ve enjoyed following this guide as much as I enjoyed writing it. See you next time.

1.9. Connecting project items 13
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CHAPTER 2

Setting up External Tools

This section describes how to set up Python, Julia, GAMS, and SpineOpt.jl for Spine Toolbox.

o Setting up Python
— Step-by-step instructions
* Shell execution
* Python Console execution
— What about Anaconda and Miniconda Pythons?
* Setting up Julia
— Step-by-step instructions
* Shell execution
* Julia Console execution

o Setting up GAMS

o Setting up SpineOpt.jl

Executing Python or Julia Tools requires that Python or Julia are installed on your system. You can download Python
from https://www.python.org/downloads/ and Julia from https://julialang.org/downloads/. In addition, you need an
installation of GAMS to execute GAMS Tools and Exporter project items. GAMS can be downloaded from https:
/lwww.gams.com/download/.

2.1 Setting up Python

If you encounter the following message in Event Log when trying to execute a Python Tool.:

15
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Couldn't determine Python version. Please check the Python interpreter option in
—Settings.

After reading this section, you should know what this message means and how to set up Python for Spine Toolbox so
you can successfully execute Python Tools.

There are two ways you can install Spine Toolbox.

1. Clone Spine Toolbox repository from https://github.com/Spine-project/Spine-Toolbox, checkout the branch you
want and follow installation instructions on the page (README.md).

2. [On Windows] Use a single-file installation bundle (e.g. spine-toolbox-0.4.0-x64.exe). These are available for
download in [Spine Toolbox Release Archive]

If you go with option 1, and you have successfully started the application, you already have a Python that can be used
in executing Python Tools. If you go with option 2, you need to have a Python installed on your system to be able to
execute Python Tools. You can select the Python you want to use on the Tools tab in Settings (See Settings).

——
+— General GAMS
GAMS executable
l;l PFOjECT Using system's default GAMS | |—3
Julia
Tools
2& Julia executable
) Using Julia executable in system path =
@ View | . |
|L|sing Julia home project | =
Use embedded Julia Console
Python
Python interpreter
|L|sing Python interpreter in system path | =
Use embedded Python Console

The Python interpreter you select here is the Python that is used when executing Python Tools with or without the
Embedded Python Console.

The default Python interpreter is the Python that is in your PATH environment variable. If you do not have Python
in your PATH, you can explicitly set the Python you want to use by clicking on the button and selecting the Python
interpreter file (python.exe on Windows). Note that you can use any Python in your system by setting a Python
interpreter here.

Note: Embedded Python Console supports Python versions from 2.7 all the way to latest ones (3.8). Executing

16 Chapter 2. Setting up External Tools
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Python Tools without using the embedded Python Console possibly supports even earlier Pythons than 2.7. You can
start Spine Toolbox only with Python 3.6 or with 3.7, but you can still set up an embedded Python Console into Spine
Toolbox that uses e.g. Python 2.7. This means, that if you still have some old Python 2.7 scripts lying around, you can
incorporate those into a Spine Toolbox project and execute them without any modifications.

2.1.1 Step-by-step instructions

You can either execute Python Tools in the embedded Python Console or as in the shell. Here are the step-by-step
instructions for setting up Spine Toolbox for both.

Shell execution

1. Go to https://www.python.org/downloads/ and download the Python you want

Run the Python installer and follow instructions

Either let the installer put Python in your PATH or memorize the path where you installed it (e.g. C:\Python38)
Start Spine Toolbox

Go to File -> Settings (or press F1) and click the Tools tab open

SAE U i

If the installed Python is now in your PATH, you can leave the Python interpreter line edit blank. Or you can set
the Python interpreter explicitly by setting it to e.g. C:\Python38\python.exe by using the button.

~

Uncheck the Use embedded Python Console check box
8. Create a project with a Tool and a Python Tool specification (See Getting Started)
9. Press play to execute the project (See Executing Projects)

10. Executing your Tool project item starts. You can see the output (stdout and stderr) in the Process Log.

Python Console execution

If you want to use the embedded Python Console (and you should). There is an extra step involved since the Python
Console requires a couple of extra packages (ipykernel and its dependencies) to be installed on the selected Python.
In addition, kernel specifications for the selected Python need to be installed beforehand. Spine Toolbox can install
these for you automatically.

1. Go to https://www.python.org/downloads/ and download the Python you want

Run the Python installer and follow instructions

Either let the installer put Python in your PATH or memorize the path where you installed it (e.g. C:\Python38)
Start Spine Toolbox

Go to File -> Settings (or press F1) and click the Tools tab open

AR

If the installed Python is now in your PATH, you can leave the Python interpreter line edit blank. Or you can set
the Python interpreter explicitly by setting it to e.g. C:\Python38\python.exe by using the button.

Check the Use embedded Python Console check box

=~

8. Create a project with a Tool and a Python Tool specification (See Gerting Started)
9. Press play to execute the project (See Executing Projects)

10. You will see a question box

2.1. Setting up Python 17
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+» ipykernel Missing hd

o Python Console requires package ipykernel.

Do you want to install the package now?

Install ipykernel

When you click on the Install ipykernel button, you can see the progress of the operation in Process Log. The following
packages will be installed on your selected Python.:

backcall, colorama, decorator, ipykernel, ipython, ipython-genutils, Jjedi, jupyter-
—client,

jupyter-core, parso, pickleshare, prompt-toolkit, pygments, python-dateutil, pywin32,
—pyzmg, six,

tornado, traitlets, wcwidth

When this operation finishes successfully, you will see another guestion box.

+» Kernel Specs Missing *

IPython kernel specifications for the selected environment are
missing.

Do you want to install kernel python-3.8 specifications now?

Install specifications

Clicking on Install specifications button starts installing the kernel specs for the selected Python. On the tested system,
this creates a new kernel into directory C:\Users\ttepsa\AppData\Roaming\jupyter\kernels\Python-3.8, which contains
the kernel.json file required by the embedded Python Console (which is actually a jupyter qtconsole)

11. After the kernel specs have been installed, executing your Tool project item starts in the Python Console imme-
diately. You can see the executed command and the Tool output in the Python Console.

Note: If you want to set up your Python environment ready for Python Console manually, the following commands
are executed by Spine Toolbox under the hood

This installs all required packages:

’python -m pip install ipykernel

And this installs the kernel specifications:

’python -m ipykernel install --user ——name python-3.8 —--display-name Python3.8

2.1.2 What about Anaconda and Miniconda Pythons?

If you installed Spine Toolbox on a Conda environment, the Python you started Spine Toolbox with has been added to
the conda environment variables. This means that you are ready to execute Python Tools without using the embedded
Python Console out of the box. For setting up the Python Console you just need to let Spine Toolbox install the

18 Chapter 2. Setting up External Tools
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ipykernel package and the kernel specifications for this Python. See section Python Console execution above for more
info.

2.2 Setting up Julia

Spine Toolbox requires a Julia installation that must be set up before Julia Tools can be executed. The basic idea is the
same as with Python. In File->Settings (Tools tab), there’s a line edit for the Julia executable. If you leave this blank,
Spine Toolbox uses the Julia that is in your PATH environment variable. Setting an explicit path to a Julia executable
(e.g. C:\ulia-1.2.0\bin\julia.exe) overrides the Julia in PATH. As with Python Tools, you execute Julia Tools in the
embedded Julia Console or without it (shell execution).

If you see this (or similar) message in Event Log when trying to execute a Julia Tool.:

julia.exe failed to start. Make sure that Julia is installed properly on your,
—computer.

This means that you either don’t have a Julia installation on your system, Julia is not set up in your PATH environment
variable or the Julia executable you have set in Settings is not valid.

2.2.1 Step-by-step instructions
Shell execution

1. Go to https://julialang.org/downloads/ and download the Julia you want

Run the Julia installer and follow instructions

Either let the installer put Julia in your PATH or memorize the path where you installed it (e.g. C:\Julia-1.2.0)
Start Spine Toolbox

Go to File -> Settings (or press F1) and click the Tools tab open

SAE I

If the installed Julia is now in your PATH, you can leave the Julia executable line edit blank. Or you can set the
Julia executable explicitly by setting it to e.g. C:\Julia.1.2.0\bin\julia.exe by using the button.

Uncheck the Use embedded Julia Console check box

~

8. Create a project with a Tool and a Julia Tool specification (See Getting Started)
9. Press play to execute the project (See Executing Projects)

10. Executing your Tool project item starts. You can see the output (stdout and stderr) in the Process Log.

Julia Console execution
Like the Python Console, Julia Console requires some extra setting up. Spine Toolbox can set this up for you
automatically.

If you want to use the embedded Julia Console (and you should). There is an extra step involved since the Julia
Console requires a couple of extra packages (IJulia, etc.) to be installed and built.

1. Go to https://julialang.org/downloads/ and download the Julia you want
2. Run the Julia installer and follow instructions

3. Either let the installer put Julia in your PATH or memorize the path where you installed it (e.g. C:\Julia-1.2.0)

2.2. Setting up Julia 19
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4. Start Spine Toolbox
5. Go to File -> Settings (or press F1) and click the Tools tab open

6. If the installed Julia is now in your PATH, you can leave the Julia executable line edit blank. Or you can set the
Julia executable explicitly by setting it to e.g. C:\Julia.1.2.0\bin\julia.exe by using the button.

7. Check the Use embedded Julia Console check box
8. Create a project with a Tool and a Julia Tool specification (See Getting Started)
9. Press play to execute the project (See Executing Projects)

10. You will see a question box

«5 lulia installation needed x

Spine Toolbox needs to do the following modifications to the
Julia project at C:
\Users\ttepsa\.julia\environments\v1.4\Project.toml:

Install the Dulia package.

Allow Cancel

When you click on the Allow button, installing [Julia starts and you can see the progress of the operation in Process
Log. This may take a few minutes.

When you see the these messages in the Event Log, the Julia Console is ready to be used.:

IJulia installation successful.
xxx Starting Julia Console xxx*

11. After the installation has finished, executing your Julia Tool project item starts in the Julia Console immediately.
You can see the executed command and the Tool output in the Julia Console. If nothing seems to be happening
in the Julia Console. Just click button and then try executing the project again by clicking the button.

Note: If you want to set up your Julia environment ready for Julia Console manually, you need to install IJulia and
the Julia kernel specifications.

2.3 Setting up GAMS

Executing a GAMS Tool project item or executing an Exporter project item requires a GAMS installation on your
system.

Note: You do not need to own a GAMS license as the demo version works just as well.

Note: The bitness (32 or 64bit) of GAMS has to match the bitness of the Python interpreter.

If you have GAMS in your PATH environment variable, you can leave the GAMS executable line edit in File->Settings
blank and Spine Toolbox will find it. You can also override the GAMS in your PATH by setting an explicit path to the
GAMS executable (e.g. CAGAMS\win64\28.2\gams.exe) line edit.

20 Chapter 2. Setting up External Tools
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2.4 Setting up SpineOpt.jl

There’s a built-in configuration assistant in Spine Toolbox that downloads and configures SpineOpt.jl automati-
cally. You can find the configuration assistant in the main window menu File->Tool configuration assistants...-
>SpineOpt.jl Before you run this, you need to set up Julia for Spine Toolbox. See instructions above (Setting up
Julia). After a Julia has been set up correctly, run the Tool configuration assistant and follow the instructions given.

2.4. Setting up SpineOpt.jl 21
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CHAPTER 3

Main Window

This section describes the different components in the application main window.

The first time you start the application you will see the main window like this.

+ Spine Toolbox - X

File Edit View Help

1 . -

e EHEE S BB o 2[4 e OOIO)

Project & X | Design View Properties x

Select a project item to view its properties

Event Log & X ProcessLog & % Julia Console & X  Python Console X
A~ "
v v
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The application main window contains six dock widgets (Project, Properties, Event Log, Process Log, Julia Console,
and Python Console), a tool bar, a Design View, and a menu bar with File, Edit, View, and Help menus. The Project
dock widget contains a list of project items and Tool specifications that are available in your project. The Properties
dock widget shows the properties of the selected project item. Event Log shows messages depending on what you do
in Spine Toolbox. Process Log shows messages from processes that are spawned by the application, i.e. it shows the
stdout and stderr streams of GAMS, Julia, Python (if Tools are executed without embedded Julia and Python Consoles,
see Settings section), and executable programs. Julia and Python Consoles provide full iJulia and a iPython consoles.
If you choose to execute Julia tools in the embedded Julia Console, the Julia code will be included into the Julia
Console and executed there. You can interact with the iJulia in the Julia Console like you would with any iJulia you
use.

Tip: You can configure the Julia and Python versions you want to use in File->Settings.

The menu bar in the top of the application contains File, Edit, View, and Help menus. In the File menu you can create
a new project, open an existing project, save the project, upgrade an old project to modern directory-based project,
and open the application Settings among other things. Spine Toolbox is project based, which means that you need to
create a new project or open an existing one before you can do anything. You can create a new project by selecting
File->New project. .. fromthe menu bar. Drag & Drop Icon tool bar contains the available project item types.
The button can be used to remove all items from your project. The Execute icons control the execution of the items in
the Design view where you build your project. The button executes all Directed-Acyclic Graphs (DAG) in the project
in arow. The button executes the selected project items only. The button terminates the execution (if running).

You can add a new project item to your project by pointing your mouse cursor on any of the draggable items in the
Drag & Drop Icon tool bar, then click-and-drag the item on to the Design view. After this you will be presented a
dialog, which asks you to fill in basic information about the new project item (name, description, etc.).

The main window is very customizable so you can e.g. close the dock widgets that you do not need and/or you can
resize the views to fit your needs and display size or resolution.

Note: If you want to restore all dock widgets to their default place use the menu item View->Dock
Widgets->Restore Dock Widgets. This will show all hidden dock widgets and restore them to the main
window.

Below is an example on how you can customize the main window. In the picture, a user has created a project My
First Project, and created one project item from each of the seven categories. A Data Store called Database, a Data
Connection called Data files, A Tool called Julia model, a View called View, an Importer called Importer, an Exporter
called Exporter, and a Manipulator called Combiner. The project items are also listed in the Project dock widget.
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CHAPTER 4

Project ltems

* Project Item Properties
* Project Item Descriptions
— Data Store data_store
— Data Connection data_connection
— Tool tool
— Gimlet gimlet
— View view
— Combiner combiner

— Importer importer

— Exporter exporter

Project items in the Design view and the connections between them make up the graph (Directed Acyclic Graph, DAG)
that is executed when the or buttons are pressed.

See Executing Projects for more information on how a DAG is processed by Spine Toolbox. Those interested in
looking under the hood can check the Project item development section.

4.1 Project Item Properties

Each project item has its own set of Properties. You can view and edit them by selecting a project item on the
Design View. The Properties are displayed in the Properties dock widget on the main window. Project item properties
are saved into the project save file (project . json), which can be found in <proj_dir>/.spinetoolbox/
directory, where <proj_dir> is your current project directory.
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In addition, each project item has it’s own directory in the <proj_dir>/.spinetoolbox/items/ directory.
You can quickly open the project item directory in a file explorer by clicking on the button located in the lower right
corner of each Properties form.

4.2 Project Item Descriptions

The following items are currently available:

4.2.1 Data Store

A Data store item represents a connection to a (Spine) database. Currently, the item supports sqlite and mysql dialects.
The database can be accessed and modified in Spine db editor available from the item’s properties or from a right-click
context menu.

4.2.2 Data Connection

A Data connection item provides access to data files. It also provides access to the Datapackage editor.

4.2.3 Tool

Tool is the heart of a DAG. It is usually the actual model to be executed in Spine Toolbox but can be an arbitrary script
or executable as well. A tool is specified by its specification.

4.2.4 Gimlet

While being able to run most scripts and copyable executables, Tool cannot handle system commands or executables
meant to run from system’s path. This is a job for Gimlet. A Gimlet can execute an arbitrary system command with
given command line arguments, input files and work directory.

4.2.5 View

A View item is meant for inspecting data from multiple sources using the Spine db editor. Note that the data is opened
in read-only mode so modifications are not possible from the View item.

4.2.6 Combiner

A Combiner item can be used to combine two or more databases into one.

4.2.7 Importer

This item provides the user a chance to define a mapping from tabulated data such as comma separated values or Excel
to the Spine data model. See Importing and exporting data for more information.
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4.2.8 Exporter

This item exports databases contained in a Data Store into . gdx format for GAMS Tools. See Importing and exporting
data for more information.
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CHAPTER B

Tool specification editor

This section describes how to make a new Tool specification and how to edit existing Tool specifications.

To execute a Julia, Python, GAMS, or an executable script in Spine Toolbox, you must first create a Tool specification
to your project. You can open the Tool specification editor in several ways. One way is to press the Tool icon with a
plus button in the Project dock widget. This presents you a pop-up menu with the New and Add existing. .. options.

Tool spedifications

& F

Mew
l Add existing...

When you click on New the following form pops up.
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« Edit Tool Specification — O *

Type name here... Select type... b

Execute in work directory

Type description here. ..

Add main program file here. .. | ‘
Type command line arguments here. .. a@
Additional source files Input files

B 5 W S]]

Optional input files Output files

g W@ &)
Main program directory

Start by giving the Tool specification a name. Then select the type of the Tool. You have four options (Julia, Python,
GAMS or Executable). Then select, whether you want the Tool specification to be executed in the work directory or
in its source directory (See Terminology section). You can give the Tool specification a description, describing what
the Tool specification does. Main program file is the main file of your simulation model, or an executable script. You
can create a blank file into a new directory by pressing the button and selecting Make new main program or you can
browse to find an existing main program file by pressing the same button and selecting Select existing main program.

Command line arguments can be appended to the actual command that Spine Toolbox executes in the background. For
example, you may have a Windows batch file called do_things.bat, which accepts command line arguments a and b.
Writing a b on the command line arguments field in the tool specification editor is the equivalent of running the batch
file in command prompt with the command do_things.bat a b. See Command line argument tag expansion for
more information on the command line arguments.

Additional source files is a list of files that the main program requires in order to run. You can add individual files or
whole directories at once to this list.

Tip: You can also drag&drop a directory from your operating systems File Explorer into the Additional source files
list.

Input files is a list of input data files that the program requires in order to execute. You can also add directories and
subdirectories. Wildcards are not supported (see Optional input files).
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Examples:
* data.csv -> File is copied to the same work directory as the main program
* input/data.csv -> Creates directory input/ to the work directory and copies file data.csv there
* output/ -> Creates an empty directory output/ into the work directory

Optional input files are files that may be utilized by your program if they are found. Unix-style wildcards ? and * are
supported.

Examples:
* data.csv -> If found, file is copied to the same work directory as the main program
* *.csv -> All found .csv files are copied to the same work directory as the main program

* input/data_?.dat -> All found files matching the pattern data_?.dat are copied into input/ directory in the work
directory.

Output files are files that will be archived into a timestamped result directory of the Tool’s project directory after the
Tool specification has finished execution. Unix-style wildcards ? and * are supported.

Examples:
* results.csv -> File is copied from work directory into results directory
* *.csv -> All .csv files from work directory are copied into results directory

* output/*.gdx -> All GDX files from the work directory’s output/ subdirectory will be copied to into output/
subdirectory in the results directory.

When you are happy with your Tool specification, click Ok, and you will be asked where to save the Tool specification
file. It is recommended to save the file into the same directory where the main program file is located. The Tool
specification file is a text file in JSON format and has an extension .json

Tip: Only name, type, and main program file fields are required to make a Tool specification. The other fields are
optional.

Here is a minimal Tool specification for a Julia script script.jl
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« Edit Tool Specification — O

Example Tool spedfication 0 Juliz

Execute in work directory

frype description here. ..

|C:,|'Tem|:lfscri|:lt.jl

© K

Type command line arguments here...

Additional source files Input files
g BJ gl W
Optional input files Output files

g M &)

Main program directory C:\Temp

Note: Under the hood, the contents of the Tool specification are saved to a Tool specification file in JSON format.
Users do not need to worry about the contents of these files since reading and writing them is managed by the app. For

the interested, here are the contents of the Tool specification file that we just created.:

{
"name": "Example Tool specification",
"description": "",
"tooltype": "julia",
"execute_in_work": true,
"includes": [

"script.jl"

]I
"inputfiles": T[],
"inputfiles_opt": T[],
"outputfiles": [1,
"cmdline_args": ""

After the user has clicked Ok and saved the file, the new Tool specification has been added to the project.
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Tool spedifications
Example Tool specification

Vil

To edit this Tool specification, just right-click on the Tool specification name and select Edit Tool specification from
the context-menu.

You are now ready to execute the Tool specification in Spine Toolbox. You just need to select a Tool item in the Design
view, set the specification Example Tool specification to it, and click or button.

5.1 Command line argument tag expansion

Spine Toolbox supports a number of special command line arguments called fags that get replaced by in-
formation relevant to a Tool’s current connections. For example, the Q@url-inputs@@ tag expands to
a list of input database URLs. If the command line arguments for the Model tool in the image below
were ——input-database=QQurl-inputs@@ the tool would be executed by python tool_script.py
-—input_database=sqglite:///input_database.sqglite command in case Input data’s database URL
was sqlite:///input_database.sqglite.

Input data Model Results
El 5] 6]
N . W= N .
- —0 | m— 1
F ll_ § (1

The button next to the command line arguments field in Tool Specification editor gives a quick access to insert the
tags into the field.
Below is a list of the command line argument tags that are currently available:

* @Qurl_inputs@@: aspace separated list of database URLs provided by all input data stores.

* QR@url_outputs@@: aspace separated list of database URLs provided by all output data stores.

* @@url:<data store name>@Q: the url provided by a named data store connected to the tool.

* QRoptional_inputs@@: aspace separated list of tool’s optional input files.

5.1. Command line argument tag expansion 35



Spine Toolbox Documentation, Release 0.5.0-beta.0

36 Chapter 5. Tool specification editor



CHAPTER O

Executing Projects

This section describes how executing a project works and what resources are passed between project items at execution
time. Execution happens by pressing the (Execute project) or the (Execute selection) buttons in the main window
tool bar. A project consists of project items and connections (yellow arrows) that are visualized on the Design View.
You use the project items and the connections to build a Directed Acyclic Graph (DAG), with the project items as
nodes and the connections as edges. A DAG is traversed using the breadth-first-search algorithm.

Rules of DAGs:
1. A single project item with no connections is a DAG.

2. All project items that are connected, are considered as a single DAG (no matter, which direction the arrows go).
If there is a path between two items, they are considered as belonging to the same DAG.

3. Loops are not allowed (this is what acyclic means).

You can connect the nodes in the Design View how ever you want but you cannot execute the resulting DAGs if they
break the rules above. Here is an example project with three DAGs.
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* DAG 1: items: a, b, ¢, d. connections: a-b, a-c, b-d, c-d
e DAG 2: items: e, f. connections: e-f
* DAG 3: items: g. connections: None

When you press the button, all three DAGs are executed in a row. You can see the progress and the current executed
item in the Event Log. Execution order of DAG 1 is a->b->c->d or a->c->b->d since items b and c are siblings.
DAG 2 execution order is e->f and DAG 3 is just g. If you have a DAG in your project that breaks the rules above,
that DAG is skipped and the execution continues with the next DAG.

We use the words predecessor and successor to refer to project items that are upstream or dowstream from a project
item. Direct predecessor is a project item that is the immediate predecessor. Direct Successor is a project item that
is the immediate successor. For example, in DAG 1 above, the successors of a are project items b, ¢ and d. The direct
successor of b is d. The predecessor of b is a, which is also its direct predecessor.

You can also execute only the selected parts of a project by multi-selecting the items you want to execute and pressing
the button in the tool bar. For example, to execute only items b, d and f, select the items in Design View or in the
project item list in Project dock widget and then press the button.

Tip: You can select multiple project items by pressing the Ctrl-button down and clicking on desired items.

6.1 Example DAG

When you have created at least one Tool specification, you can execute a Tool as part of the DAG. The Tool specifi-
cation defines the process that is depicted by the Tool project item. As an example, below we have two project items;
Julia Model Tool and Data File Data Connection connected to each other.
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+ Spine Toolbox  -- First Project -- — O >
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Selecting the Julia Model shows its properties in the Properties dock widget. In the top of the Tool Properties, there is
a specification drop-down menu. From this drop-down menu, you can select the Tool specification for this particular
Tool item. The Julia Model Specification tool specification has been selected for the Tool Julia Model. Below the
drop-down menu, you can see the details of the Tool specification, command line arguments, Source files (the first one
is the main program file), Input files, Optional input files and Output files. Results... button opens the Tool’s result
archive directory in the File Explorer (all Tools have their own result directory). The Execute in radio buttons control,
whether this Tool is first copied to a work directory and executed there, or if the execution should happen in the source
directory where the main program file is located.

When you click on the button, the execution starts from the Data File Data Connection. When executed, Data
Connection items advertise their files and references to project items that are in the same DAG and executed after
them. In this particular example, the Data File item contains a file called data.csv as depicted in the picture below.
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When it’s the Julia Model tools turn to be executed, it checks if it finds the file data.csv from project items, that have
already been executed. When the DAG is set up like this, the Tool finds the input file that it requires and then starts
processing the Tool specification starting with the main program file script.jl. Note that if the connection would be
the other way around (from Julia Model to Data File) execution would start from the Julia Model and it would fail
because it cannot find the required file data.csv. The same thing happens if there is no connection between the two
project items. In this case the project items would be in separate DAGs.

Since the Tool specification type was set as Julia and the main program is a Julia script, Spine Toolbox starts the
execution in the Julia Console (if you have selected this in the application Settings, See Settings section).

6.2 Tool execution algorithm

The below figure depicts what happens when a Tool item with a valid Tool specification is executed.
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6.2. Tool execution algorithm
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CHAPTER /

Settings

You can open Spine Toolbox settings from the main window menu File->Settings. .., or by pressing F1.
Settings are categorized into four tabs; General, Project, Tool, and View. In addition to application settings, each
Project item has user adjustable properties (See Project Items)

* General settings
* Project settings
* Tools settings

» View settings

* Application preferences

» Where are the application settings stored?
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7.1 General settings

General

[E—_ Ge e al
——
Dpen pre\inUS p oject at Star‘tup

" Project [ ] show confirm exit prompt
|:| Save project at exit
}& Tools Show date and time in Event Log messages
@ View |:| Delete data when project item is removed from project
Work directory
Using default directory | 1
Smooth zoom
Curved links
Design View background
() Grid @ solid
Data flow animation speed
Slow Fast

The General tab contains the general application settings.

Open previous project at startup If checked, application opens the project at startup that was open the last
time the application was shut down. If left unchecked, application starts without a project open.

Show confirm exit prompt If checked, confirm exit prompt is shown. If unchecked, application exits without
prompt.

Save project at exit Unchecked: Does not save project and does not show message box. Partially checked:
Shows message box (default). Checked: Saves project and does not show message box.

Show date and time in Event Log messages If checked, every Event Log message is prepended with a date
and time ‘tag’.

Delete data when project item is removed from project Check this box to delete project item’s data when a
project item is removed from project. This means, that the project item directory and its contents will be deleted
from your hard drive. You can find the project item directories from the <proj_dir>/.spinetoolbox/
items/ directory, where <proj_dir> is your current project directory.

Work directory Directory where processing the Tool takes place. Default place (if left empty) is the /work
subdirectory of Spine Toolbox install directory. You can change this directory. Make sure to clean up the
directory every now and then.

Smooth zoom Controls the way zooming (by using the mouse wheel) behaves in Design View and in Spine
database editor. Controls if the zoom in/out is continuous or discrete. On older computers, smooth zoom is not
recommended (because it may be slower).
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* Curved links Controls the look of the arrows (connections) on Design View.

¢ Design View background Choosing grid shows a black grid as the Design View background. Choosing Solid
and then clicking on the square next to it let’s you choose the background color.

e Data flow animation speed This slider controls the speed of the ‘arrow’ animation on Design View when
execution is about to start.

7.2 Project settings

== General Project
MName

%" project |Praject 1
Description

)& Tools

@ View

These settings affect the project that is currently open. To save the project to a new directory use the File->Save
project as... menuitem. Or you can simply copy the project directory anywhere on your file system.

* Name The default name for new projects is the name of the project directory. You can change the project name
here.

* Description You can type a description for your project here.
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7.3 Tools settings

——
+— General GAMS
GAMS executable
l;l Project Using system's default GAMS | |—3
Julia
Tools
2& Julia executable
) Using Julia executable in system path =
@ View | . |
|L|sing Julia home project | =
Use embedded Julia Console
Python
Python interpreter
|L|sing Python interpreter in system path | =
Use embedded Python Console

GAMS executable Path to GAMS executable you wish to use to execute Exporter project items and Tool project
items that use a GAMS Tool specification. Leave this empty to use the system GAMS (i.e. GAMS set up in
your system PATH variable).

Julia executable Path to Julia executable you wish to use to execute ool project items that use a Julia Tool
specification. This is the Julia executable that will be used in the embedded Julia Console and also the Julia that
is used when executing Julia Tool specifications as in the shell. Leave this empty, if you wish to use the system
Julia.

Julia home project Set the Julia home project here.

Use embedded Julia Console Check this box to execute Tool project items that use a Julia Tool specification
in the built-in Julia Console. If you leave this un-checked, Julia Tool specifications will be executed as in the
shell. I.e on Windows this would be the equivalent to running command julia.exe example_script.
j1 in the command prompt. If you decide to use the embedded Julia Console, the example_script.jlis
included into the console and executed there. It is recommended to use the embedded Julia Console, since this
gives a significant performance boost compared to shell execution.

Python interpreter Path to Python executable you wish to use to execute Tool project items that use a Python
Tool specification. This is the Python that will be used in the embedded Python Console and also the Python that
is used when executing Python Tool specifications as in the shell. Leave this empty to use the system Python.

Use embedded Python Console Check this box to execute Python Tool specifications in the embedded Python
Console. If you un-check this box, Python Tool specifications will be executed as in the shell. I.e on Windows
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this would be the equivalent to running command python.exe script.py inthe command prompt. If you
decide to use the embedded Python Console, script .py is executed there instead.

7.4 View settings

- Data store view
= General

[m] Commit session when view is closed

" Project [ ] sticky selection in object tree

}& Tools

@ View

* Commit session when view is closed This checkbox controls what happens when you close the Spine database
editor which has uncommitted changes. When this is unchecked, all changes are discarded without notice. When
this is partially checked (default), a message box warning you about uncommitted changes is shown. When this
is checked, a commit message box is shown immediately without first showing the message box.

« Sticky selection in object tree Controls how selecting items in Spine database editor’s Object tree using the
left mouse button works. If unchecked, single selection is enabled and pressing the Ctrl-button down enables
multiple selection. If checked, Multiple selection is enabled and pressing the Ctrl-button down enables single
selection.

7.5 Application preferences

Spine Toolbox remembers the size, location, and placement of most of the application windows from the previous
session (i.e. when closing and restarting the app).
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7.6 Where are the application settings stored?

Application settings and preferences (see above) are saved to a location that depends on your oper-
ating system. On Windows, there is no separate settings file. They are stored into registry key
HKEY_CURRENT_USER\Software\SpineProject\Spine Toolbox. It is safe to delete this key if you
want to reset Spine Toolbox to factory settings.

Note: If you are looking for information on project item properties, see Project Items.
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CHAPTER 8

Welcome to Spine database editor’s User Guide!

Spine database editor is a dedicated component of Spine Toolbox, that you can use to visualize and edit data in one or
more Spine databases.

8.1 Getting started

* Launching the editor
— From Spine Toolbox

— From the command line

* Knowing the Ul

8.1.1 Launching the editor
From Spine Toolbox

To open a single database in Spine database editor:
1. Create a Data Store project item.
2. Select the Data Store.
3. Enter the url of the database in Data Store Properties.
4. Press the Open editor button in Data Store Properties.
To open multiple databases in Spine database editor:
1. Repeat steps 1 to 3 above for each database.

2. Create a View project item.

49



Spine Toolbox Documentation, Release 0.5.0-beta.0

3. Connect each Data Store item to the View item.
4. Select the View item.

5. Press Open editor in View Properties.

From the command line

To open a single SQLite database in Spine database editor, use the open_spine_db_editor.py scriptinthe bin
folder:

open_spine_db_editor.py "...path of the database file..."

8.1.2 Knowing the Ul

The form has the following main UI components:

* Entity trees (Object tree and Relationship tree): they present the structure of classes and entities in all databases
in the shape of a tree.

e Stacked tables (Object parameter value, Object parameter definition, Relationship parameter value, and Re-
lationship parameter definition): they present object and relationship parameter data in the form of stacked
tables.

* Pivot table and Frozen table: they present data for a given class in the form of a pivot table, optionally with
frozen dimensions.

* Entity graph: it presents the structure of classes and entities in the shape of a graph.
* Parameter value list: it presents parameter value lists available in the database.

* Parameter tag toolbar: it presents parameter tags defined in the database.

Tip: You can show or hide form components using the View menu, or select among three predefined layout styles:
Stacked style, Pivot style, and Graph style.

8.2 Viewing data

This section describes the available tools to view data.

* Viewing entities and classes
— Using Entity trees
— Using Entity graph
* Building the graph
* Manipulating the graph
» Viewing parameter definitions and values

— Using Stacked tables

* Viewing parameter values and relationships

50 Chapter 8. Welcome to Spine database editor’s User Guide!



Spine Toolbox Documentation, Release 0.5.0-beta.0

— Using Pivot table and Frozen table
x Selecting the input type
+ Pivoting and freezing
+ Filtering

* Viewing parameter value lists

» Viewing parameter tags

8.2.1 Viewing entities and classes
Using Entity trees

Entity trees present the structure of classes and entities in all databases in the shape of a tree:

Object tree

name dat ™
~ root exE
____ commodity L&
- electricity exe

EXE

;?, exe

~ & node__commeodity eXe

& electricity_node exe

e EXE

v water exE

EXE

;?, exe

~ & node__commeodity eXe

& Bastusel_lower exe

& DBastusel_upper eXe

& DBergnds_lower exe

& bBergnas_upper eXe

& DBatfors_lower exe

& DBatfors_upper eXe

& Finnfors_lower exe

& Finnfors_upper eXe

& Gallejaur_lower eXe~

In Object tree:

* To view all object classes from all databases, expand the root item (automatically expanded when loading the
form).

* To view all objects of a class, expand the corresponding object class item.

 To view all relationship classes involving an object class, expand any objects of that class.
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 To view all relationships of a class involving a given object, expand the corresponding relationship class item
under the corresponding object item.

In Relationship tree:

 To view all relationship classes from all databases, expand the root item (automatically expanded when loading
the form).

 To view all relationships of a class, expand the corresponding relationship class item.

Note: To expand an item in Object tree or Relationship tree, double-click on the item or press the right arrow while
it’s active. Items in gray don’t have any children, thus they cannot be expanded. To collapse an expanded item,
double-click on it again or press the left arrow while it’s active.

Tip: To expand or collapse an item and all its descentants in Object tree or Relationship tree, right click on the item
to display the context menu, and select Fully expand or Fully collapse.

Tip: In Object tree, the same relationship appears in many places (as many as it has dimensions). To jump to the next
ocurrence of a relationship item, either double-click on the item, or right-click on it to display the context menu, and
select Find next.

Using Entity graph

Entity graph presents the structure of classes and entities from one database in the shape of a graph:
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Tip: To see it in action, check out this video.

Building the graph

To build the graph, select any number of items in either Object tree or Relationship tree. What is included in the graph
depends on the specific selection you make:

To include all objects and relationships from the database, select the root item in either Object tree or Relation-
ship tree.

To include all objects of a class, select the corresponding class item in Object tree.
To include all relationships of a class, select the corresponding class item in Relationship tree.

To include all relationships of a specific class involving a specific object, select the corresponding relationship
class item under the corresponding object item in Object tree.

To include specific objects or relationships, select the corresponding item in either Object tree or Relationship
tree.

Note:

In Entity graph, a small unnamed vertex represents a relationship, whereas a bigger named vertex represents

an object. An arc between a relationship and an object indicates that the object is a member in that relationship.
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The graph automatically includes relationships whenever all the member objects are included (even if these relation-
ships are not selected in Object tree or Relationship tree). You can change this behavior to automatically include
relationships whenever any of the member objects are included. To do this, enable Show cascading relationships via
the Graph menu, or via Entity graph’s context menu.

Tip: To extend the selection in Object tree or Relationship tree, press and hold the Ctrl key while clicking on the
items.

Tip: Object tree and Relationship tree also support Sticky selection, i.e., extending the selection by clicking on items
without pressing Ctrl. To enable Sticky selection, go to File -> Settings and check the corresponding box.

Note: At the moment, Entity graph only shows data from the first database open in the form.

Manipulating the graph

You can move items in the graph by dragging them with your mouse. To make relationship items stay in the same rela-
tive position with respect to their member objects, go to File -> Settings and check the box next to, Move relationships
along with objects in Entity graph.

To save the position of items into the database, select the items in the graph and then choose Graph -> Save positions
from the menu bar. To clear saved positions, select the items again and choose Graph -> Clear saved positions.

To hide part of the graph, select the items you want to hide and then choose Graph -> Hide selected. To show the
hidden items again, select Graph -> Show hidden.

To prune the graph, select the items you want to prune and then choose Graph -> Prune selected entities or Prune
selected classes. To restore specific prunned items, go to Graph -> Restore prunned and select the items you want
to restore from the popup menu. To restore all prunned items at once, select Graph -> Restore all prunned.

Note: Entity graph supports extended selection and rubber-band selection. To extend a selection, press and hold Ctrl
while clicking on the items. To perform rubber-band selection, press and hold Ctrl while dragging your mouse around
the items you want to select.

Note: Prunned items are remembered across graph builds.

To zoom in and out, scroll your mouse wheel over Entity graph or use the buttons in Graph -> Zoom. To rotate
clockwise or anti-clockwise, press and hold the Shift key while scrolling your mouse wheel, or use the buttons in
Graph -> Rotate.

To export the current graph as a PDF file, select File -> Export graph as PDF.
8.2.2 Viewing parameter definitions and values

Using Stacked tables

Stacked tables present object and relationship parameter data from all databases in the form of stacked tables:
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Object parameter value

object_class_name

& model
K model
K model
&5 node
&= node
&5 node
&5 hode
&= node
&5 node
&= node
&5 node
&5 hode
&= node
&5 node
&= node
&5 node
& node
&= node

object_name

instance
instance
instance
Bastusel_upper
Bastusel_upper
Bastusel_upper
Bastusel_upper
Bergnas_upper
Bergnas_upper
Bergnas_upper
Bergnas_upper
Batfors_upper
Batfors_upper
Batfors_upper
Batfors_upper
Finnfors_upper
Finnfors_upper
Finnfors_upper

parameter_name
duration_unit

model_end
model_start
demand
fix_node_state
has_state
node_state_cap
demand
fix_node_state
has_state
node_state_cap
demand
fix_node_state
has_state
node_state_cap
demand
fix_node_state
has_state

hour

value

2019-01-08 00:00:00
2019-01-01 00:00:00

-0.2579768519
Time series

value_true

8208.0
-22.29
Time series

value_true

216120.0
-2.0
Time series

value_true

1330.0
0.0
Time series

value_true

()
database =

example
example
example
example
example
example
example
example
example
example
example
example
example
example
example
example
example
example

-

To filter Stacked tables by any entities and/or classes, select the corresponding items in either Object tree, Relationship
tree, or Entity graph. To remove all these filters, select the root item in either Object tree or Relationship tree.

To filter parameter definitions and values by certain parameter tags, select those tags in Parameter tag toolbar.

To apply a custom filter on a Stacked table, click on any horizontal header. A menu will pop up listing the items in the

corresponding column:
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Remove filters

(4]
5}
[aT]
™
—

(Select All) -
Bastusel_upper

Bergnas_upper

Batfors_upper

Finnfors_upper

Gallejaur_upper

Granfors_upper

Grytfors_upper

Krangfors_upper

irirtFarcmnam  immne

Uncheck the items you don’t want to see in the table and press Ok. Additionally, you can type in the search bar at the
top of the menu to filter the list of items. To remove the current filter, select Remove filters.

Y

To filter a Stacked table according to a selection of items in the table itself, right-click on the selection to show the
context menu, and then select Filter by or Filter excluding. To remove these filters, select Remove filters from the
header menus of the filtered columns.

Tip: You can rearrange columns in Stacked tables by dragging the headers with your mouse. The ordering will be
remembered the next time you open the form.

8.2.3 Viewing parameter values and relationships
Using Pivot table and Frozen table

Pivot table and Frozen table present data for an individual class from one database in the form of a pivot table,
optionally with frozen dimensions:
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Pivot table

connection
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To populate the tables with data for a certain class, just select the corresponding class item in either Object tree or

Relationship tree.
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Selecting the input type

Pivot table and Frozen table support three different input types:

e Parameter value (the default): it shows objects and parameter definitions in the headers, and corresponding
parameter values in the table body.

* Index expansion: Similar to the above, but it also shows parameter indexes in the headers. Indexes are extracted
from special parameter values, such as time-series.

* Relationship: it shows objects in the headers, and corresponding relationships in the table body. It only works
when selecting a relationship class in Relationship tree.

You can select the input type from the Pivot table menu in the menu bar.

Note: In Pivot table, header blocks in the top-left area indicate what is shown in each horizontal and vertical header.
For example, in Parameter value input type, by default, the horizontal header has a single row listing parameter
names, whereas the vertical header has one or more columns listing object names.

Pivoting and freezing

To pivot the data, drag a header block across the top-left area of the table. You can turn a horizontal header into a
vertical header and viceversa, as well as rearrange headers vertically or horizontally.

To freeze a dimension, drag the corresponding header block from Pivot table into Frozen table. To unfreeze a frozen
dimension, just do the opposite.

Note: Your pivoting and freezing selections for any class will be remembered when switching to another class.

Filtering

To apply a custom filter on Pivor table, click on the arrow next to the name of any header block. A menu will pop up
listing the items in the corresponding row or column:
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Remove filters
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(Select All) %
Bastusel_upper

Bergnas_upper

Batfors_upper

Finnfors_upper

Gallejaur_upper

Granfors_upper

Grytfors_upper

Krangfors_upper

irirtFarcmnam  immne

Uncheck the items you don’t want to see in the table and press Ok. Additionally, you can type in the search bar at the
top of the menu to filter the list of items. To remove the current filter, select Remove filters.

Y

-

To filter the pivot table by an individual vector across the frozen dimensions, select the corresponding row in Frozen
table.

Note: At the moment, Pivot table shows data for only one class at a time, and only for the first database open in the
form.

8.2.4 Viewing parameter value lists

You can find parameter value lists from all databases under Parameter value list:
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Parameter value list 3]

~ & root (example)

¢+ balance_type_list

- commodity_physics_list
commodity_physics_ptdf
commodity_physics _lodf
commodity_physics_none
Type new list value here...

» constraint_sense

+ duration_unit_list

+ node_opf_type_list

+ truth_value_list

+ unit_online_variable_type_..

~ Type new list name here...

Type new list value here...

To view the parameter value lists from each database, expand the root item for that database. To view the values for
each list, expand the corresponding list item.

8.2.5 Viewing parameter tags

You can find parameter tags from all databases in Parameter tag toolbar:

Parameter tag I untagged " date_time " duration H time_pattern " time_series ]

8.3 Adding data

This section describes the available tools to add new data.

* Adding object classes

— Using Add object classes dialog
* Adding objects

— Using Add objects dialog

— Using Pivot table

— Duplicating objects

* Adding relationship classes
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— Using Add relationship classes dialog
* Adding relationships

— Using Add relationships dialog

— Using Pivot table

— Using Entity graph
* Adding parameter definitions

— Using Stacked tables

— Using Pivot table
* Adding parameter values

— Using Stacked tables

— Using Pivot table

* Adding parameter value lists

8.3.1 Adding object classes

Using Add object classes dialog

Select Edit -> Add object classes from the menu bar, or right-click on the root item in Object tree to display the
context menu, and select Add object classes.

The Add object classes dialog will pop up:

object class name description display icon databases
1 (<) example

e o | o

Enter the names of the classes you want to add under the object class name column. Optionally, you can enter
a description for each class under the description column. To select icons for your classes, double click on the
corresponding cell under the display icon column. Finally, select the databases where you want to add the classes
under databases. When you’re ready, press OKk.
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8.3.2 Adding objects
Using Add objects dialog

Select Edit -> Add objects from the menu bar, or right-click on an object class item in Object tree to display the
context menu, and select Add objects.

The Add objects dialog will pop up:

object class name object name description databases
1 example

o

Enter the names of the object classes under object class name, and the names of the objects under object name.
To display a list of available classes, start typing or double click on any cell under the object class name column.
Optionally, you can enter a description for each object under the description column. Finally, select the databases
where you want to add the objects under databases. When you’re ready, press OK.

Using Pivot table

To add an object to a specific class, bring the class to Pivor table using any input type (see Using Pivot table and
Frozen table). Then, enter the object name in the last cell of the header corresponding to that class.

Duplicating objects

To duplicate an existing object with all its relationships and parameter values, right-click over the corresponding object
item in Object tree to display the context menu, and select Duplicate object. Enter a name for the duplicate and press
Ok.

8.3.3 Adding relationship classes

Using Add relationship classes dialog

From the menu bar, select Edit -> Add relationship classes. Alternatively, right-click on either the root item in
Relationship tree, or on an object class item in Object tree, and select Add relationship classes from the context
menu.

The Add relationship classes dialog will pop up:
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'

Mumber of dimensions |1

object class name (1) relationship class name description databases
1 example

x Cancel + OK

Select the number of dimensions using the spinbox at the top; then, enter the names of the object classes for each
dimension under each object class name column, and the names of the relationship classes under relationship class
name. To display a list of available object classes, start typing or double click on any cell under the object class name
columns. Optionally, you can enter a description for each relationship class under the description column. Finally,
select the databases where you want to add the relationship classes under databases. When you’re ready, press OKk.

8.3.4 Adding relationships

Using Add relationships dialog

Select Edit -> Add relationships from the menu bar, or right-click on a relationship class item in either Object tree
or Relationship tree, and select Add relationships from the context menu.

The Add relationships dialog will pop up:
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Relationship class | connection__from_node (connection,node) -
connection node relationship name databases

1 example

&

Ceona ] o

Select the relationship class from the combo box at the top; then, enter the names of the objects for each member
object class under the corresponding column, and the name of the relationship under relationship name. To display a
list of available objects for a member class, start typing or double click on any cell under that class’s column. Finally,
select the databases where you want to add the relationships under databases. When you’re ready, press OK.

Using Pivot table

To add a relationship for a specific class, bring the class to Pivot table using the Relationship input type (see Using
Pivot table and Frozen table). The Pivot table headers will be populated with all possible combinations of objects
across the member classes. Locate the objects you want as members in the new relationship, and check the corre-
sponding box in the table body.

Using Entity graph

Make sure all the objects you want as members in the new relationship are in the graph. To start the relationship,
either double click on one of the objects, or right click to display the context menu and choose Add relationships. A
menu will pop up showing the available relationship classes. Select the class you want; the mouse cursor will adopt a
cross-hairs shape. Click on each of the remaining member objects one by one to make the relationships.

Tip: All the Add. .. dialogs support pasting tabular (spreadsheet) data from the clipboard. Just select any cell in the
table and press Ctrl+V. If needed, the table will grow to accommodate the exceeding data. To paste data on multiple
cells, select all the cells you want to paste on and press Ctrl+V.

8.3.5 Adding parameter definitions

Using Stacked tables

To add new parameter definitions for an object class, just fill the last empty row of Object parameter definition. Enter
the name of the class under object_class_name, and the name of the parameter under parameter_name. To display a
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list of available object classes, start typing or double click under the object_class_name column. Optionally, you can
also specify a default value, a parameter value list, or any number of parameter tags under the appropriate columns.
The parameter is added when the background of the cells under object_class_name and parameter_name become gray.

To add new parameter definitions for a relationship class, just fill the last empty row of Relationship parameter defini-
tion, following the same guidelines as above.

Using Pivot table

To add a new parameter definition for a class, bring the corresponding class to Pivot table using the Parameter value
input type (see Using Pivot table and Frozen table). The parameter header of Pivot table will be populated with
existing parameter definitions for the class. Enter a name for the new parameter in the last cell of that header.

8.3.6 Adding parameter values

Using Stacked tables

To add new parameter values for an object, just fill the last empty row of Object parameter value. Enter the name
of the class under object_class_name, the name of the object under object_name, and the name of the parameter
under parameter_name. Optionally, you can also specify the parameter value right away under the value column.
To display a list of available object classes, objects, or parameters, start typing or double click under the appropriate
column. The parameter value is added when the background of the cells under object_class_name, object_name, and
parameter_name become gray.

To add new parameter values for a relationship class, just fill the last empty row of Relationship parameter value,
following the same guidelines as above.

Note: To add parameter values for an object, the object has to exist beforehand. However, when adding parameter
values for a relationship, you can specify any valid combination of objects under object_name_list, and a relationship
will be created among those objects if one doesn’t yet exist.

Using Pivot table

To add parameter value for any object or relationship, bring the corresponding class to Pivot table using the Parameter
value input type (see Using Pivot table and Frozen table). Then, enter the parameter value in the corresponding cell
in the table body.

Tip: All Stacked tables and Pivot table support pasting tabular (spreadsheet) data from the clipboard. Just select any
cell in the table and press Ctrl+V. If needed, Stacked tables will grow to accommodate the exceeding data. To paste
data on multiple cells, select all the cells you want to paste on and press Ctrl+V.

8.3.7 Adding parameter value lists

To add a new parameter value list, just enter the name of the list in the last row of Parameter value list, under the
corresponding database item.

To add new values for the list, enter the values in the rows under the corresponding list item.
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Note: To be actually added to the database, a parameter value list must have at least one value.

8.4 Updating data

This section describes the available tools to update existing data.

* Updating entities and classes
— Using Edit... dialogs
— Using Pivot table

* Updating parameter definitions and values
— Using Stacked tables

— Using Pivot table

* Updating parameter value lists

8.4.1 Updating entities and classes

Using Edit... dialogs

Select any number of entity and/or class items in Object tree or Relationship tree, or any number of object and/or
relationship items in Entity graph. Then, either select Edit -> Edit selected items from the menu bar, or right-click
on the selection and choose Edit selected items from the context menu.

One separate Edit... dialog will pop up for each selected entity or class type, and the tables will be filled with the
current data of selected items. E.g.:

object class name description display icon databases ~
1) commodity A commodity example
2 connection An entity where an energy transfer takes place & example
3 model (<] example
4/ node An entity where an energy balance takes place Egﬁ example
5 output (<] example
6 report (<] example
7 temporal_block A temporal block (L) example =

Modify the field(s) you want under the corresponding column(s). Specify the databases where you want to update
each item under the databases column. When you’re ready, press Ok.

Using Pivot table

To rename an object of a specific class, bring the class to Pivot table using any input type (see Using Pivot table and
Frozen table). Then, just edit the appropriate cell in the corresponding class header.
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8.4.2 Updating parameter definitions and values

Using Stacked tables

To update parameter data, just go to the appropriate Stacked table and edit the corresponding row.

Using Pivot table

To rename parameter definitions for a class, bring the corresponding class to Pivot table using the Parameter value
input type (see Using Pivot table and Frozen table). Then, just edit the appropriate cell in the parameter header.

To modify parameter values for an object or relationship, bring the corresponding class to Pivot table using the Pa-
rameter value input type (see Using Pivot table and Frozen table). Then, just edit the appropriate cell in the table
body.

8.4.3 Updating parameter value lists

To rename a parameter value list or any of its values, just edit the appropriate row in Parameter value list.

8.5 Removing data

This section describes the available tools to remove data.

* Removing entities and classes
— Using Remove items dialog
— Using Entity graph
— Using Pivot table
* Removing parameter definitions and values
— Using Stacked tables
— Using Pivot table

* Removing parameter value lists

* Mass-removing items

8.5.1 Removing entities and classes

Using Remove items dialog

Select the items in Object tree or Relationship tree corresponding to the entities and classes you want to remove. Then,
either select Edit -> Remove selected items from the menu bar, or right-click on the selection and choose Remove
selected items from the context menu.

The Remove items dialog will popup:
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type name databases
1 object electricity example
2 object water example

3 relationship class commodity_group__commodity | example
4 relationship class commodity_group__node_group example
5 relationship class node__commodity example
6 relationship class unit_group__commodity_group | example

=0 e

Specify the databases from where you want to remove each item under the databases column, and press OK.

Using Entity graph

Select the items in Entity graph corresponding to the objects and/or relationships you want to remove. Then, either
select Edit -> Remove selected items from the menu bar, or right-click on the selection and choose Remove selected
items from the context menu.

Using Pivot table

To remove objects or relationships from a specific class, bring the class to Pivot table using the Parameter value input
type (see Using Pivot table and Frozen table), and select the cells in the table headers corresponding to the objects
and/or relationships you want to remove. Then, either select Edit -> Remove selected items from the menu bar, or
right-click on the selection and choose Remove selected items from the context menu.

Alternatively, to remove relationships for a specific class, bring the class to Pivot table using the Relationship input
type (see Using Pivot table and Frozen table). The Pivot table headers will be populated with all possible combinations
of objects across the member classes. Locate the member objects of the relationship you want to remove, and uncheck
the corresponding box in the table body.

8.5.2 Removing parameter definitions and values

Using Stacked tables

To remove parameter definitions or values, go to the relevant Stacked table and select any cell in the row corresponding
to the items you want to remove Then, either select Edit -> Remove selected items from the menu bar, or right-click
on the selection and choose Remove selected items from the context menu.

Using Pivot table
To remove parameter definitions and/or values for a certain class, bring the corresponding class to Pivot table using
the Parameter value input type (see Using Pivot table and Frozen table). Then:

1. Select the cells in the parameter header corresponding to the parameter definitions you want to remove.

2. Select the cells in the table body corresponding to the parameter values you want to remove.
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Finally, either select Edit -> Remove selected items from the menu bar, or right-click on the selection in Pivot table
and choose Remove selected items from the context menu.

8.5.3 Removing parameter value lists

To remove parameter value list or any of their values, just select the appropriate rows in Parameter value list. Then,
either select Edit -> Remove selected items from the menu bar, or right-click on the selection and choose Remove
selected items from the context menu.

8.5.4 Mass-removing items

To remove all items of specific types, select Edit -> Mass remove items from the menu bar. The Mass remove items
dialog will pop up:

Databases ltems
object class
relationship class
parameter definition
parameter tag

v example

parameter value list
object
relationship

parameter value

=0 B

Select the databases from where you want to remove the items under Databases, and the type of items you want to
remove under Items. Then, press Ok.

8.6 Managing data

This section describes the available tools to manage data, i.e., adding, updating or removing data at the same time.

* Managing parameter tags

* Managing relationships
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8.6.1 Managing parameter tags

To add, update, and/or remove parameter tags, press Manage parameter tags on Parameter tag toolbar, or select
Edit -> Manage parameter tags from the menu bar. The Manage parameter tags dialog will pop up:

parameter tag description databases remove
1 date_time a specific point in time  example
2 duration duration in time example

3/ time_pattern time patterned data example
4 time_series  time series data example

To add new parameter tags, just fill the last empty row in the table: Enter the tag under parameter tag, and optionally
a description under description. Finally, select the databases where you want to add the tag under databases.

To update existing parameter tags, just edit the appropriate row in the table, and select the databases where you want
the changes to be effective under databases.

To remove parameter tags, just check the corresponding box under the remove column, and select the databases from
where you want to remove the tag under databases.

When you’re ready, press Ok.

Note: Changes made using the Manage parameter tags dialog are not applied to any databases until you press Ok.

8.6.2 Managing relationships

Select Edit -> Manage relationships from the menu bar. The Manage relationships dialog will pop up:
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Relationship class | connection__from_node - Database |example ~
Available objects Existing relationships
connection = node = connection node =
Bastusel_to_Grytfors_disch Bastusel_lower 1 |Bastusel_to_Grytfors_disch Bastusel_lower
Bastusel_to_Grytfors_spill Bastusel_upper 2 |Bastusel_to_Grytfors_spill Bastusel_upper
Bergnds_to_Slagnds_disch Bergnas_lower B P .

. . ) . 3 |Bergnés_to_Slagnés_disch Bergnéds_lower
Bergnas_to_Slagnas_spill Bergnas_upper — — - —
Batfors_to_Finnfors_disch Batfors_lower 4 |Bergnas_to_Slagnds_spill Bergnds_upper
Batfors_to_Finnfors_spill Batfors_upper 5 |Batfors_to_Finnfors_disch Batfors_lower
Finnfors_to_Granfors_disch Finnfors_lower 6 |Batfors_to_Finnfors_spill Batfors_upper
Finnfors_to_Granfors_spill Finnfors_upper 7 |Finnfors_to_Granfors_disch Finnfors_lower
Gallejaur_to_Vargfors_disch Gallejaur_lower & >> . , , &

. ) . 8 |Finnfors_to_Granfors_spill Finnfors_upper
Gallejaur_to_Vargfors_spill Gallejaur_upper - - -
Granfors_to_Krangfors_disch Granfors_lower 9 |Gallejaur-to_Vargfors_disch Gallejaur_lower
Granfors_to_Krangfors_spill Granfors _upper 10| Gallejaur _to_Vargfors_spill Gallejaur_upper
Grytfors_to_Gallejaur_disch Grytfors_lower 11| Granfors_to_Krangfors_disch Granfors_lower
Grytfors_to_Gallejaur _spill Grytfors_upper 12| Granfers_to_Krangfors_spill Granfors_upper
Kréanors_to_Selsfors_d|5_ch Krangfors_lower 13 Grytfors_to_Gallejaur_disch Grytfors_lower
Krangfors_to_Selsfors_spill Krangfors_upper - -
Kvistforsen_to_downstream_disch _  Kvistforsen_lower 14 Grytfors_to_Gallejaurspill Grytfors_upper
{ || Kvistforsen_upper - 15 Krangfors_to_Selsfors_disch Krangfors_lo.. |~

o o]

To get started, select a relationship class and a database from the combo boxes at the top.

To add relationships, select the member objects for each class under Available objects and press the Add relationships
button at the middle of the form. The relationships will appear at the top of the table under Existing relationships.

To add multiple relationships at the same time, select multiple objects for one or more of the classes.

Tip: To extend the selection of objects for a class, press and hold the Ctrl key while clicking on more items.

Note: The set of relationships to add is determined by applying the product operation over the objects selected for
each class.

To remove relationships, select the appropriate rows under Existing relationships and press the Remove relationships
button on the right.

When you’re happy with your changes, press Ok.

Note: Changes made using the Manage relationships dialog are not applied to the database until you press OKk.

8.7 Importing and exporting data

This section describes the available tools to import and export data.

e Overview

— Excel format

— JSON format

8.7. Importing and exporting data 71



Spine Toolbox Documentation, Release 0.5.0-beta.0

* Importing
» Exporting
— Mass export
— Selective export

— Session export

* Accessing/using exported files

8.7.1 Overview

Spine database editor supports importing and exporting data in three different formats: SQLite, JSON, and Excel.

The SQLite import/export uses the Spine database format. The JSON and Excel import/export use a specific format
described below.

Tip: To get a JSON or Excel file template you can simply export an existing Spine database into one of those formats.

Excel format
The Excel format consists of one sheet per object and relationship class. Each sheet can have one of four different
formats:
1. Object class with scalar parameter data:
A E C

Sheet type Data type object class name
object Parameter unit

named unit 1 1,618

1

2

3

4 commodity_group Parameter 1 Parameter 2

3

& mamed_unit_2 2,718 3,14

2. Object class with time-series parameter data:

A B C
1 |Sheet type Data type object class name
2 |object Jjson array unit
3
4 |node named_unit_1 named_unit_2
5 |json parameter timseries_parameter timseries_parameter
& | 2018-01-01 00:00 1 3
7 | 2018-01-01 01:00 2 4
8 | 2018-01-01 02:00 3

3. Relationship class with scalar parameter data:
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A E < D E
1 [Sheettype Data type relationship class name Mumber of relationship dimensions MNumber of pivoted relationship dimensions
2 |relationship Parameter commodity_group_ commodity 2 0
S
4 commodity_group commodity relationship_parameterl relationship_parameter2
5 |electricity_group electricity 1
6 |water_group water 1 2
=

4. Relationship class with time-series parameter data:

A B C D E F G
1 |Sheettype Data type relationship class name Mumber of relationship dimensions
2 |relationship json array unit__commodity 2
3
4 |unit SE1_spot SE2_spot
5 |commodity electricity electricity
6 |Json parameter conversion_cost conversion cost
¥ | 2018-01-01 00:00 -24,03 -24,03
& | 2018-01-01 01:00 -24,03 -24,03
9 | 2018-01-01 02:00 -24,02 -24,02

JSON format

The JSON format consists of a single JSON object with the following OPTIONAL keys:

* object_classes: the value of this key MUST be a JSON array, representing a list of object classes. Each element
in this array MUST be itself a JSON array and MUST have three elements:

— The first element MUST be a JSON string, indicating the object class name.
— The second element MUST be either a JSON string, indicating the object class description, or null.
— The third element MUST be either a JSON integer, indicating the object class icon code, or null.

« relationship_classes: the value of this key MUST be a JSON array, representing a list of relationships classes.
Each element in this array MUST be itself a JSON array and MUST have three elements:

— The first element MUST be a JSON string, indicating the relationship class name.

— The second element MUST be a JSON array, indicating the member object classes. Each element in this
array MUST be a JSON string, indicating the object class name.

— The third element MUST be either a JSON string, indicating the relationship class description, or null.

» parameter_value_lists: the value of this key MUST be a JSON array, representing a list of parameter value lists.
Each element in this array MUST be itself a JSON array and MUST have two elements:

— The first element MUST be a JSON string, indicating the parameter value list name.

— The second element MUST be a JSON array, indicating the values in the list. Each element in this array
MUST be either a JSON object, string, number, or null, indicating the value.

¢ object_parameters: the value of this key MUST be a JSON array, representing a list of object parameter defini-
tions. Each element in this array MUST be itself a JSON array and MUST have five elements:

— The first element MUST be a JSON string, indicating the object class name.

— The second element MUST be a JSON string, indicating the parameter name.
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— The third element MUST be either a JSON object, string, number, or null, indicating the parameter default
value.

— The fourth element MUST be a JSON string, indicating the associated parameter value list, or null.
— The last element MUST be either a JSON string, indicating the parameter description, or null.

* relationship_parameters: the value of this key MUST be a JSON array, representing a list of relationship
parameter definitions. Each element in this array MUST be itself a JSON array and MUST have five elements:

— The first element MUST be a JSON string, indicating the relationship class name.

The second element MUST be a JSON string, indicating the parameter name.

The third element MUST be either a JSON object, string, number, or null, indicating the parameter default
value.

The fourth element MUST be a JSON string, indicating the associated parameter value list, or null

The last element MUST be either a JSON string, indicating the parameter description, or null.

* objects: the value of this key MUST be a JSON array, representing a list of objects. Each element in this array
MUST be itself a JSON array and MUST have three elements:

— The first element MUST be a JSON string, indicating the object class name.
— The second element MUST be a JSON string, indicating the object name.
— The third element MUST be either a JSON string, indicating the object description, or null.

* relationships: the value of this key MUST be a JSON array, representing a list of relationships. Each element in
this array MUST be itself a JSON array and MUST have two elements:

— The first element MUST be a JSON string, indicating the relationship class name.

— The second element MUST be a JSON array, indicating the member objects. Each element in this array
MUST be a JSON string, indicating the object name.

* object_parameter_values: the value of this key MUST be a JSON array, representing a list of object parameter
values. Each element in this array MUST be itself a JSON array and MUST have four elements:

The first element MUST be a JSON string, indicating the object class name.

The second element MUST be a JSON string, indicating the object name.

The third element MUST be a JSON string, indicating the parameter name.

The fourth element MUST be either a JSON object, string, number, or null, indicating the parameter value.

* relationship_parameter_values: the value of this key MUST be a JSON array, representing a list of relationship
parameter values. Each element in this array MUST be itself a JSON array and MUST have four elements:

— The first element MUST be a JSON string, indicating the relationship class name.

The second element MUST be a JSON array, indicating the relationship’s member objects. Each element
in this array MUST be a JSON string, indicating the object name.

The third element MUST be a JSON string, indicating the parameter name.

The fourth element MUST be either a JSON object, string, number, or null, indicating the parameter value.

Example:

{
"object_classes": [
["connection", "An entity where an energy transfer takes place",
—280378317271233],

(continues on next page)
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(continued from previous page)

["node", "An entity where an energy balance takes place", 280740554077951],
["unit", "An entity where an energy conversion process takes place",
—2814706818054297,

1,
"relationship_classes": [

["connection__node_ _node", ["connection", "node", "node"] , null],
["unit__ from_node", ["unit", "node"], null],
["unit___to_node", ["unit", "node"], null],
]I
"parameter_value_lists": [
["balance_type_list", ["\"balance_type_node\"", "\"balance_type_group\"", "\
—"balance_type_none\""]1],
["truth_value_list", ["\"value_false\"", "\"value_true\""]],

1,

"object_parameters": [
["connection", "connection_availability_factor", 1.0, null, null],
["node", "balance_type", "balance_type_node", "balance_type_list", null],

1,

"relationship_parameters": [
["connection__node__node", "connection_flow_delay", {"type": "duration", "data
—": "Oh"}, null, null],

["unit___from_node", "unit_capacity", null, null, null],
["unit__to_node", "unit_capacity", null, null, null],
]I
"objects": [
["connection", "Bastusel_ to_Grytfors_disch", null],
["node", "Bastusel_lower", null],
["node", "Bastusel_upper", null],
["node", "Grytfors_upper", null],
["unit", "Bastusel_pwr_plant", null],

1,

"relationships": [
["connection__node__node", ["Bastusel_to_Grytfors_disch", "Grytfors_upper",
—"Bastusel_lower"]],
["unit___from_node", ["Bastusel_pwr_plant", "Bastusel_upper"]ll],

["unit__to_node", ["Bastusel_pwr_plant", "Bastusel_lower"]],

1,

"object_parameter_values": [
["node", "Bastusel_upper", "demand", -0.2579768519],
["node", "Bastusel_upper", "fix_node_state", {"type": "time_series", "data": {

—"2018-12-31T23:00:00": 5581.44, "2019-01-07T23:00:00": 5417.28}}1,
["node", "Bastusel_upper", "has_state", "value_true"],

1,
"relationship_parameter_values": [

["connection__node__node", ["Bastusel_to_Grytfors_disch", "Grytfors_upper",
—"Bastusel_lower"], "connection_flow_delay", {"type": "duration", "data": "1h"}],
["unit___from_node", ["Bastusel_pwr_plant", "Bastusel_upper"], "unit_capacity",

— 127.57,
]

8.7.2 Importing

To import a file, go to File = Import. The Import file dialog will pop up. Select the file type (SQLite, JSON, or
Excel), enter the path of the file to import, and accept the dialog.
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Note: Changes from import operations are not committed immediately to any databases. You need to commit them
separately (see Committing and rolling back).

Tip: You can undo import operations using Edit -> Undo.

8.7.3 Exporting

Mass export

To export items in mass, go to File —> Export. The Mass export items dialog will pop up:

Databases ltems
v object class
¥ relationship class
v parameter definition
V| parameter tag
v example
v| parameter value list
object
relationship

parameter value

Select the databases you want to export under Databases, and the type of items under Items, then press Ok. The
Export file dialog will pop up now. Select the file type (SQLite, JSON, or Excel), enter the path of the file to export,
and accept the dialog.

Selective export

To export a specific subset of items, select the corresponding items in either Object tree and Relationship tree, right
click on the selection to bring the context menu, and select Export selected.

The Export file dialog will pop up. Select the file type (SQLite, JSON, or Excel), enter the path of the file to export,
and accept the dialog.

Session export

To export only uncommitted changes made in the current session, go to File —> Export session.
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The Export file dialog will pop up. Select the file type (SQLite, JSON, or Excel), enter the path of the file to export,
and accept the dialog.

Note: Export operations include all uncommitted changes.

8.7.4 Accessing/using exported files

Whenever you successfully export a file, a button with the file name is created in the Exports bar at the bottom of the
form. To open the file in your registered program, press that button. To open the containing folder, click on the arrow
next to the file name and select Open containing folder from the popup menu.

To add an exported SQLite file to a Data Store item in the current project, click on the arrow next to the file name
and select Add to project from the popup menu. The Add SQLite file to Project dialog will pop up. Select a Data
Store item from the list to become the host of the exported file. Alternatively, you can create a new Data Store item by
typing in the last row. When you’re done, press OK.

8.8 Committing and rolling back

Note: Changes are not immediately saved to the database(s). They need to be committed separately.

To commit your changes, select Session -> Commit from the menu bar, enter a commit message and press Commit.
Any changes made in the current session will be saved into the database.

To undo all changes since the last commit, select Session -> Rollback from the menu bar.

Tip: To undo/redo individual changes, use the Undo and Redo actions from the Edit menu.
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CHAPTER 9

Plotting

Basic data visualization is available in the Spine database editors. Currently, it is possible to plot plain parameter
values as well as time series and maps.

To plot a column, select the values from a table and then Plot from the right click popup menu.
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Selecting data in multiple columns plots the selection in a single window.

It is possible to add a plot to an existing plot window. Select the target plot window from the Plot in window submenu

and the data will be added to the plot.
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9.1 X axis for plain values

It is possible to plot plain values against X values given by a designated column in the pivot table.

To set a column as the X column right click the top empty area above the column header and select Use as X from the
popup menu. An (X) in the topmost cell indicates that the column is designated as containing the X axis.

Plot single column

parameter » operating_
Plot in window
commodity ¥ | direction w
Uze as X
water from_node 3.4 e T

When selecting and plotting other columns in the same table the data will be plotted against the values in the X column
instead of row numbers.
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cHAaPTER 10

Parameter value editor

Parameter value editor is used to edit object and relationship parameter values such as time series, time patterns or
durations. It can also convert between different value types, e.g. from a time series to a time pattern.

The editor is available from a right click popup menu or by double clicking a parameter value in one of the Spine
database editors.

10.1 Choosing value type

Parameter type |Flain value e

Flain value

Map

Time series - fixed resolution —
Time series - variable resolution
Time pattern
Datetime
Duration

The combo box at the top of the editor window allows changing the type of the current value.

10.2 Plain values

The simplest parameter values are of the Plain value type. These are numbers or booleans which can be set by entering
true or false on the Parameter value field.
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10.3 Maps

Parameter type | Flain value

Parameter value |III.IZI

]
]
=]
o]

Maps are nested data structures which can contain many different types of data including one and multi dimensional
indexed arrays. The current support for maps in Parameter value editor is rather bare bones. The map is shown as a
table where the last non-empty cells on each row contain the value while the preceding cells contain the value’s index.

Parameter type |Map

Index

2

3

5

1 2020-01-0100:0...

4 2020-01-0200:0...

Index or value

2020-01-0100:0...

2020-01-02 00:0...

2020-01-03 00:0...

2020-01-02 00:0...

2020-01-03 00:0...

Index or value

Value

A Right click popup menu gives options to add rows or columns (effectively adds a new dimension to map) or trim

empty columns from the right hand side.

At the moment the cell values have to be entered as JSON strings.
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10.4 Time series

There are two types of time series: variable and fixed resolution. Variable resolution means that the time stamps can
be arbitrary while in fixed resolution series the time steps between consecutive stamps are fixed.

Parameter type |T|me series - variable resolution vI

|:| Ignore year |:| Repeat

— 1
Time stamp Values & 'ﬁ é é .*. Q - Ii 'ﬁ
1 2019-01-D1T0C:.. -162,03
2 2018-01-01T01:... -156,36 =150 +
3 2019-01-01702:... -151,06 —200 1
4 2019-01-01703:... -153,52 —230 1
—300 4
5 2019-01-01T04... -158,91
—350 4
§  2019-01-01T0%:... -164,02
=400 4
7 2019-01-01T06... -175,56 oo L T
Lo O 6P oh o o ol | oP
0 0 0 0 0 0 0 0
g 2019-01-01T07... -283,11 B T L S
1] A019-01-01T0A: -ATATh =

Parameter type |T|me series - fixed resolution

Start time | 2019-01-01 00:00:00

| Calendar

Format: ¥ -MM-DOThh:mm:ss

AEI Q=B A

Resolution |I|J‘| |
Available units: s, m, h, D, M, ¥
=150 o
[1 Ignore year [ | Repeat
=200 4
Time stamp Values &
=250 4
1 2019-01-01T00:... -162,03
=300 +
2 2019-01-01T07:...  -1536,36
—350 4
3 2019-01-01T02:... -151,06
—400
4 2019-01-01T02:.. -153,52 T ot '
' ov  oF o oh o° b ol | o
Ay, v oY ey oY oY o, o
5  2019-01-01T(4:... -15891 1{}'\- 1{}'\- 1{}1 1{}1 1{}1 1{}1 1{}1 1{}1
£ 2018-01-01TRS  -1RA N2 ~

10.4. Time series
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The editor windows is split into two in both cases. The left side holds all the options and a table with all the data while
the right side shows a plot of the series. The plot is not editable and is for visualization purposes only.

In the table rows can be added or removed from a popup menu available by a right click. Data can be copied and
pasted by Ctrl-C and Ctrl-V. Copying from/to an external spreadsheet program is supported.

The time steps of a fixed resolution series are edited by the Start time and Resolution fields. The format for the start
time is ISO8601. The Resolution field takes a single time step or a comma separated list of steps. If a list of resolution
steps is provided then the steps are repeated so as to fit the data in the table.

The Ignore year option available for both variable and fixed resolution time series allows the time series to be used
independent of the year. Only the month, day and time information is used by the model.

The Repeat option means that the time series is cycled, i.e. it starts from the beginning once the time steps run out.

10.5 Time patterns

The time pattern editor holds a single table which shows the period on the right column and the corresponding values
on the left. Inserting/removing rows and copy-pasting works as in the time series editor.

Parameter type | Time pattern A
Tirne period Value
11-3,7d 4
2 4d 7
3 5,6d 5

10.6 Datetimes

The datetime value should be entered in ISO8601 format.
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Parameter type | Datetime ;I

Datetime | 2000-01-01T00:00:00 v
Format: YYyY-DD-MMThh:mm:ss

10.7 Durations

A single value or a comma separated list of time durations can be entered to the Duration field.

Parameter type | Duration ;I

Duration |I|J‘| |
Units: 5, m, h, D, M, ¥

Cancel
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cHAPTER 11

Importing and exporting data

This section explains the different ways of importing and exporting data to and from a Spine database.

11.1 Importing data with Importer

Data importing is handled by the Importer project item which can import tabulated and to some degree tree-structured
data into a Spine database from various formats. The same functionality is also available in Spine database editor
from File->Import but using an Importer item is preferred because then the process is documented and repeatable.

Tip: A Tool item can also be connected to Importer to import tool’s output files to a database.

The heart of Importer is the Import Editor window in which the mappings from source data to Spine database entities
are set up. The editor window can be accessed by the Import Editor... button in Importer’s Properties tab. Note, that
you have to select one of the files in the Source files list before clicking the button.
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Design Yiew Importer Properties g X

import

Source files
|j Chdata\Fake data\results.gdx
B5 ..tron scattering lengths and cross sections.xlsx

Cancel import on error

Import Editor. ..

The Import Editor windows is divided into two parts: Sources shows all the ‘sheets’ contained in the file, some
options for reading the file correctly, and a preview table to visualize and configure how the data on the selected sheet
would be mapped. Mappings, on the other hand, shows the actual importing settings, the mappings from the input
data to database entities.
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& Import Editor  -- import -- - O X
File
Sources Mappings
[ real part Options MNew Remove
[ imaginary part = —
Hag header: | e
Skip raws:
Skip columns:
Read until empty column on first row: [
Read until empty row on first column: []
AD Al A2 ~ Options
1 Neutron scatter... Class type: Object i Repeat time serie
2 lsotope conc Cohb e RET LR e
Read data from row:
3 H -3,739
4 1H 99,985 -3,7406
5 2H 0,015 6,671 Target Source type Source ref.
6 3H 12,32 4,792
Object names MNone
7 He 3,26
3 3He 0,00014 5,74
El AHe 99,9995 3,26 v
< >

The options in the Mappings part declare if the currently selected sheet will be imported as an object or relationship
and what type of parameters, if any, the sheet contains. The table can be used to configure how the input data is
interpreted: which row or column contains the entity class names, parameter values, time stamps and so on.
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Options

Class type: Object o Repeat time serie

Parameter type: Single value -
Read data from row:

Target Source type Source ref,
Object names Mone

Parameter names MNone

It might be helpful to fill in the mapping options using the preview table in the Sources part. Right clicking on the
table cells shows a popup menu that lets one to configure how the rows and colunms are read upon importing.

A0 AT A 2 2 Opt
1 Meutron scatter.., Cla
2 W conc Coh b -
3 H Map column to... r -39 Rei
Map header to... ’
4 H Map row to... r Object class names
5 2H Map all headers to... * Object names
Parameter names
6 3H 12,32 4
Pararneter values
7 J
/ He 3,26
Parar
8 IHe 0,00014 5,74
9 4He 99,9999 3,26 v .
£ >

An important aspect of data import is whether each item in the input data should be read as a string, a number, a
time stamp, or something else. By default all input data is read as strings. However, more often than not things like
parameter values are actually numbers. It is possible to control what type of data each column (and, sometimes, each
row) contains from the preview table. Clicking the data type indicator button on column headers pops up a menu with
a selection of available data types. Right clicking the column header also gives the opportunity to change the data type
of all columns at once.
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|A 4 Als A

datetime
duration
float
string

integer sequence datetime

5,592 2,05

11.2 Exporting to GAMS

Note: You need to have GAMS installed to use this functionality. However, you do not need to own a GAMS license
as the demo version works just as well.

Note: The bitness (32 or 64bit) of GAMS has to match the bitness of the Python interpreter.

Databases can be exported to GAMS . gdx files by the Exporter project item. When a project is executed, Exporter
writes its output files to its data folder and forwards file paths to project items downstream. If a Tool is to use such a
file, remember to add the file as one of the Tool specification’s input files!

The mapping between entities in a Spine database and GAMS is as follows:

Database entity GAMS entity

Object class Universal set (or domain)
Object Universal set member
Object parameter Parameter

Relationship class Subset of universal sets
Relationship Subset member
Relationship parameter | Parameter

Note: Currently, it is not possible to use subsets (relationship classes) as dimensions for other subsets due to technical
limitations. For example, if there is a domain A(*) and a subset foo(A), a subset of foo has to be expressed as bar(A)
instead of bar(foo).

It is also possible to designate a single object class as a Global parameter. The parameters of the objects of that class
will be exported as GAMS scalars.

Some GAMS models need their data to be in a specific order in the .gdx. This is not directly supported by the
database. Rather, user has to specify the desired exporting order using the Exporter item’s settings.

11.2.1 Exporter Project Iltem

The image below shows the settings tab of Exporter with two Data Sources connected to it.
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Exporter Properties i

Gdx export

sqlite:/ f /C:/data/databases/times_mochk.sqlite

Filename: |nut.gdx

sqlite:/ f /C:/data/databases/times_test_database_for_table_view.sqglite

Filename: |in.gdx

For each connected Data Store a box with the database’s URL and export file name field is shown on the tab. The
Settings. .. buttons open Gdx Export settings windows to allow editing database specific export parameters such as
the order in which entities are exported from the database.

+» Odx Export settings  -- sqlite:///C:/data/databases/times_mock.sglite -- — O >

Sets et Contents
[ glebals first_ week
ALL TS second_week
ALL_REG third_week :

= - Alphabetic
COM_GRP Move Up
time_stamps Mowe Down
COM Mowe Down
REG

COM_DESC

Indexed parameters. ..

Global parameters domain: | globals e
Restore Defaults Cancel

The Gdx Export settings window (see above) contains a Sets list which shows all GAMS sets (gray background) and
subsets that are available in the database. The sets are exported in the order they are shown in the list. The Move Up
and Move Down buttons can be used to move the selected set around. Note that you cannot mix sets with subsets so
all sets always get exported before the subsets.

The checkbox next to the set name is used to control which sets are actually exported. Note that it is not possible to
change this setting for certain sets. Global parameters domain is never exported, only its parameters which become
GAMS scalars. Further, sets created for Indexed paramaters are always exported.
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The Set Contents box lists the members of the selected set or subset. Their order of export can be changed the same
way as with sets by Move Up and Move Down. The Alphabetic button sorts the members alphabetically.

Time series and time patterns cannot be exported as-is. They need to be tied up to a GAMS set. This can be achieved
from the window that opens from the Indexed parameters... button. See the Exporting time series and patterns
section below for more information.

Finally, one of the sets can be designated as the global parameter set. This is achieved by choosing the set’s name in
the Global parameters domain box. Note that this set is not exported, only its parameters are. They end up as GAMS
scalars.

11.2.2 Exporting time series and patterns

Since GAMS has no notion of time series or time patterns these types need special handling when exported to a . gdx
file. Namely, the time stamps or time periods (i.e. parameter indexes) need be available as GAMS sets in the exported
file. It is possible to use an existing set or create a new one for this purpose. The functionality is available in Gdx
Parameter Indexing Settings window accessible from the Indexed Parameters. .. button.

o Gdx Parameter Indexing Settings  -- sqliter///C:/data/databases/times_mock.sqlite -- — | pot

size
Parameter successfully indexed.

Indexing domains: (COM_GRP, ALL_TS) Move Left Move Right

(®) Use existing domain ALL_TS sweets

ALL_TS "

Label picking expression: I:I

() Create new index domain

1 first_week
2 second_week 13.8

3 third_week
Domain name:

Description:

Generator expression:

The above figure shows the indexing settings when an existing GAMS set is used to replace the original time stamps
of a time series in a parameter called ‘size’. The choice between using an existing set or creating a new one can be
changed by the Use existing domain and Create new index domain radio buttons. When using an existing set it is
selected by the combo box. In the above figure, ALL TS set is used for indexing.

In case of existing set it is possible that not all the set’s contents are used for indexing. The table occupying the right
side of the above figure shows which of the set’s keys index which parameter values. The first column contains the
keys of the currently selected set whereas the other columns contain the parameter’s values, one column for each object
that has the parameter. Selecting and deselecting rows in the table changes the indexing as only the keys on selected
rows are used to index the parameter. Shift, ctrl and ctrl-A help in manual selection. If the selected indexes have
certain pattern it might be useful to utilize the Label picking expression field which selects the set keys using a Python
expression returning a boolean value. Some examples:
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Expression Effect

i == Select the third row only
i%2==0 Select even rows

(1 + 1) $ 2 == 0 and 1 != 9 | Select odd rows except row 9

The Indexing domains list allows to shuffle the order of the parameter’s dimensions. The bold dimension is the new
dimension that is added to the parameter. It can be moved around by the Move Left and Move Right buttons.

+ Gdx Parameter Indexing Settings

-- sglite:///C:/data/databases/times_mock.sqglite -- - O >

winterness

Parameter successfully indexed.

Indexing domains: (REG_GRP, time_stamps) Move Left Move Right

() Use existing domain
ALL_REG
Label picking expression:

(® Create new index domain

Domain name: |time_stamps |

Description: |T'-,'|:|E explanatory text ... |

Generator expression: |:|

Extract index from parameter

time_stamps

Antarktis

1 2019-01-01T00:... 1.0
2 2019-04-01T00:... 2.0
3 2019-07-01T00:... 3.0

4 2019-10-01T00:... 2.5

Europa
1.5

0.7
0.0

0.9

It is possible to create a new indexing set by choosing Create new index domain as shown in the figure above. Domain
name is mandatory for the new domain. A Description can also be provided but it is optional. There are two options
to generate the index keys: extract the time stamps or time periods from the parameter itself or generate them using a
Python expression. The Extract index from parameter button can be used to extract the keys from the parameter. The
Generator expression field, on the other hand, is used to generate index keys for the new set. The expression should
return Python object that is convertible to string. Below are some example expressions:

Keys

Expression
i

1,2,3,...

f"{i - 1:04}"

0000, 0001, 0002.,...

E"T{i:03}"

T001, TO02, TOO3,...
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cHAPTER 12

Spine datapackage editor

Note: This section is a work in progress.

This section describes the Spine datapackage editor, used to interact with tabular data and export it into Spine format.

To open the Spine datapackage editor, select a Data Connection with CSV files in it, and press the Datapackage
button in its Properties:
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Design View Data Connection Properties (5 ()
| Data Connectiom 1 |
References
Data Connection 1
mmmm—————
1 [
gy | +[=m
!_- j Data
i 1 i 37 _inetoolbox/items/data_connection_1/bus_flat.csv
T T o ..spinetoolbox/items/data_connection_1/branch.csv
ﬁ? .. 2/.spinetoolbox/items/data_connection_1/gen.csv
i:? ..netoolbox/items/data_connection_1/gengroup.csv
«+» Datapackage
| —3
L] L
File Edit View
Resources Data Fields @
name sourc || f_bus t_bus br_r br_x br_b tap rate_a rate_b outage_rate outage_duratioi™ name type  primary key?
bus_flat bus_flatc | |1 |2 0.003 0.014 0461 0 193 200 0.24 16 _bus integer
branch branch.cs | |1 3 0.055 0.211 0.057 0 208 220 051 10 t_bus integer
gen gen.csv 1 5 0022 0085 0023 0 208 220 0.33 10 br_r number
gengroup gengroup || 2 4 0.033 0.127 0034 0 208 220 039 10 br_x number
2 6 005 0192 0052 0 208 220 0.48 10 br_b number
3 9 0031 0119 0032 0 208 220 0.38 10 tap integer
3 24 0002 0084 0 1015 510 600 0.02 768 rate_a integer
4 9 0027 0104 0028 0 208 220 036 10 rate_b integer
5 10 0023 0088 0024 0 208 220 0.34 10 outage_rate number
6 10 0014 0061 2459 0 193 200 0.33 35 outage_duration  integer
7 8 0016 0061 0017 0 208 220 03 10 weighting_factor | number
8 9 0043 0165 0045 0 208 220 044 10 br_status integer
8 10 0043 0.165 0045 0 208 220 0.44 10 angmin integer
9 11 0002 0084 0 103 510 600 0.02 768 angmax integer
9 12 0002 0084 0 103 510 600 0.02 768 Shift integer
10 11 0002 0084 0 1015 510 600 0.02 768 internal integer
10 12 0.002 0084 0 1015 510 600 0.02 768
11 13 0006 0048 01 0 600 625 0.4 11
11 |14 0005 0.042 0088 0 600 625 0.39 11
12 13 0006 0048 01 0 600 625 0.4 11 Foreign keys am
12 |23 0012 0097 0203 0 600 625 0.52 11
13 23 0.011 0.087 0.182 0 600 625 049 11 fields reference resource reference fields
14 |16 0005 0.059 0082 0 600 625 0.38 11 1
15 |16 0.002 0017 0036 0 600 625 0.33 11
15 21 0.006 0.049 0103 0 600 625 0.41 11
15 21 0.006 0.049 0103 0 600 625 0.41 11
15 24 0.007 0.052 0109 0 600 625 0.41 11
16 |17 0.003 0026 0055 0 600 625 0.35 11
16 19 0.003 0023 0049 0 600 625 0.34 11
17 |18 0002 0014 003 0 600 625 0.32 11
17 22 0014 0105 0221 0 600 625 054 11
18 21 0.003 0.026 0055 0 600 625 0.35 11
18 21 0003 0026 0055 0 600 625 0.35 11 _
4 » :" o e oo o - o T o " » '] »
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cHAPTER 13

Terminology

Here is a list of definitions related to Spine project, SpineOpt.jl, and Spine Toolbox.

Arec Graph theory term. See Connection.

Case study Spine project has 13 case studies that help to improve, validate and deploy different aspects of the
SpineOpt.jl and Spine Toolbox.

Connection an arrow on Spine Toolbox Design View that is used to connect project items to each other to form
a DAG.

Data Connection is a project item used to store a collection of data files that may or may not be in Spine data
format. It facilitates data transfer from original data sources e.g. spreadsheet files to Spine Toolbox. The original
data source file does not need to conform to the format that Spine Toolbox is capable of reading, since there we
can use an interpreting layer (Importer) between the raw data and the Spine format database (Data Store).

Data Package is a data container format consisting of a metadata descriptor file (datapackage. json) and
resources such as data files.

Data sources are all the original, unaltered, sources of data that are used to generate necessary input data for
Spine Toolbox tools.

Data Store is a project item. It’s a Spine Toolbox internal data container which follows the Spine data model.
A data store is implemented using a database, it may be, for example, an SQL database.

Design View A sub-window on Spine Toolbox main window, where project items and connections are visual-
ized.

Direct predecessor Immediate predecessor. E.g. in DAG x->y->z, direct predecessor of node z is node y. See
also predecessor.

Direct successor Immediate successor. E.g. in DAG x->y->z, direct successor of node x is node y. See also
successor.

Directed Acyclic Graph (DAG) Finite directed graph with no directed cycles. It consists of vertices and edges.
In Spine Toolbox, we use project items as vertices and connections as edges to build a DAG that represents a
data processing chain (workflow).

Edge Graph theory term. See Connection
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Exporter is a project item that allows exporting a Spine data structure from a Data Store into a file which can
be used as an input file in a Tool.

Importer is a project item that can be used to import data from e.g. an Excel file, transform it to Spine data
structure, and into a Data Store.

Node Graph theory term. See Project item.

Predecessor Graph theory term that is also used in Spine Toolbox. Preceding project items of a certain project
item in a DAG. For example, in DAG x->y->z, nodes x and y are the predecessors of node z.

Project in Spine Toolbox consists of project items and connections, which are used to build a data processing
chain for solving a particular problem. Data processing chains are built and executed using the rules of Directed
Acyclic Graphs. There can be any number of project items in a project.

Project item Spine Toolbox projects consist of project items. Project items together with connections are used
to build Directed Acyclic Graphs (DAG). Project items act as nodes and connections act as edges in the DAG.

Scenario A scenario is a meaningful data set for the target tool.

Spine data structure Spine data structure defines the format for storing and moving data within Spine Toolbox.
A generic data structure allows representation of many different modelling entities. Data structures have a class
defining the type of entity they represent, can have properties and can be related to other data structures. Spine
data structures can be manipulated and visualized within Spine Toolbox while SpineOpt.jl will be able to directly
utilize as well as output them.

SpineOpt.jl An interpreter, which formulates a solver-ready mixed-integer optimization problem based on the
input data and the equations defined in the SpineOpt.jl. Outputs the solver results.

Source directory In context of Tool specifications, a source directory is the directory where the main program
file of the Tool specification is located. This is also the recommended place for saving the Tool specification file
(.json).

Successor Graph theory term that is also used in Spine Toolbox. Following project items of a certain project
item in a DAG. For example, in DAG x->y->z, nodes y and z are the successors of node x.

Tool is a project item that is used to execute Python, Julia, GAMS, executable scripts, or simulation models.
This is done by creating a Tool specification defining the script or program the user wants to execute in Spine
Toolbox. Then you need to attach the Tool specification to a Tool project item. Tools can be used to execute a
computational process or a simulation model, or it can also be a process that converts data or calculates a new
variable. In general, Tools may take some data as input and produce an output.

Tool specification is a JSON structure that contains metadata required by Spine Toolbox to execute a compu-
tational process or a simulation model. The metadata contains; type of the program (Python, Julia, GAMS,
executable), main program file (which can be e.g. a Windows batch (.bat) file or for Python scripts this would be
the .py file where the __main__() method is located), All additional required program files, any optional input
files (e.g. data), and output files. Also any command line arguments can be defined in a Tool specification.
SpineOpt.jl is a Tool specification from Spine Toolbox’s point-of-view.

Use case Potential way to use Spine Toolbox. Use cases together are used to test the functionality and stability
of Spine Toolbox and SpineOpt.jl under different potential circumstances.

Vertice Graph theory term. See Project item.
View A project item that can be used for visualizing project data.

Work directory Tool specifications can be executed in Source directory or in work directory. When a Tool
specification is executed in a work directory, Spine Toolbox creates a new work directory, copies all required
and optional files needed for running the Tool specification to this directory and executes it there. After execution
has finished, output or result files can be copied into a timestamped (archive) directory from the work directory.
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cHAPTER 14

Dependencies

Spine Toolbox requires Python 3.6 or Python 3.7. Python 3.8 is not supported yet.

Spine Toolbox uses code from packages and/or projects listed in the table below. Required packages must be installed
for the application to start. Users can choose the SQL dialect API (pymysql, pyodbc psycopg2, and cx_Oracle) they
want to use. These can be installed in Spine Toolbox when needed. If you want to deploy the application by using the
provided setup.py file, you need to install cx_Freeze package (6.0bl version or newer is recommended). All version
numbers are minimum versions except for pyside2, where the version should be 5.14. Version 5.15 is not supported
(yeo).

14.1 Required packages

The following packages are installed when spinetoolbox package is installed via setup.py or requirements.
txt
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Package name | Version License
pyside2 >=5.14,<5.15 | LGPL
datapackage 1.2.3 MIT
jupyter-client <5.3.2 BSD
gtconsole 4.3.1 BSD
sqlalchemy 1.2.6 MIT
spinedb_api 0.1.15 LGPL
spine_engine 0.4.0 LGPL
openpyxl 2.5.0 MIT/Expat
numpy 1.15.1 BSD
matplotlib 3.0 BSD
scipy 1.1.0 BSD
networkx 2.2 BSD
pymysql 0.9.2 MIT
pyodbc 4.0.23 MIT
psycopg2 274 LGPL
cx_Oracle 6.3.1 BSD
python-dateutil 2.8.0 PSF
pandas 0.24.0 BSD
jsonschema 2.6 MIT
gdx2py 2.04 MIT

14.1.1 Developer packages

The developer packages are available from dev-requirements.txt. Sphinx and sphinx_rtd_theme packages
are needed for building the user guide. Black is used for code formatting while pylint does linting. Pre-commit hook
enables automatic code formatting at git commit.

Package name Version | License
black 19.3b0 | MIT
pre-commit 1.16.1 MIT
pylint 2.3.0 GPL
sphinx 1.7.5 BSD
sphinx_rtd_theme | 0.4.0 MIT
recommonmark 0.5.0 MIT
sphinx-autoapi 1.1.0 MIT
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cHAPTER 15

Contribution Guide for Spine Toolbox

All are welcome to contribute! This guide is based on a set of best practices for open source projects [JF18].

15.1 Reporting Bugs

15.1.1 Due Diligence

Before submitting a bug report, please do the following:
Perform basic troubleshooting steps.

1. Make sure you’re on the latest version. If you’re not on the most recent version, your problem may have been
solved already! Upgrading is always the best first step.

2. Try older versions. If you're already on the latest release, try rolling back a few minor versions (e.g. if on 1.7,
try 1.5 or 1.6) and see if the problem goes away. This will help the devs narrow down when the problem first
arose in the commit log.

3. Try switching up dependency versions. If you think the problem may be due to a problem with a dependency
(other libraries, etc.). Try upgrading/downgrading those as well.

4. Search the project’s bug/issue tracker to make sure it’s not a known issue. If you don’t find a pre-existing
issue, consider checking with the maintainers in case the problem is non-bug-related.

15.1.2 What to Put in Your Bug Report

Make sure your report gets the attention it deserves: bug reports with missing information may be ignored or
punted back to you, delaying a fix. The below constitutes a bare minimum; more info is almost always better:

1. What version of the Python interpreter are you using? E.g. Python 2.7.3, Python 3.6?

2. What operating system are you on? Windows? (Vista, 7, 8, 8.1, 10). 32-bit or 64-bit? Mac OS X? (e.g. 10.7.4,
10.9.0) Linux (Which distro? Which version of that distro? 32 or 64 bits?) Again, more detail is better.
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3. Which version or versions of the software are you using? If you have forked the project from Git, which branch
and which commit? Otherwise, supply the application version number (Help->About menu). Also, ideally you
followed the advice above and have ruled out (or verified that the problem exists in) a few different versions.

4. How can the developers recreate the bug? What were the steps used to invoke it. A screenshot demonstrating
the bug is usually the most helpful thing you can report (if applicable) Relevant output from the Event Log or
debug messages from the console of your run, should also be included.

15.2 Feature Requests

The developers of Spine Toolbox are happy to hear new ideas for features or improvements to existing functionality.
The format for requesting new features is free. Just fill out the required fields on the issue tracker and give a description
of the new feature. A picture accompanying the description is a good way to get your idea into development faster.
But before you make a new issue, check that there isn’t a related idea already open in the issue tracker. If you have an
idea on how to improve an existing issue, just join the conversation.

15.3 Submitting features/bugfixes

If you feel like you can fix a bug that’s been bothering you or you want to add a new feature to the application but
the devs seem to be too busy with something else, please follow the instructions in the following sections on how to
contribute code.

15.3.1 Coding Style

Follow the style you see used in the repository! Consistency with the rest of the project always trumps other consider-
ations. It doesn’t matter if you have your own style or if the rest of the code breaks with the greater community - just
follow along.

Spine Toolbox coding style follows PEP-8 style guide for Python code with the following variations:
e Maximum line length is 120 characters. Longer lines are acceptable if there’s a sound reason.

* Google style docstrings with the title and input parameters are required for all classes, functions, and methods.
For small functions or methods only the summary is necessary. Return types are highly recommended but not
required if it is obvious what the function or method returns.

¢ Other deviations from PEP-8 can be discussed if there are good reasons.

15.3.2 Commit messages

The commit message should tell what was changed and why. Details on how it was done can usually be left out, if the
code itself is self-explanatory (remeber source comments too!). Separate the subject line from the body with a blank
line. The subjet line (max. 50 chars) should explain in condensed form what happened using imperative mood, i.e.
using verbs like ‘change’, ‘fix’ or ‘add’. Start the subject line with a capital letter. Do not use the issue number on
the subject line, as it does not tell much to a person who’s not aware of that particular issue. For more info see Chris
Beams’ ‘Seven rules of of a great Git commit message’ [CB14].

A good example (insipred by [CB14])
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Fix bugs when updating parameters in foo and bar

Body of the commit message starts after a blank line. Explain here in more

detail the reasons why you made the change, how things worked before and how they,
—work now.

Also explain why

You can use hyphens to make bulleted lists:
- Foo was added because of bar
- Baz was not used so it was deleted

Add references to issue tracker (if any) at the end.

Solves: #123
See also: #456, #789

15.3.3 Contributing to the User Guide

Spine Toolbox uses Sphinx to create HTML pages from restructured text (.rst) files. The .rst files are plain text files that
are formatted in a way that Sphinx understands and is able to turn them into HTML. Please see this brief introduction
for more on reStructured text. You can modify the existing or create new .rst files into docs/source directory.
When you are done editing, run bin/build_doc.bat on Windows or bin/build_doc. sh on Linux to build
the HTML pages. The created pages are found in docs/build/html directory.

15.3.4 Contributing to the Spine Toolbox Graphical User Interface

If you want to change or add new widgets into the application, you need to use the bin\build_ui.bat (Win-
dows) or bin/build_ui.sh (Linux) scripts. The main design of the widgets should be done with Qt Designer
(designer.exe or designer) that is included with PySide2. The files produced by Qt Designer are XML files
(-ui). You can also embed graphics (e.g. icons, logos, etc.) into the application by using Qt Designer. When you are
done modifying widgets in the designer, you need to run the build_ui script for the changes to take effect. This
script uses tools provided in the PySide2 package to turn .ui files into Python files, in essence rebuilding the whole
Spine Toolbox user interface.

Styling the widgets should be done with Qt Style Sheets in code. Avoid using style sheets in Qt Designer.

15.3.5 Version Control Branching

Always make a new branch for your work, no matter how small. This makes it easy for others to take just that one
set of changes from your repository, in case you have multiple unrelated changes floating around. A corollary: don’t
submit unrelated changes in the same branch/pull request! The maintainer shouldn’t have to reject your awesome
bugfix because the feature you put in with it needs more review.

Name your new branch descriptively, e.g. issue#XXX-fixing-a-serious-bug or
issue#ZZZ-cool-new-feature. New branches should in general be based on the latest dev branch. In
case you want to include a new feature still in development, you can also start working from its branch. The
developers will backport any relevant bug-fixes to previous or upcoming releases under preparation.

If you need to use code from an upstream branch, please use git-rebase if you have not shared your work with others
yet. For example: You started working on an issue, but now the upstream branch (master) has some new commits
you would like to have in your branch too. If you have not yet pushed your branch, you can now rebase your changes
on top of the upstream branch:
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$ git pull origin master:master
$ git checkout my_branch
$ git rebase master

Avoid merging the upstream branch to your issue branch if it’s not necessary. This will lead to a more linear and
cleaner history.

Finally, make a pull request from your branch so that the developers can review your changes. You might be asked to
make additional changes or clarifications or add tests to prove the new feature works as intended.

15.3.6 Test-driven development is your friend
Any bug fix that doesn’t include a test proving the existence of the bug being fixed, may be suspect. Ditto for new
features that can’t prove they actually work.

It is recommended to use test-first development as it really helps make features better designed and identifies potential
edge cases earlier instead of later. Writing tests before the implementation is strongly encouraged.

15.3.7 Full example

Here’s an example workflow. Your username is yourname and you’re submitting a basic bugfix.
Preparing your Fork
1. Click ‘Fork’ on Github, creating e.g. yourname/Spine-Toolbox
2. Clone your project: git clone git@github.com:yourname/Spine-Toolbox
3. cd Spine-Toolbox
4. Create a virtual environment and install requirements
5. Create a branch: git checkout -b foo-the-bars master
Making your Changes
1. Add changelog entry crediting yourself.
2. Write tests expecting the correct/fixed functionality; make sure they fail.
3. Hack, hack, hack.
4. Run tests again, making sure they pass.
5. Commit your changes: git commit -m "Foo the bars"
Creating Pull Requests
1. Push your commit to get it back up to your fork: git push origin HEAD
2. Visit Github, click handy ‘Pull request* button that it will make upon noticing your new branch.

3. In the description field, write down issue number (if submitting code fixing an existing issue) or describe the
issue + your fix (if submitting a wholly new bugfix).

4. Hit ‘submit’! And please be patient - the maintainers will get to you when they can.

15.4 References
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cHAPTER 16

Developer documentation

Here you can find developer specific documentation on Spine Toolbox.

16.1 Project item development

This document discusses the structure of project items, how they interact with the Toolbox GUI and how they are
executed.

The core of every project item consists of two classes: a static project item class which is a subclass
of spinetoolbox.project_item.ProjectItem and an executable, a subclass of spinetoolbox.
executable item base.ExecutableItemBase. The static item is responsible for integrating the item with
the Toolbox while its executable counterpart exists only during execution.

Additional classes are needed to fully define a project item:

spinetoolbox.project_item.ProjectItemFactory assists Toolbox in constructing project items.

Toolbox needs to know an item’s type and category. This is achieved by spinetoolbox.
project_item info.ProjectItemInfo

The item’s Design view icon is inherited from spinetoolbox.graphics_items.ProjectItemIcon.
Properties tab widget and other UI widgets are needed to change the item’s settings.

An add project item widget is used by Toolbox right after a new item has been created. Some
project items use the general purpose spinetoolbox.widgets.add project_item widget.
AddProject ItemiWidget while others may use more specialized widgets.

Items that support specifications need spinetoolbox.project_item specification_factory.
ProjectItemSpecificationFactory

16.1.1 Getting started

Probably the most convenient way to start developing a new project item is to work with a copy of some simple project
item. For example, View provides a nice starting point.
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16.1.2 Project item packages

Project items are mostly self-contained Python packages. Toolbox expects certain modules to exist in the package:

e __init__ .py which contains an TtemFactory class which must be a subclass of spinetoolbox.
project_item.ProjectItemFactory and an ItemInfo class which must be a subclass of
spinetoolbox.project_item info.ProjectItemInfo

* executable_item.py which contains an ExecutableItem class, a subclass of spinetoolbox.
executable item base.ExecutableltemBase

* optional for items that support specifications: specification_factory.py
which contains a SpecificationFactory class, a subclass of spinetoolbox.
project_item specification_factory.ProjectItemSpecificationFactory

It is customary to structure the project item packages like the Toolbox itself: mvcmodels submodule for Qt’s models,
ui module for automatically generated UI forms and widgets for the widget’s business logic.

16.1.3 Item info

spinetoolbox.project_item_info.ProjectItemInfo is used by Toolbox to query two important
pieces of knowledge from a project item: type and category. Type identifies the project item while category is used by
the Toolbox GUI to group project items with similar function.

Categories are predefined by Toolbox. Currently available categories are: Data Connections, Data Stores, Importers,
Exporters, Manipulators, Tools and Views.

16.1.4 Executable item

Usually, most of project item’s code is for setting up the item via Toolbox GUI and for integrating the item into the
Design View. The code that is run during execution by Spine Engine, the executble item, is usually contained in a single
class which must be a subclass of spinetoolbox.executable item base.ExecutableltemBase.

Executable items live in a separate environment to the rest of the project item. They are constructed by the Toolbox
only during execution and mainly interact with Spine Engine. As such, the executable items are expected to not use
any GUI code or have any interaction with users.

One common aspect between executable items and ‘static’ project items (subclasses of spinetoolbox.
project_item.ProjectItem) are resources. However, executable items cannot pass transient_file type
resources since all file URLs need to point to existing files during execution.

16.1.5 Factories

Toolbox utilizes spinetoolbox.project_item.ProjectItemFactory to instantiate new project items
in the Design View. For this purpose, the class provides methods to create an icon to show in Toolbox toolbar,
an add item dialog, an icon to show on the Design view (a subclass of spinetoolbox.graphics_items.
ProjectItemIcon), construct the project item itself, and some methods to deal with items that support specifica-
tions.

16.1.6 Specifications

Project item specifications are template or predefined configurations for certain tasks. For example, a tool might have
a specification which defines input files, command line parameters and other settings for running a specific model
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generator. Specifications are an opt-in feature and project items need to implement the corresponding methods in
spinetoolbox.project_item.ProjectItemFactory such that Toolbox knows the item supports them.

16.1.7 Toolbox GUI integration

Toolbox shows a project item’s icon which it gets from the item factory’s spinetoolbox.project_item.
ProjectItemFactory.icon () method on the toolbar. The method returns an URL to the icon’s resource in
Toolbox’ resources. Items that support specifications may get their icon in the specifications toolbar as well, if a
proper specification has been added to the project.

After dragging and dropping a project item from the toolbar onto the design view, Toolbox calls spinetoolbox.
project_item.ProjectItemFactory.make_1icon () toconstruct the item on the design view. This icon is
a subclass of spinetoolbox.graphics_items.ProjectItemIcon. To prompt the user for the new item’s
name and optionally other initial properties, Toolbox shows the Add item dialog it gets from spinetoolbox.
project_item.ProjectItemFactory.make_add_item_widget ()

Once the item is on the design view, the main interaction with it goes through the properties tab which is created by
spinetoolbox.project_item.ProjectItemFactory.make_properties_widget (). The proper-
ties tab widget should have all the needed controls to set up the item.

Every time a DAG on the design view changes, Toolbox calls spinetoolbox.project_item.ProjectItem.
_do_handle_dag_changed () on the affected items. This method should be reimplemented to update the project
item and check its status, e.g. if all required inputs are available. Issues can be reported by spinetoolbox.
project_item.ProjectItem.add _notification () and the notification cleared by spinetoolbox.
project_item.ProjectItem.clear_notifications ()

16.1.8 Saving and restoring project items

Project items are saved in JSON format as part of the project.json file. Item saving is handled by spinetoolbox.
project_item.ProjectItem.item dict () which should return a JSON compatible dict and contain at
least the information in the dict returned by the base class method.

File system paths are handled specifically during saving: all paths outside the project directory should be absolute
while the paths in the project directory should be relative. This is to enable self-contained projects which include all
needed files and can be easily transferred from system to system. As such, paths are saved as special dictionar-
ies. spinetoolbox.helpers.serialize_path(), spinetoolbox.helpers.serialize_url ()
and spinetoolbox.helpers.deserialize_path () help with dealing with the paths.

spinetoolbox.project_item.ProjectItem.from_dict () is responsible for reconstructing a save
project item from the dictionary. spinetoolbox.project_item.ProjectItem.parse_item_dict ()
can be utilized to deserialize the basic data needed by the base class.

16.1.9 Passing data between items: resources

Project items share data by files or via databases. One item writes a file which is then read by another item. Project
item resources are used to communicate the URLs of these files and databases.

Resources are instances of the spinetoolbox.project_item resource.ProjectItemResource class.

Both static items and their executable counterparts pass resources. The major difference is that static item’s may pass
resource promises such as files that are generated during the execution. The full path to the promised files or even their
final names may not be known until the items are executed.

During execution resources are propagated only to item’s direct predecessors and successors. Static items offer their
resources to direct successors only. Resources that are communicated to successor items are basically output files that
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the successor items can use for input. Currently, the only resource that is propagated to predecessor items is database
URLSs by Data Store project items. As Data Stores leave the responsibility of writing to the database to other items it
has to tell these items where to write their output data.

The table below lists the resources each project item type provides during execution.

Item Notes | Provides to predecessor | Provides to successor
Combiner n/a n/a

Data Connection | ' n/a File URLs

Data Store ? Database URL Database URL

Exporter n/a File URLs

Gimlet n/a Resources from predecessor
Importer n/a n/a

Tool 3 n/a File URLs

View n/a n/a

The table below lists the resources that might be used by each item type during execution.

ltem Notes | Accepts from predecessor | Accepts from successor
Combiner 4 Database URL Database URL

Data Connection n/a n/a

Data Store n/a n/a

Exporter Database URL n/a

Gimlet 3 File URLs, database URLs Database URLs

Importer 0 File URLs Database URL

Tool 7 File URLs, database URLs Database URLs

View Database URLs n/a

16.1.10 Execution

The executable counterparts for project items in a DAG are created before execution. The current settings of each item
are passed to the executable which is then sent to Spine Engine for execution.

The DAG is executed in two phases: first backwards then forwards. During backward execution, the DAG is executed
in an inverted order and resources are propagated to direct predecessors. No current project item actually executes any
other code besides storing these resources for later use. Forward execution is when the project items do their actions.

When executing in either direction:

1. spinetoolbox.executable item base.ExecutableltemBase.execute () is invoked with a
list of available resources and current execution direction.

2. The resources returned by spinetoolbox.executable item base.ExecutableltemBase.
output_resources () are accumulated and passed to the execute () of the successor item.

I Data connection provides paths to local files.

2 Data Store provides a database URL to direct successors and predecessors. Note, that this is the only project item that provides resources to
it’s predecessors.

3 Tool’s output files are specified by a Tool specification.

4 Combiner requires a database URL from its successor for writing the output data.

3 Gimlet’s resources can be passed to the command as command line arguments but are otherwise ignored.

6 Importer requires a database URL from its successor for writing the mapped data. This can be provided by a Data Store.

7 Tool specification specifies tool’s optional and required input files. Database URLs can be passed to the tool program via command line
arguments but are otherwise ignored by the Tool project item. Currently, there is no mechanism to know if a URL is actually required by a tool
program. For more information, see Tool specification editor.
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The execute() method further delegates the execution to the overridable spinetoolbox.
executable item base.ExecutableltemBase._execute_ forward () and spinetoolbox.

executable item base.ExecutableItemBase._execute_backward() methods. Similarly,
output_resources () calls the spinetoolbox_executable_item_base.ExecutableltemBase.
_output_resources_forward () and spinetoolbox_executable_item_base.

ExecutableltemBase._output_resources_backward () methods.

The executable items need additional properties to function. The table below lists the properties for each item. Basi-
cally, these are the arguments that are provided to each executable’s __init___ method.

Item Notes | Properties

Combiner Log directory

Cancel on error flag
File references

10 Data files

Data Store Database URL

Gimlet Shell name

Command

Work directory

Data files

Exporter Export settings

Output directory

- GAMS system directory
Cancel on error flag
Importer Mapping settings

Log directory

Python system directory
GAMS system directory
Cancel on error flag
Tool Work directory

Output directory

Tool specification
Command line arguments
View n/a

Data Connection

5

T6

8 A flag indicating if the combine database operation should stop when an error is encountered.

9 Path to files which can be anywhere in the file system.
10 Files which reside in the item’s data directory.

' Including command line arguments.
12 Path to the directory which contains a GAMS installation. Required to find the libraries needed for writing . gdx files.
13 Path to the directory which contains a Python installation. Required to run the import operation in a separate process.
14 Path to the directory which contains a GAMS installation. Required to find the libraries needed for reading . gdx files.
15 A flag indicating if the export operation should stop when an error is encountered.
16 A flag indicating if the import operation should stop when an error is encountered.
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API Reference

This page contains auto-generated API reference documentation'.

17.1 spinetoolbox

spinetoolbox package.

17.1.1 Subpackages

spinetoolbox.configuration assistants

Standard assistants.
author
M. Marin (KTH)
date 17.2.2020

Subpackages
spinetoolbox.configuration_assistants.spine_opt

SpineOpt.jl config assistant.
author
M. Marin (KTH)
date 17.2.2020

! Created with sphinx-autoapi
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Submodules
spinetoolbox.configuration_assistants.spine_opt.configuration_assistant

Widget for assisting the user in configuring SpineOpt.jl.
author
M. Marin (KTH)
date 9.1.2019

Module Contents

Classes

SpineOptConfigurationAssistant A widget with a state machine.

class spinetoolbox.configuration_assistants.spine_opt.configuration_assistant.SpineOptConft:
Bases: spinetoolbox.widgets.state _machine widget.StateMachineWidget

A widget with a state machine.
Initializes class.
Parameters

* window_title (str)-

* parent (OMainWindow) —
_required_ julia_version = 1.1.0
py_call program check_needed
spine_opt_process_failed
py_call_installation_needed
py_call_reconfiguration_needed
py_call process_failed
spine_opt_ready

resolve_julia (self)
Returns Julia executable and project according to user’s Settings.

resolve_python (self)
Returns the full path to Python interpreter according to user’s Settings.

check_kernel_is_ok (self, kernel_name, prgm)
Checks that kernel spec is valid for the configuration assistant to continue.

Parameters
¢ kernel_name (str)— Kernel name
e prgm (str) — Either “Python” or “Julia”, determines which kernel type to check

Returns True if kernel is ok, False otherwise
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Return type bool
find_julia_version (self)
_make_processing_state (self, name, text)
_make_report_state (self, name, text)
_make_prompt_state (self, name, text)
_make_report_julia_not_found (self)
_make_report_bad_julia_ version (self)
_make_welcome (self)
_make_updating_spine_opt (self)
_make_prompt_to_install_latest_spine_opt (self)
_make_installing_ latest_spine_opt (self)
_make_report_spine_opt_installation_failed (self)
_make_checking_py_call_program (self)
_make_prompt_to_reconfigure_py_ call (self)
_make_prompt_to_install_py_ call (self)
_make_report_spine_opt_ready (self)
_make_reconfiguring py_call (self)
_make_installing_py_ call (self)
_make_report_py_call_process_failed (self)
update_spine_opt (self)
install_spine_opt (self)
_handle_spine_opt_process_finished (self, ret)
check_py call_program (self)
_handle_check_py call_program_finished (self, ret)

reconfigure_py call (self)
Starts process that reconfigures PyCall to use selected Python interpreter.

_handle_reconfigure_py call_finished (self, ret)

install_py_call (self)
Starts process that installs PyCall in current julia version.

_handle_install_py_call_finished (self, ret)

set_up_machine (self)

Package Contents

Classes
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make_assistant A widget with a state machine.

class spinetoolbox.configuration_assistants.spine_opt.make_assistant (foolbox)
Bases: spinetoolbox.widgets.state _machine_widget.StateMachineWidget

A widget with a state machine.
Initializes class.
Parameters

e window_title (str)-—

* parent (OMainWindow)—
_required_julia_version = 1.1.0
py_call_program_check_needed
spine_opt_process_failed
py_call_installation_ needed
py_call_reconfiguration_needed
py_call_process_failed
spine_opt_ready

resolve_julia (self)

Returns Julia executable and project according to user’s Settings.

resolve_python (self)

Returns the full path to Python interpreter according to user’s Settings.

check_kernel_is_ok (self, kernel_name, prgm)

Checks that kernel spec is valid for the configuration assistant to continue.

Parameters

* kernel_name (str)— Kernel name

* prgm (str) — Either “Python” or “Julia”, determines which kernel type to check

Returns True if kernel is ok, False otherwise

Return type bool
find_julia_version (self)
_make_processing_state (self, name, text)
_make_report_state (self, name, text)
_make_prompt_state (self, name, text)
_make_report_julia_ not_found (self)
_make_report_bad_julia_version (self)
_make_welcome (self)
_make_updating_spine_opt (self)
_make_prompt_to_install_ latest_spine_opt (self)

_make_installing latest_spine_opt (self)
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_make_report_spine_opt_installation_failed (self)
_make_checking py_call_program (self)
_make_prompt_to_reconfigure_py_ call (self)
_make_prompt_to_install_py_call (self)
_make_report_spine_opt_ready (self)
_make_reconfiguring py_call (self)
_make_installing py call (self)
_make_report_py_call_process_failed (self)
update_spine_opt (self)

install_spine_opt (self)
_handle_spine_opt_process_finished (self, ret)
check_py call_program (self)

_handle_check_py call_program_f£finished (self, ret)

reconfigure_py_call (self)
Starts process that reconfigures PyCall to use selected Python interpreter.

_handle_reconfigure_py call_finished (self, ret)

install_py_call (self)
Starts process that installs PyCall in current julia version.

_handle_install_py_ call_finished (self, ret)
set_up_machine (self)

spinetoolbox.configuration_assistants.spine_opt.assistant_name = SpineOpt. jl

spinetoolbox.import_editor

This subpackage contains GUI files for the Import editor.
authors
A. Soininen (VTT)
date 13.5.2020

Subpackages
spinetoolbox.import_editor.mvcmodels

Contains Import editor’s MVC models.
author
A. Soininen (VTT)
date 5.8.2020
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Submodules

spinetoolbox.import_editor.mvcmodels.mapping list_model

Contains the mapping list model.
author
P. Vennstrom (VTT)
date 1.6.2019

Module Contents

Classes

MappingListModel A model to hold a list of Mappings.

class spinetoolbox.import_editor.mvcmodels.mapping_list_model.MappingListModel (mapping_specifi
ta-
ble_name,

undo_stack)
Bases: PySide2.QtCore.QAbstractListModel

A model to hold a list of Mappings.
Parameters

* mapping_specifications (list of MappingSpecificationModel) -
mapping specifications

* table_name (str) - source table name
¢ undo_stack (QUndoStack) — undo stack
mapping_specifications

flags (self, index)
Returns flags for given index.

get_mappings (self)
mapping_specification (self, name)
mapping name_at (self, row)
rowCount (self, index=None)
row_for_mapping (self, name)
data_mapping (self, index)

data (self, index, role=Qt.DisplayRole)

setData (self, index, value, role=Qt.EditRole)
Renames a mapping.

rename_mapping (self, row, name)
Renames a mapping.

Parameters
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* row (int)— mapping’s row

* name (str)—new name
add_mapping (self)
insert_mapping specification (self, name, row, specification)
remove_mapping (self, row)

check_mapping_validity (self)
Checks if there are any issues with the mappings.

Returns a map from mapping name to discovered issue; contains only mappings that have issues
Return type dict

reset (self, item_mappings, table_name)
Resets the model.

Parameters
* item mappings (dict) —item mappings

e table_name (str)—name of the source table

spinetoolbox.import_editor.mvcmodels.mapping specification_model

Contains the mapping specification model.
author
P. Vennstrom (VTT)
date 1.6.2019

Module Contents

Classes
MappingSpecificationModel A model to hold a Mapping specification.
Functions
_name_ 1ndex(name) Parses an index from a string which ends with that num-

ber.

spinetoolbox.import_editor.mvcmodels.mapping_specification_model._ MAP_TYPE_DISPLAY NAME
spinetoolbox.import_editor.mvcmodels.mapping_specification_model._ DISPLAY TYPE_TO_TYPE

spinetoolbox.import_editor.mvcmodels.mapping_specification_model._ TYPE_TO_DISPLAY TYPE
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class spinetoolbox.import_editor.mvcmodels.mapping_specification_model .MappingSpecificatio:

Bases: PySide2.QtCore.QAbstractTableModel
A model to hold a Mapping specification.
Parameters
e table_name (str)— source table name
* mapping_name (str)— mapping name
* mapping (spinedb_api.ItemMappingBase) — the item mapping to model
e undo_stack (QUndoStack) — undo stack

mapping_read_start_row_changed
Emitted after mapping’s read start row has been changed.

row_or_column_type_ recommendation_changed
Emitted when a change in mapping prompts for change in column or row type.

multi_column_type_ recommendation_changed
Emitted when all but given columns should be of given type.

about_to_undo
Emitted before an undo/redo action.

mapping

mapping_name
source_table_ name
skip_columns

map_type

last_pivot_row

dimension

import_objects
parameter_type

is_pivoted

read_start_row
set_read_start_row (self, row)
set_import_objects (self, flag)
set_mapping (self, mapping)
set_dimension (self, dim)

change_item_ _mapping_type (self, new_type)
Change item mapping’s type.

Parameters new_type (str)—name of the type
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change_parameter_type (self, new_type)
Change parameter type

set_parameter_mapping (self, mapping)
Changes the parameter mapping.

Parameters mapping (ParameterDefinitionMapping)—new mapping
update_display_table (self)
get_map_type_display (self, mapping, name)
get_map_value_display (self, mapping, name)
data (self, index, role=Qt.DisplayRole)
static data_color (display_name)

_mapping_issues (self, row)
Returns a message string if given row contains issues, or an empty string if everything is OK.

rowCount (self, index=None)

columnCount (self, index=None)

headerData (self, section, orientation, role=Qt.DisplayRole)
flags (self, index)

setData (self, index, value, role=Qt.DisplayRole)

change_component_mapping (self, component_name, type_name, reference)
Pushes SetComponentMappingType to the undo stack.

Parameters
* component_name (str)—name of the component whose type to change
* type_ name (str)—name of the new type
* reference (str or int)-component mapping reference

set_type (self, name, value)
Changes the type of a component mapping.

Parameters
* name (str) - component name
* value (str)— mapping type name

set_value (self, name, value)
Sets the reference for given mapping.

Parameters
* name (str)—name of the mapping
e value (str)—anew value
Returns True if the reference was modified successfully, False otherwise.
Return type bool
_get_component_mapping_from_ name (self, name)
_set_component_mapping_ from name (self, name, mapping)

_row_for_ component_name (self, name)
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_recommend_string_type (self, mapping)
_recommend_float_type (self, mapping)
_recommend_datetime_type (self, mapping)

_recommend_mapping_reference_type_change (self, mapping, convert_spec)

_recommend_parameter_value_mapping_reference_type_change (self, mapping)

set_skip_columns (self, columns=None)

set_time_series_repeat (self, repeat)
Toggles the repeat flag in the parameter’s options.

set_map_dimensions (self, dimensions)

set_map_compress_flag (self, compress)
Sets the compress flag for Map type parameters.

Parameters compress (bool) - flag value

mapping_has_parameters (self)
Returns True if the item mapping has parameters.

model_parameters (self)
Returns the mapping’s parameters.

to_dict (self)
Serializes the mapping specification into a dict.

Returns serialized specification
Return type dict

static from_dict (specification_dict, table_name, undo_stack)
Restores a serialized mapping specification.

Parameters
* specification_dict (dict) - serialized specification model
e table_name (str) - source table name
¢ undo_stack (QUndoStack) — undo stack

Returns mapping specification

Return type MappingSpecificationModel

spinetoolbox.import_editor.mvcmodels.mapping_specification_model
Parses an index from a string which ends with that number.

Parameters name (str) — a string that ends with a number
Returns the number at the end of the given string minus one

Return type int

spinetoolbox.import_editor.mvcmodels.source_data_ table_model

Contains the source data table model.
author

P. Vennstrom (VTT)

._name_index (name)
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date 1.6.2019

Module Contents

Classes

SourceDataTableModel A model for import mapping specification.

class spinetoolbox.import_editor.mvcmodels.source_data_table_model.SourceDataTableModel (par
Bases: spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel

A model for import mapping specification.
Highlights columns, rows, and so on, depending on Mapping specification.
Table model for outlining simple tabular data.

Parameters parent (QObject) — the parent object
column_types_updated
row_types_updated
mapping_changed

about_to_undo
Emitted when an undo/redo command is going to be executed.

mapping_specification (self)

clear (self)
Clear all data in model.

reset_model (self, main_data=None)
Reset model.

set_mapping (self, mapping)
Set mapping to display colors from

Parameters mapping (MappingSpecificationModel)— mapping model
validate (self, section, orientation=Qt.Horizontal)
get_type (self, section, orientation=Qt.Horizontal)
get_types (self, orientation=Qt.Horizontal)
set_type (self, section, section_type, orientation=Qt.Horizontal)
set_types (self, sections, section_type, orientation)
set_all_column_types (self, excluded_columns, column_type)
_mapping_data_changed (self)
update_colors (self)
data_error (self, index, role=Qt.DisplayRole, orientation=Qt.Horizontal)

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
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¢ index (OModelIndex) — Index of item
e role (int)— Datarole
Returns Item data for given role.

data_color (self, index)
Returns background color for index depending on mapping.

Parameters index (PySide2.QtCore.QModel Index) — index
Returns color of index
Return type QColor

index_in_mapping (self, mapping, index)
Checks if index is in mapping

Parameters
* mapping (MappingBase)— mapping
¢ index (OModelIndex) —index
Returns True if mapping is in index
Return type bool

mapping_column_ref int_list (self)
Returns a list of column indexes that are not pivoted

Returns [List[int]] — list of ints

spinetoolbox.import_editor.mvcmodels.source_table_ list_model

Contains SourceTableListModel and associated list item classes
author
A. Soininen (VTT)
date 6.8.2019

Module Contents

Classes
SourceTableItem A listitem for _SourceTableListModel
SourceTableListModel Model for source table lists which supports undo/redo

functionality.

class spinetoolbox.import_editor.mvcmodels.source_table_list_model.SourceTableItem (name,

o checked)
A list item for _SourceTablelListModel

Initialize self. See help(type(self)) for accurate signature.

class spinetoolbox.import_editor.mvcmodels.source_table_list_model.SourceTableListModel (una
Bases: PySide2.QtCore.QAbstractListModel

Model for source table lists which supports undo/redo functionality.
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Parameters undo_stack (QUndoStack) — undo stack
checked_table_names (self)
data (self, index, role=Qt.DisplayRole)
flags (self, index)
headerData (self, section, orientation, role=Qt.DisplayRole)
reset (self, items)
rowCount (self, parent=QModellndex())
setData (self, index, value, role=Qt.EditRole)

set_checked (self, row, checked)
Sets the checked status of a list item.

Parameters
e row (int) — item row
¢ checked (boo1l) - True for checked, False for unchecked

set_multiple_checked undoable (self, rows, checked)
Sets the checked status of multiple list items.

This action is undoable.
Parameters
e rows (Iterable of int)-—item rows
¢ checked (bool) - True for checked, False for unchecked
table_at (self, row)
table_index (self, table)

table_names (self)

spinetoolbox.import_editor.ui

Automatically generated Ul modules for Import editor.
authors
A. Soininen (VTT)
date 13.5.2020

Submodules

spinetoolbox.import_editor.ui.import_editor_window

Module Contents

Classes

17.1. spinetoolbox
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Ui_MainWindow

class spinetoolbox.import_editor.ui.import_editor_window.Ui_MainWindow

Bases: object

setupUi (self, MainWindow)

retranslateUi (self, MainWindow)

spinetoolbox.import_editor.widgets

Interface logic for Import editor.
authors
A. Soininen (VTT)
date 13.5.2020

Submodules

spinetoolbox.import_editor.widgets.import_editor

Contains ImportEditor widget and MappingTableMenu.

author
P. Vennstrom (VTT)
date 1.6.2019

Module Contents

Classes
ImportEditor Provides an interface for defining one or more Mappings
associated to a data Source (CSV file, Excel file, etc).
MappingTableMenu A context menu for the source data table, to let users
define a Mapping from a data table.
TableMenu Menu for tables in data source
Functions

_sanitize_ data(data, header)

Fills empty data cells with None.
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class spinetoolbox.import_editor.widgets.import_editor.ImportEditor (ui,
ui_error,
undo_stack,
connec-
tor,
map-
ping_settings)

Bases: PySide2.QtCore.Q0bject

Provides an interface for defining one or more Mappings associated to a data Source (CSV file, Excel file, etc).
Parameters
* ui (QWidget) — importer window’s Ul
* ui_error (QErrorMessage) — error dialog
e undo_stack (QUndoStack) — undo stack
* connector (ConnectionManager)— a connector
* mapping_settings (dict) — serialized mappings
table_checked
mapped_data_ready
source_table_ selected
preview_data_ updated
checked_tables
set_model (self, model)
set_mapping (self, model)

set_loading_status (self, status)
Disables/hides widgets while status is True

request_new_tables_from_connector (self)
Requests new tables data from connector

_change_selected_table (self, selected, deselected)
Sets selected table and requests data from connector

_select_table_row (self, row)

select_table (self, table)
Selects given table in the source table list.

Parameters table (str)— source table name
request_mapped_data (self)

update_tables (self, tables)
Updates list of tables

update_preview_data (self, data, header)
_restore_mappings (self, settings)

import_mappings (self, mappings_dict)
Restores mappings from a dict.

Parameters mappings_dict (dict) — serialized mappings
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get_settings_dict (self)
Returns a dictionary with type of connector, connector options for tables, mappings for tables, selected
tables.

Returns dict with settings
Return type dict

close_connection (self)
Close connector connection.

_new_column_types (self)
_new_row_types (self)
_update_display_ row_types (self)

show_source_table_ context_menu (self, pos)
Shows context menu for source tables.

Parameters pos (OPoint)— Mouse position

_copy_mappings (self, table)
Copies the mappings of the given source table.

Parameters table (str) - source table name
Returns copied mappings
Return type dict

_options_to_dict (self, table)
Serializes mapping options to a dict.

Parameters table (st r) - source table name
Returns serialized options
Return type dict

paste_mappings (self, table, mappings)
Pastes mappings to given table

Parameters
* table (str) - source table name
* mappings (dict)— mappings to paste

paste_options (self, table, options)
Pastes all mapping options to given table.

Parameters
e table (str) - source table name
* options (dict) - options

class spinetoolbox.import_editor.widgets.import_editor.MappingTableMenu (parent=None)
Bases: PySide2.QtWidgets.QMenu

A context menu for the source data table, to let users define a Mapping from a data table.
Parameters parent (QWidget) — parent widget

set_model (self, model)
Sets target mapping specification.
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Parameters model (MappingSpecificationModel)— mapping specification
set_mapping (self, name=", map_type=None, value=None)
request_menu (self, pos=None)

class spinetoolbox.import_editor.widgets.import_editor.TableMenu (parent,
position,
can_paste_option,
can_paste_mapping)
Bases: spinetoolbox.widgets.custom menus.CustomContextMenu

Menu for tables in data source
Parameters
* parent (QWidget) — Parent for menu widget (ToolboxUI)
e position (QPoint) — Position on screen

spinetoolbox.import_editor.widgets.import_editor._sanitize_data (data, header)
Fills empty data cells with None.

spinetoolbox.import_editor.widgets.import_editor window

Contains ImportPreviewWindow class.
authors
P. Savolainen (VTT), A. Soininen (VTT), P. Vennstrom (VTT)
date 10.6.2019

Module Contents

Classes

ImportEditorWindow A QMainWindow to let users define Mappings for an
Importer item.

class spinetoolbox.import_editor.widgets.import_editor_window.ImportEditorWindow (importer,
filepath,
con-
nec-
tor,
con-
nec-
tor_settings,
map-
ping_settings,
tool-

box)
Bases: PySide2.QtWidgets.QMainWindow

A QMainWindow to let users define Mappings for an Importer item.

Parameters
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* importer (spinetoolbox.project_items.importer.importer.
Importer) — Project item that owns this preview window

* filepath (str) - Importee path
* connector (SourceConnection)— Asynchronous data reader
* mapping_settings (dict) — Default mapping specification
¢ toolbox (OMainWindow) — ToolboxUI class
settings_updated
connection_failed
_insert_undo_redo_actions (self)
show_error (self, message)

restore_dock_widgets (self)
Docks all floating and or hidden QDockWidgets back to the window.

begin_style_change (self)
Begins a style change operation.

end_style_change (self)
Ends a style change operation.

apply_classic_ui_style (self)
Applies the classic Ul style.

import_mapping from file (self)
Imports mapping spec from a user selected .json file to the preview window.

export_mapping_to_file (self)
Exports all mapping specs in current preview window to .json file.

apply_and_close (self)
Apply changes to mappings and close preview window.

start_ui (self)

restore_ui (self)
Restore Ul state from previous session.

closeEvent (self, event=None)
Handles close window.

Parameters event (QEvent) — Closing event if ‘X’ is clicked.

spinetoolbox.import_editor.widgets.import_mapping_options

ImportMappingOptions widget.
author
P. Vennstrom (VTT)
date 12.5.2020
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Module Contents

Classes
ImportMappingOptions Provides methods for managing Mapping options (class
type, dimensions, parameter type, ignore columns, and
SO on).

class spinetoolbox.import_editor.widgets.import_mapping_options.ImportMappingOptions (ui,

undo_st
Bases: PySide2.QtCore.Q0bject

Provides methods for managing Mapping options (class type, dimensions, parameter type, ignore columns, and
SO on).

Parameters
* ui (OWidget) — importer window’s Ul
* undo_stack (QUndoStack) — undo stack
about_to_undo
set_num _available_columns (self, num)
change_skip_columns (self, skip_cols)
set_mapping_specification_model (self, model)

update_ui (self)
updates ui to RelationshipClassMapping, ObjectClassMapping or ObjectGroupMapping model

_change_item_mapping_type (self, new_type)
Pushes a SetltemMappingType command to the undo stack

Parameters new_type (str)—item’s new type

set_item_mapping_type (self, source_table_name, mapping_specification_name, new_type)
Sets the type for an item mapping.

Parameters
* source_table_name (str)— name of the source table
* mapping_specification_name (str) - name of the mapping specification
* new_type (str)—name of the type

set_item_mapping (self, source_table_name, mapping_specification_name, mapping)
Sets item mapping.

Parameters
e source_table_name (str)— name of the source table
* mapping_specification_name (str) - name of the mapping specification
* mapping (ItemMappingBase) — item mapping

_change_dimension (self, dimension)
Pushes a SetltemMappingDimension command to the undo stack.

Parameters dimension (int)— mapping’s dimension
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set_dimension (self, source_table_name, mapping_specification_name, dimension)
Changes the item mapping’s dimension and emits about_to_undo.

Parameters
¢ source_table_ name (str)— name of the source table
* mapping_specification_name (str) - name of the mapping specification
e dimension (int) - new dimension value

_change_parameter_type (self, type_name)
Pushes a SetParameterType command to undo stack.

Parameters type_name (str)— new parameter type’s name

set_parameter_type (self, source_table_name, mapping_specification_name, type_name)
Sets parameter type for an item mapping.

Parameters
e source_table_name (str)— name of the source table
* mapping_specification_name (str)—name of the mapping specification
* type name (src)—new parameter type’s name

set_parameter_mapping (self, source_table_name, mapping_specification_name, parame-
ter_mapping)
Sets parameter mapping for an item mapping.

Parameters
e source_table_ name (str)— name of the source table
* mapping_specification_name (str) - name of the mapping specification
* parameter_mapping (ParameterDefinitionMapping)—new parameter

_change_import_objects (self, state)
Pushes SetImportObjectsFlag command to the undo stack.

Parameters state (bool)—new flag value

set_import_objects_flag (self, source_table_name,  mapping_specification_name,  im-
port_objects)
Sets the import objects flag.

Parameters
e source_table_ name (str) - name of the source table
* mapping_specification_name (str) - name of the mapping specification
e import_objects (bool) - flag value

_change_read_start_row (self, row)
Pushes SetReadStartRow to the undo stack.

Parameters row (int)— new read start row

set_read_start_row (self, source_table_name, mapping_specification_name, start_row)
Sets item’s parameter’s read start row.

Parameters
e source_table_ name (str)— name of the source table

* mapping_specification_name (str)—name of the mapping specification
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e start_row (int)— new read start row value

_change_time_series_repeat_f£flag (self, repeat)
Pushes SetTimeSeriesRepeatFlag to the undo stack.

Parameters repeat (bool)— True is repeat is enable, False otherwise

set_time_series_repeat_flag (self, source_table_name, mapping_specification_name, repeat)

Sets the time series repeat flag to given value.
Parameters
e source_table_ name (str)— name of the source table
* mapping_specification_name (str) - name of the mapping specification
* repeat (bool)— new repeat flag value

_change_map_dimensions (self, dimensions)
Pushes SetMapDimensions to the undo stack.

Parameters dimensions (int)—new map dimensions

set_map_dimensions (self, source_table_name, mapping_specification_name, dimensions)
Sets map dimensions.

Parameters
¢ source_table_name (str)— name of the source table
* mapping_ specification_name (str) - name of the mapping specification
* dimensions (int)— new map dimensions

_change_map_compression_f£1lag (self, compress)
Pushes SetMapCompressFlag to the undo stack.

Parameters compress (CheckState) —if Qt . Checked, Maps will be compressed

set_map_compress (self, source_table_name, mapping_specification_name, compress)
Sets map compress flag.

Parameters
¢ source_table_ name (str) - name of the source table
* mapping_specification_name (str) - name of the mapping specification
* compress (bool)—new flag value

_update_time_series_options (self)
Updates widgets that concern time series type parameters

_update_map_options (self)
Updates widgets that concern map type parameters.

spinetoolbox.import_editor.widgets.import_ mappings

ImportMappings widget.
author
P. Vennstrom (VTT)
date 1.6.2019
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Module Contents

Classes

ImportMappings Provides methods for managing Mappings (add, re-

move, edit, visualize, and so on).

spinetoolbox.import_editor.widgets.import_mappings.MAPPING_CHOICES =

class spinetoolbox.import_editor.widgets.import_mappings.ImportMappings (ui,

undo_stack)

Bases: PySide2.QtCore.Q0Object
Provides methods for managing Mappings (add, remove, edit, visualize, and so on).
Parameters
* ui (OWidget) — importer window’s Ul
e undo_stack (QUndoStack) — undo stack

mapping_selection_changed
Emitted when a new mapping specification is selected from the Mappings list.

mapping_data_changed
Emits the new MappingListModel.

about_to_undo
Emitted before an undo/redo action.

set_mappings_model (self, source_table_name, model)
Sets new mappings.

Parameters
e source_table_name (str) - source table’s name
* model (MappingListModel)— mapping list model

focus_on_changing_specification (self, source_table_name, mapping_name)
Selects the given mapping from the list and emits about_to_undo.

Parameters
¢ source_table_ name (str)— name of the source table
* mapping_name (str)—name of the mapping specification

data_changed (self)
Emits the mappingDataChanged signal with the currently selected data mappings.

new_mapping (self)
Pushes a CreateMapping command to the undo stack

create_mapping (self)
insert_mapping specification (self, source_table_name, name, row, mapping_specification)

delete_selected_mapping (self)
Pushes a DeleteMapping command to the undo stack.

delete_mapping (self, source_table_name, name)

_select_row (self, row)
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change_mapping (self, selected, deselected)

spinetoolbox.import_editor.widgets.multi_checkable list_view

Contains MultiCheckablelListView.
author
A. Soininen (VTT)
date 13.8.2020

Module Contents

Classes

MultiCheckableListView

A list view which allows all selected items to be
checked/unchecked with space bar.

class spinetoolbox.import_editor.widgets.multi_checkable_list_view.MultiCheckableListView

Bases: PySide2.QtWidgets.QListView

A list view which allows all selected items to be checked/unchecked with space bar.

keyPressEvent (self, event)
Handles key press events.

spinetoolbox.import_editor.widgets.options_widget

Contains OptionsWidget class.
author
P. Vennstrom (VTT)
date 1.6.2019

Module Contents

Classes
OptionsWidget A widget for handling simple options.
Functions
_emit_spin_box_option_changed(, op- A ‘slot’ to transform changes in QSpinBox into changes

tion_key, options_widget)

in options.

_emit_line edit_option_changed(text, op-
tion_key, options_widget)

A ‘slot’ to transform changes in QLineEdit into changes
in options.

Continued on next page
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Table 16 — continued from previous page
_emit_check_box_option_changed(state, op- A ‘slot’ to transform changes in QCheckBox into

tion_key, options_widget) changes in options.
_emit_combo_box_option_changed(text, op- A ‘slot’ to transform changes in QComboBox into
tion_key, options_widget) changes in options.

class spinetoolbox.import_editor.widgets.options_widget .OptionsWidget (connector,

undo_stack)
Bases: PySide2.QtWidgets.QWidget

A widget for handling simple options.
Parameters

* connector (ConnectionManager) — the connection manager whose current table’s
options are show on the widget

e undo_stack (QUndoStack) — undo stack

options_changed
Emitted whenever an option in the widget is changed.

about_to_undo
Emitted before undo action.

connector
The connection manager linked to this options widget.

undo_stack
undo_enabled
current_source_table

_build_ui (self)
Builds ui from specification in dict

_set_options (self, source_table, options=None)
Sets state of options

Parameters
* source_table (str)—name of the source table

* options (dict, optional) - Dict with option name as key and value as value (de-
fault: {None})

set_option_without_undo (self, source_table, option_key, value)

_fetch_options_from connector (self)
Read options from the connector.

spinetoolbox.import_editor.widgets.options_widget._emit_spin_box_option_changed (i,

op-

tion_key,

op-
tions_widget)

A ‘slot’ to transform changes in QSpinBox into changes in options.
Parameters
* text (str) - text for undo/redo

* option_key (str) - option’s key
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* options_widget (OptionsWidget)— options widget

spinetoolbox.import_editor.widgets.options_widget._emit_line_edit_option_changed (fext,
op-
tion_key,
op-
tions_widget)
A ‘slot’ to transform changes in QLineEdit into changes in options.
Parameters

e text (str) - text for undo/redo

* option_key (str)— option’s key

* options_widget (OptionsWidget) — options widget

spinetoolbox.import_editor.widgets.options_widget._emit_check_box_option_changed (stafte,
op-
tion_key,
op-
tions_widget)
A ‘slot’ to transform changes in QCheckBox into changes in options.
Parameters

e text (str) - text for undo/redo

* option_key (str)—option’s key

* options_widget (OptionsWidget)— options widget

spinetoolbox.import_editor.widgets.options_widget._emit_combo_box option_changed (rext,
op-
tion_key,
op-
tions_widget)
A ‘slot’ to transform changes in QComboBox into changes in options.
Parameters
* text (str) - text for undo/redo
* option_key (str) - option’s key

* options_widget (OptionsWidget)— options widget

spinetoolbox.import_editor.widgets.table_view_with button_header

Classes for handling models in PySide2’s model/view framework.
author
P. Vennstrom (VTT)
date 11.5.2020

Module Contents
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Classes

TableViewWithButtonHeader

Customized table with data type buttons on horizontal
and vertical headers

HeaderWithButton

Class that reimplements the QHeaderView section paint
event to draw a button

Functions

_create_allowed_types_menu(parent,
ger_slot)

trig- Returns a menu which contains actions for each allowed
data type.

spinetoolbox.import_editor.widgets.
spinetoolbox.import_editor.widgets.

spinetoolbox.import_editor.widgets.

table_view_with_button_header. ALLOWED TYPES
table_view_with_button_header. TYPE_ TO_FONT AWESOME_ICOIl

table_view_with button_header.Margin

class spinetoolbox.import_editor.widgets.table_view_with_button_header.TableViewWithButtonl
Bases: PySide2.QtWidgets.QTableView

Customized table with data type buttons on horizontal and vertical headers

Parameters parent (QOWidget) — a parent widget

scrollContentsBy (self, dx, dy)

Scrolls the table’s contents by given delta.

update_buttons (self, orientation)

Updates the header buttons for given orientation.

Parameters orientation (int)— Qt.Horizontal or Qt.Vertical

_create_horizontal_ header menu (

self’)

Returns a new menu for the horizontal header

_create_vertical_header_menu (self)
Returns a new menu for the vertical header.

_show_horizontal_header_menu (self, pos)
Opens the context menu of the horizontal header.

_show_vertical_header_menu (self, pos)
Opens the context menu of the vertical header.

_set_all_column_data_types (self, action)
Sets all columns data types to the type given by action’s text.

_set_all row_data_ types (self, action)
Sets all rows data types to the type given by action’s text.

set_undo_stack (self, undo_stack, about_to_undo_slot)

Sets undo stack for the table.

Parameters

¢ undo_stack (QUndoStack) — undo stack

* about_to_undo_slot (object) —aslot that takes the source table name as its argu-

ment
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class spinetoolbox.import_editor.widgets.table_view_with_button_header.HeaderWithButton (orie
par
ent:

Bases: PySide2.QtWidgets.QHeaderView

Class that reimplements the QHeaderView section paint event to draw a button that is used to display and change
the type of that column or row.

about_to_undo
Emitted when an undo/redo command is going to be executed.

display all
sections_with_ buttons

_menu_pressed (self, action)
Sets the data type of a row or column according to menu action.

change_data_types (self, sections, type_str)
Pushes SetColumnOrRowType to the undo stack.

Parameters
* sections (Iterable or int or NoneType)-row/column index
* type_str (str) - data type name

set_data_types (self, source_table_name, sections, convert_specification)
Sets the data type for given sections.

Parameters
e source_table_ name (str)— name of the source table
e sections (Iterable) — section indexes
* convert_specification (ConvertSpec)— data conversion specification

update_buttons (self)
Updates the buttons.

widget_width (self)
Width of widget

Returns Width of widget
Return type int

widget_height (self)
Height of widget

Returns Height of widget
Return type int

_hide_or_show_button (self, logical_index)
Hides or shows the button depending on the logical index.

Parameters logical_index (int)—

mouseMoveEvent (self, mouse_event)
Moves the button to the correct section so that interacting with the button works.

enterEvent (self, event)
Shows the button.
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leaveEvent (self, event)
Hides button.

_set_button_geometry (self, button, index)
Sets a buttons geometry depending on the index.

Parameters
* button (QWidget)— QWidget that geometry should be set
* index (int) - logical_index to set position and geometry to.

_section_resize (self, i)
When a section is resized.

Parameters i (int)— logical index to section being resized

paintSection (self, painter, rect, logical_index)
Paints a section of the QHeader view.

Works by drawing a pixmap of the button to the left of the original paint rectangle. Then shifts the original
rect to the right so these two doesn’t paint over each other.

sectionSizeFromContents (self, logical_index)
Add the button width to the section so it displays right.

Parameters logical_index (int) - logical index of section
Returns Size of section
Return type QSize

_section_move (self, logical, old_visual_index, new_visual_index)
Section being moved.

Parameters
* logical (int) - logical index of section beeing moved.
e old_visual_index (int) - old visual index of section
* new_visual_index (int)— new visual index of section

fix_widget_positions (self)
Update position of interaction button

set_margins (self, margins)
Sets the header margins.

setModel (self, model)
Sets the model for this view.

Parameters model (QOAbstractItemModel)—a model

set_undo_stack (self, undo_stack)
Sets undo stack for the header making menu actions to work.

Parameters undo_stack (QUndoStack) — undo stack

set_source_table (self, table_name)
Sets the current source table.

Parameters table_name (str) — source table name
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spinetoolbox.import_editor.widgets.table_view_with_button_header._create_allowed_types_men

Returns a menu which contains actions for each allowed data type.

Parameters

* parent (QWidget) — a parent widget

* trigger_slot (Slot) - aslot which is connected to QMenu’s ‘triggered’ signal

Returns a menu

Return type QMenu

Submodules

spinetoolbox.import_editor.commands

Contains undo and redo commands for Import editor.

author
A. Soininen (VTT)
date 4.8.2020

Module Contents

Classes
_Id Enum where members are also (and must be) ints
PasteMappings Command to paste copied mappings
PasteOptions Command to paste copied mapping options.
SetTableChecked Command to change a source table’s checked state.
RenameMapping A command to change the name of a mapping.

SetComponentMappingType

Sets the type of a component mapping.

SetComponentMappingReference

Sets the reference for a component mapping.

SetConnectorOption

Command to set a ConnectorManager option.

CreateMapping Creates a new mapping.

DeleteMapping Command to delete a mapping.

SetItemMappingType Command to change item mapping’s type.

SetImportObjectsFlag Command to set item mapping’s import objects flag.

SetParameterType Command to change the parameter type of an item map-
ping.

SetReadStartRow Command to change item mapping’s read start row op-

tion.

SetItemMappingDimension

Command to change item mapping’s dimension option.

SetTimeSeriesRepeatFlag

Command to change the repeat flag for time series.

SetMapDimensions

Command to change the dimensions of a Map parameter
value type.

SetMapCompressFlag

Command to change the Map compress flag.

SetColumnOrRowType

Command to change the type of columns or rows.

Continued on next page
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Table 19 — continued from previous page
RestoreMappingsFromDict Restores mappings from a dict.

class spinetoolbox.import_editor.commands._Id
Bases: enum. IntEnum

Enum where members are also (and must be) ints
Initialize self. See help(type(self)) for accurate signature.
SET_OPTION

class spinetoolbox.import_editor.commands.PasteMappings (import_editor,
source_table_name,
copied_mappings, previ-
ous_mappings)
Bases: PySide2.QtWidgets.QUndoCommand
Command to paste copied mappings
Parameters
* import_editor (ImportEditor)— import editor
* source_table_name (src)—name of the target source table
* copied mappings (Iterable)— mappings to paste
* previous_mappings (Iterable)— mappings before pasting

redo (self)
Pastes the copied mappings

undo (self)
Restores mappings to their previous state.

class spinetoolbox.import_editor.commands.PasteOptions (import_editor,
source_table_name,
copied_options, previ-
ous_options)

Bases: PySide2.QtWidgets.QUndoCommand
Command to paste copied mapping options.
Parameters
* import_editor (ImportEditor)— import editor
* source_table_name (src)— name of the target source table
* copied_options (dict) - options from the internal clipboard
* previous_options (dict) — previous options

redo (self)
Pastes the options.

undo (self)
Restores the options to their previous values.

class spinetoolbox.import_editor.commands.SetTableChecked (table_name, ta-
ble_list_model, row,
checked)

Bases: PySide2.QtWidgets.QUndoCommand

Command to change a source table’s checked state.
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Parameters
e table_name (str)— source table name
* table_list_model (SourceTablelListModel) — source table model
e row (int) — table row on the list
¢ checked (bool)—new checked state

redo (self)
Changes the checked state.

undo (self)
Restores the previous checked state.

class spinetoolbox.import_editor.commands.RenameMapping (row, mapping_list_model,

name, previous_name)
Bases: PySide2.QtWidgets.QUndoCommand

A command to change the name of a mapping.
Parameters
* mapping_list_model (MappingListModel)— model holding the mapping names
* name (str)—new name
* previous_name (str) — original name

redo (self’)
Renames the mapping.

undo (self)
Reverts renaming of the mapping.

class spinetoolbox.import_editor.commands.SetComponentMappingType (component_display name,
map-
ping_specification_model,
map-
ping_type,
previ-
ous_type,
previ-

ous_reference)
Bases: PySide2.QtWidgets.QUndoCommand

Sets the type of a component mapping.
Parameters

* component_display_name (str) — component name on the mapping specification
table

* mapping_specification_model (MappingSpecificationModel) — specifi-
cation model

* mapping_type (str)—name of the new type
* previous_type (str)—name of the original type
* previous_reference (str or int)- original mapping’s reference

redo (self)
Changes a component mapping’s type.
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undo (self)
Restores component mapping’s original type.

class spinetoolbox.import_editor.commands.SetComponentMappingReference (component display_name,

map-
ping_specification_model,
ref-
er-
ence,
pre-
Vi-
ous_reference,
pre-
vi-
ous_mapping_type_was_non

Bases: PySide2.QtWidgets.QUndoCommand

Sets the reference for a component mapping.

Parameters

* component_display name (str)— component name on the mapping specification
table

* mapping_ specification_model (MappingSpecificationModel) — specifi-
cation model

* reference (str or int)- new value for the reference
* previous_reference (str or int)- preference’s original value

* previous_mapping_type_was_none (bool) — True if the mapping was originally
a NoneMapping

redo (self)
Sets the reference’s value.

undo (self)
Restores the reference’s value and, if necessary, mapping type to their original values.

class spinetoolbox.import_editor.commands.SetConnectorOption (source_table,
option_key, op-
tions_widget,
value, previ-

ous_value)
Bases: PySide2.QtWidgets.QUndoCommand

Command to set a ConnectorManager option.
Parameters
* source_table (str)— source table name
* option_key (str)— option’s key
* options_widget (OptionsWidget) — connector options widget
* value (str or int or bool)-option’s new value
* previous_value (str or int or bool)—option’s previous value

id (self)
This command’s id.
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Returns id
Return type int

mergeWith (self, command)
Merges command with another Set ConnectorOption.

Parameters command (QUndoCommand) —a command to merge with
Returns True if merge was successful, False otherwise
Return type bool

redo (self)
Changes the connector’s option.

undo (self)
Restores the option back to its original value.

class spinetoolbox.import_editor.commands.CreateMapping (source_table_name, im-
port_mappings, row)
Bases: PySide2.QtWidgets.QUndoCommand

Creates a new mapping.
Parameters
e source_table_ name (src) - source table name
* import_mappings (ImportMappings)— mappings manager
* row (int)—row where the new mapping should be created

redo (self)
Creates a new mapping at the given row in mappings list.

undo (self)
Deletes the created mapping.

class spinetoolbox.import_editor.commands.DeleteMapping (source_table_name,
import_mappings,  map-
ping_name, row)
Bases: PySide2.QtWidgets.QUndoCommand

Command to delete a mapping.
Parameters
* source_table_name (src) — source table name
* import_mappings (ImportMappings)— mappings manager
* mapping_name (str)—name of the mapping to delete
* row (int)— mapping’s row in the mapping list

redo (self')
Deletes the mapping.

undo (self)
Restores the deleted mapping.
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class spinetoolbox.import_editor.commands.SetItemMappingType (source_table_name,
map-
ping_specification_name,
options_widget,
new_type,  previ-

ous_mapping)
Bases: PySide2.QtWidgets.QUndoCommand

Command to change item mapping’s type.
Parameters
e source_table_ name (src) - name of the source table
* mapping_specification_name (str)—name of the mapping
* options_widget (ImportMappingOptions) — options widget
* new_type (str)—name of the new mapping type
* previous_mapping (ItemMappingBase) — the previous mapping

redo (self’)
Sets the mapping type to its new value.

undo (self)
Resets the mapping type to its former value.

class spinetoolbox.import_editor.commands.SetImportObjectsFlag (source_table_name,
map-
ping_specification_name,
options_widget,

import_objects)
Bases: PySide2.QtWidgets.QUndoCommand

Command to set item mapping’s import objects flag.
Parameters
e source_table name (str) - name of the source table
* mapping_specification_name (str)- name of the mapping specification
* options_widget (ImportMappingOptions)— options widget
* import_objects (bool) —new flag value

redo (self’)
Changes the import objects flag.

undo (self)
Restores the import objects flag.

class spinetoolbox.import_editor.commands.SetParameterType (source_table_name,

map-
ping_specification_name,
options_widget,
new_type, previ-
ous_parameter)

Bases: PySide2.QtWidgets.QUndoCommand

Command to change the parameter type of an item mapping.

Parameters
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e source_table_ name (str) - name of the source table

* mapping_specification_name (str)—name of the mapping specification
* options_widget (ImportMappingOptions)— options widget

* new_type (str)—name of the new parameter type

* previous_parameter (ParameterDefinitionMapping) — previous parameter
mapping

redo (self’)
Changes a parameter’s type.

undo (self)
Restores a parameter to its previous type

class spinetoolbox.import_editor.commands.SetReadStartRow (source_table_name,
map-
ping_specification_name,
options_widget,
start_row, previ-

ous_start_row)
Bases: PySide2.QtWidgets.QUndoCommand

Command to change item mapping’s read start row option.
Parameters
e source_table_ name (str) - name of the source table
* mapping_specification_name (str)— name of the mapping specification
* options_widget (ImportMappingOptions)— options widget
* start_row (int)— new read start row
* previous_start_row (int) — previous read start row value

redo (self)
Changes item mapping’s read start row to a new value.

undo (self)
Restores item mapping’s read start row to its previous value.

class spinetoolbox.import_editor.commands.SetItemMappingDimension (source_table_name,
map-
ping_specification_name,
op-
tions_widget,
dimension,
previ-
ous_dimension)
Bases: PySide2.QtWidgets.QUndoCommand
Command to change item mapping’s dimension option.
Parameters
* source_table_name (str)—name of the source table
* mapping_specification_name (str)— name of the mapping specification
* options_widget (ImportMappingOptions)— options widget

* dimension (int)— new dimension
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* previous_dimension (int) — previous dimension

redo (self)
Changes the item mapping’s dimension to the new value.

undo (self)
Changes the item mapping’s dimension to its previous value.

class spinetoolbox.import_editor.commands.SetTimeSeriesRepeatFlag (source_table_name,
map-
ping_specification_name,
op-
tions_widget,

repeat)
Bases: PySide2.QtWidgets.QUndoCommand

Command to change the repeat flag for time series.
Parameters
e source_table name (str) - name of the source table
* mapping_specification_name (str)—name of the mapping specification
* options_widget (ImportMappingOptions)— options widget
* repeat (bool)—new repeat flag value

redo (self’)
Sets the repeat flag to given value.

undo (self)
Restores the repeat flag to its previous value.

class spinetoolbox.import_editor.commands.SetMapDimensions (source_table_name,
map-
ping_specification_name,
options_widget, di-
mensions, previ-

ous_dimensions)
Bases: PySide2.QtWidgets.QUndoCommand

Command to change the dimensions of a Map parameter value type.
Parameters
* source_table_name (str)—name of the source table
* mapping_specification_name (str)—name of the mapping specification
* options_widget (ImportMappingOptions)— options widget
* dimensions (int)— new dimensions
* previous_dimensions (int) — previous dimensions

redo (self)
Sets the Map dimensions to the new value.

undo (self)
Restores the previous Map dimensions value.
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class spinetoolbox.import_editor.commands.SetMapCompressFlag (source_table_name,
map-
ping_specification_name,
options_widget,
compress)
Bases: PySide2.QtWidgets.QUndoCommand

Command to change the Map compress flag.
Parameters
e source_table_name (str)— name of the source table
* mapping_specification_name (str) - name of the mapping specification
* options_widget (ImportMappingOptions)— options widget
* compress (bool) - compress flag value

redo (self)
Sets the compress flag.

undo (self)
Resets the compress flag to previous value.

class spinetoolbox.import_editor.commands.SetColumnOrRowType (source_table_name,
header_widget,
sections, new_type,

previous_type)
Bases: PySide2.QtWidgets.QUndoCommand

Command to change the type of columns or rows.
Parameters
* source_table_name (src)— name of the source table
* header_widget (HeaderWithButton)— widget of origin
e sections (Iterable of int)-row or column indexes
* new_type (ConvertSpec) — conversion specification for the rows/columns

* previous_type (ConvertSpec) — previous conversion specification for the
rows/columns

redo (self)
Sets column/row type.

undo (self)
Restores column/row type to its previous value.

class spinetoolbox.import_editor.commands.RestoreMappingsFromDict (import_editor,
map-
ping_dict)
Bases: PySide2.QtWidgets.QUndoCommand

Restores mappings from a dict.
Parameters
* import_editor (ImportEditor)— import editor

* mapping_dict (dict)— mappings to
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redo (self)
Restores the mappings.

undo (self)
Reverts back to previous mappings.

spinetoolbox.import_editor.mapping_colors

Contains colors used in Import editor’s tables.
author
P. Vennstrom (VTT)
date 1.6.2019

Module Contents

spinetoolbox.import_editor.mapping_colors.MAPPING_ COLORS

spinetoolbox.import_editor.mapping_colors.ERROR_COLOR

spinetoolbox.mvcmodels

Modules in this package contain classes that represent Spine Toolbox’s models (internal data structures) in the Model-
View-Controller design pattern. The model classes define an interface that is used by views and delegates to access

data in the application.
author
P. Savolainen (VTT)
date 24.9.2019

Submodules

spinetoolbox.mvcmodels.array model

Contains logic for the fixed step time series editor widget.

author
A. Soininen (VTT)
date 14.6.2019

Module Contents

Classes
ArrayModel Model for the Array parameter_value type.
_ErrorCell A sentinel class to mark erroneous cells in the table.
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class spinetoolbox.mvcmodels.array_model.ArrayModel
Bases: PySide2.QtCore.QAbstractTableModel

Model for the Array parameter_value type.

Even if the array is empty this model’s rowCount() will still return 1. This is to show an empty row in the table
view.

array (self)
Returns the array modeled by this model.

batch_set_data (self, indexes, values)
Sets data at multiple indexes at once.

columnCount (self, parent=QModellndex())
Returns 1.

data (self, index, role=Qt.DisplayRole)
Returns model’s data for given role.

flags (self, index)
Returns table cell’s flags.

headerData (self, section, orientation, role=Qt.DisplayRole)
Returns header data.

insertRows (self, row, count, parent=QModellndex())
Inserts rows to the array.

removeRows (self, row, count, parent=QModellndex())
Removes rows from the array.

reset (self, value)
Resets the model to a new array.

Parameters value (Array) — anew array to model

rowCount (self, parent=QModellndex())
Returns the length of the array.

Note: returns 1 even if the array is empty.

set_array_type (self, new_type)
Changes the data type of array’s elements.

setData (self, index, value, role=Qt.EditRole)
Sets the value at given index.

_set_data (self, index, value)
Sets data for given index.

In case of errors the value at index is replaced by an _ErrorCell sentinel.
Parameters
¢ index (OModelIndex) — an index
¢ value (str) - value in database format

class spinetoolbox.mvcmodels.array_model._ErrorCell (edit_value, tooltip)
A sentinel class to mark erroneous cells in the table.

Parameters

* edit_value (str) - the JSON string that caused the error
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* tooltip (str)—tooltip that should be shown on the table cell

spinetoolbox.mvcmodels.compound table_model

Models that vertically concatenate two or more table models.
authors
M. Marin (KTH)
date 9.10.2019

Module Contents

Classes
CompoundTableModel A model that concatenates several sub table models ver-
tically.
CompoundWithEmptyTableModel A compound parameter table model where the last

model is an empty row model.

class spinetoolbox.mvcmodels.compound_table_model.CompoundTableModel (parent=None,

header=None)
Bases: spinetoolbox.mvcmodels.minimal_ table _model.MinimalTableModel

A model that concatenates several sub table models vertically.
Initializes model.

Parameters parent (Q0Object) — the parent object
refreshed

map_to_sub (self, index)
Returns an equivalent submodel index.

Parameters index (OModelIndex)—the compound model index.
Returns the equivalent index in one of the submodels
Return type QModellndex

map_from_sub (self, sub_model, sub_index)
Returns an equivalent compound model index.

Parameters
* sub_model (MinimalTableModel) — the submodel
¢ sub_index (OModelIndex) — the submodel index.
Returns the equivalent index in the compound model
Return type QModellndex

item_at_row (self, row)
Returns the item at given row.

Parameters row (int)—

Returns object
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sub_model_at_row (self, row)
Returns the submodel corresponding to the given row in the compound model.

Parameters row (int)—
Returns MinimalTableModel

refresh (self)
Refreshes the layout by computing a new row map.

do_refresh (self)
Recomputes the row and inverse row maps.

_append_row_map (self, row_map)
Appends given row map to the tail of the model.

Parameters row_map (11ist) — tuples (model, row number)

static _row_map_for_ model (model)
Returns row map for given model. The base class implementation just returns all model rows.

Parameters model (MinimalTableModel) -
Returns tuples (model, row number)
Return type list

canFetchMore (self, parent=QModellndex())
Returns True if any of the submodels that haven’t been fetched yet can fetch more.

fetchMore (self, parent=0QModellndex())
Fetches the next sub model and increments the fetched counter.

flags (self, index)
Return index flags.

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (OModelIndex) — Index of item
e role (int)— Datarole

Returns Item data for given role.

rowCount (self, parent=QModellndex())
Returns the sum of rows in all models.

batch_set_data (self, indexes, data)
Sets data for indexes in batch. Distributes indexes and values among the different submodels and calls
batch_set_data on each of them.

insertRows (self, row, count, parent=QModellndex())
Inserts count rows after the given row under the given parent. Localizes the appropriate submodel and
calls insertRows on it.

removeRows (self, row, count, parent=QModellndex())
Removes count rows starting with the given row under parent. Localizes the appropriate submodels and
calls removeRows on it.

class spinetoolbox.mvcmodels.compound_table_model.CompoundWithEmptyTableModel (parent=None,

header=None)
Bases: spinetoolbox.mvcmodels. compound_table _model.CompoundTableModel
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A compound parameter table model where the last model is an empty row model.
Initializes model.
Parameters parent (Q0bject) — the parent object
single_models
empty model

_create_single_models (self)
Returns a list of single models.

_create_empty model (self)
Returns an empty model.

init_model (self)
Initializes the compound model. Basically populates the sub_models list attribute with the result of _cre-
ate_single_models and _create_empty_model.

connect_model_signals (self)
Connects signals so changes in the submodels are acknowledge by the compound.

_recompute_empty_row_map (self)
Recomputeds the part of the row map corresponding to the empty model.

_handle_empty_ rows_removed (self, parent, empty_first, empty_last)
Runs when rows are removed from the empty model. Updates row_map, then emits rowsRemoved so the
removed rows are no longer visible.

_handle_empty_ rows_inserted (self, parent, empty_first, empty_last)
Runs when rows are inserted to the empty model. Updates row_map, then emits rowsInserted so the new
rows become visible.

_handle_single_model_reset (self, single_model)
Runs when one of the single models is reset. Updates row_map, then emits rowsInserted so the new rows
become visible.

_insert_single_row_map (self, single_row_map)
Inserts given row map just before the empty model’s.

clear_model (self)
Clears the model.

spinetoolbox.mvcmodels.data_package_models

Classes for models dealing with Data Packages.
authors
M. Marin (KTH)
date 24.6.2018

Module Contents

Classes
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DatapackageResourcesModel A model of datapackage resource data, used by Spine-
DatapackageWidget.

DatapackageResourceDataModel A model of datapackage field data, used by SpineData-
packageWidget.

DatapackageFieldsModel A model of datapackage field data, used by SpineData-
packageWidget.

DatapackageForeignKeysModel A table model with a last empty row.

class spinetoolbox.mvcmodels.data_package_models.DatapackageResourcesModel (parent,
dat-
a-
pack-

age)
Bases: spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel

A model of datapackage resource data, used by SpineDatapackageWidget.
Parameters parent (SpineDatapackageWidget)—
refresh_model (self)

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (OModelIndex) — Index of item
e role (int)— Datarole
Returns Item data for given role.
update_resource_dirty (self, idx, dirty)

batch_set_data (self, indexes, data)
Batch set data for indexes.

set_data (self, index, value)
_check_resource_name (self, name)
update_resource_name (self, resource_index, new_name)

flags (self, index)
Return index flags.

class spinetoolbox.mvcmodels.data_package_models.DatapackageResourceDataModel (parent,

dat-
a_
pack-
age)

Bases: spinetoolbox.mvcmodels.minimal_table _model.MinimalTableModel

A model of datapackage field data, used by SpineDatapackageWidget.

Parameters parent (SpineDatapackageWidget)—
refresh_model (self, resource_index)

headerData (self, section, orientation=Qt.Horizontal, role=Qt.DisplayRole)
Returns headers.
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batch_set_data (self, indexes, data)
Batch set data for indexes.

update_resource_data (self, resource_index, rows, columns, new_values)

class spinetoolbox.mvcmodels.data_package_models.DatapackageFieldsModel (parent,

dat-
a_
pack-
age)

Bases: spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel

A model of datapackage field data, used by SpineDatapackageWidget.

Parameters parent (SpineDatapackageWidget)—

refresh_model (self, resource_index)

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (QModelIndex) — Index of item
e role (int) - Data role

Returns Item data for given role.

flags (self, index)
Return index flags.

batch_set_data (self, indexes, data)
Batch set data for indexes.

_valid_field_names (self, new_names)
update_field names (self, resource_index, field_indexes, old_names, new_names)
update_primary_keys (self, resource_index, field_indexes, statuses)

class spinetoolbox.mvcmodels.data_package_models.DatapackageForeignKeysModel (parent,
dat-
a-
pack-

age)
Bases: spinetoolbox.mvcmodels.empty_ row_model.EmptyRowModel

A table model with a last empty row.

A model of datapackage foreign key data, used by SpineDatapackageWidget.
Parameters parent (SpineDatapackageWidget)—

foreign_keys

refresh_model (self, resource_index)

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (OModelIndex) — Index of item

e role (int) - Datarole
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Returns Item data for given role.
_true_data (self, index)
_check_foreign_key (self, foreign_key)

batch_set_data (self, indexes, data)
Batch set data for indexes.

set_data (self, index, value)

_append_foreign_key (self, fk_index)
_update_foreign_key (self, fk_index)

append_foreign_key (self, resource_index, foreign_key)
update_foreign_key (self, resource_index, fk_index, foreign_key)
call_remove_foreign_key (self, fk_index)
remove_foreign_key (self, resource_index, fk_index)
insert_foreign_key (self, resource_index, fk_index, foreign_key)

emit_data_changed (self, roles=None)
Emits dataChanged for the entire model.

spinetoolbox.mvcmodels.empty row_model

Contains a table model with an empty last row.
authors
M. Marin (KTH)
date 20.5.2018

Module Contents

Classes

EmptyRowModel A table model with a last empty row.

class spinetoolbox.mvcmodels.empty_row_model.EmptyRowModel (parent=None,

header=None)
Bases: spinetoolbox.mvcmodels.minimal_ table _model.MinimalTableModel

A table model with a last empty row.
Init class.

canFetchMore (self, parent=0QModellndex())
Return True if the model hasn’t been fetched.

fetchMore (self, parent=0QModellndex())
Fetch data and use it to reset the model.

flags (self, index)
Return default flags except if forcing defaults.
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set_default_row (self, **kwargs)
Set default row data.

clear (self)
Clear all data in model.

reset_model (self, main_data=None)
Reset model.

_handle_data_changed (self, top_left, bottom_right, roles=None)
Insert a new last empty row in case the previous one has been filled with any data other than the defaults.

removeRows (self, row, count, parent=QModellndex())
Don’t remove the last empty row.

_handle_rows_inserted (self, parent, first, last)
Handle rowslInserted signal.

set_rows_to_default (self, first, last=None)
Set default data in newly inserted rows.

spinetoolbox.mvcmodels.filter checkbox_ list_model

Provides FilterCheckboxListModel for FilterWidget.
author
P. Vennstrom (VTT)
date 1.11.2018

Module Contents

Classes
SimpleFilterCheckboxListModel Init class.
LazyFilterCheckboxListModel Extends SimpleFilterCheckboxListModel to allow for
lazy loading in synch with another model.
DataToValueFilterCheckboxListModel Extends SimpleFilterCheckboxListModel to allow for

translating internal data to a value for display role.

class spinetoolbox.mvcmodels.filter_ checkbox_list_model.SimpleFilterCheckboxListModel (parent

show_
Bases: PySide2.QtCore.QAbstractListModel

Init class.

Parameters parent (QOWidget) —
_show_empty
_show_add_to_selection
reset_selection (self)
_handle_select_all_clicked (self)
_check_all_selected (self)
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rowCount (self, parent=QModellndex())

data (self, index, role=Qt.DisplayRole)
_handle_index_clicked (self, index)
set_1list (self, data, all_selected=True)
set_selected (self, selected, select_empty=None)
get_selected (self)

get_not_selected (self)

set_filter (self, filter_expression)

set_base_filter (self, condition)
Sets the base filter. The other filter, the one that works by typing in the search bar, should be applied on
top of this base filter.

Parameters condition (function) - Filter acceptance condition.
apply_filter (self)
_remove_and_add_filtered (self)
_remove_and_replace_filtered (self)
remove_filter (self)
_do_add_items (self, data)
add_items (self, data, selected=None)
remove_items (self, data)

class spinetoolbox.mvcmodels.filter_ checkbox_list_model.LazyFilterCheckboxListModel (parent,
source_m

show_em,
Bases: spinetoolbox.mvcmodels.filter. _checkbox_1list_model.

SimpleFilterCheckboxListModel
Extends SimpleFilterCheckboxListModel to allow for lazy loading in synch with another model.
Init class.
Parameters
* parent (SpineDBEditor) -
* source_model (CompoundParameterModel)—a model to lazily get data from
canFetchMore (self, parent=0QModellndex())
fetchMore (self, parent=0Modellndex())

_do_add_items (self, data)
Adds items so the list is always sorted, while assuming that both existing and new items are sorted.

class spinetoolbox.mvcmodels.filter checkbox_list_model.DataToValueFilterCheckboxListModel

Bases: spinetoolbox.mvcmodels.filter. checkbox list_model.
SimpleFilterCheckboxListModel

Extends SimpleFilterCheckboxListModel to allow for translating internal data to a value for display role.

Init class.

17.1. spinetoolbox 159



Spine Toolbox Documentation, Release 0.5.0-beta.0

Parameters
* parent (SpineDBEditor)—
* data_ to_value (method) —a method to translate item data to a value for display role

data (self, index, role=Qt.DisplayRole)

spinetoolbox.mvcmodels. indexed value_table_model

A model for indexed parameter values, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 18.6.2019

Module Contents

Classes

IndexedValueTableModel A base class for time pattern and time series models.

class spinetoolbox.mvcmodels.indexed_value_table_model.IndexedValueTableModel (value,
in-
dex_header,

value_header)
Bases: PySide2.QtCore.QAbstractTableModel

A base class for time pattern and time series models.
Parameters

* value (TimePattern, TimeSeriesFixedStep,
TimeSeriesVariableStep) — a parameter_value

¢ index_header (str)— a header for the index column
¢ value_header (str)— a header for the value column

value
Returns the parameter_value associated with the model.

columnCount (self, parent=QModellndex())
Returns the number of columns which is two.

data (self, index, role=Qt.DisplayRole)
Returns the data at index for given role.

headerData (self, section, orientation=Qt.Horizontal, role=Qt.DisplayRole)
Returns a header.

reset (self, value)
Resets the model.

rowCount (self, parent=QModellndex())
Returns the number of rows.
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spinetoolbox.mvcmodels .map_model

A model for maps, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 11.2.2020

Module Contents

Classes
MapMode 1l A model for Map type parameter values.

Functions
_as_rows(map_value, row_this_far=None) Converts given Map into list of rows recursively.
_make_square(rows) Makes a list of rows a 2D table by appending None to

the row ends.

_rows_to_dict(rows) Turns table into nested dictionaries.
_reconstruct_map(tree) Constructs a Map from a nested dictionary.

class spinetoolbox.mvcmodels.map_model .MapModel (map_value)
Bases: PySide2.QtCore.QAbstractTableModel

A model for Map type parameter values.

This model represents the Map as a 2D table. Each row consists of one or more index columns and a value
column. The last columns of a row are padded with None.

Example

Map {
"A": 1.0
"B": Map {"a": -1.0}
"C": 3.0

}

The table corresponding to the above map:

“A” | 1.0 | None
64B7’ 6‘a37 _1.0
“C” | 3.0 | None

Parameters map_value (Map) — a map

append_column (self)
Appends a new column to the right.
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columnCount (self, index=QModellndex())
Returns the number of columns in this model.

convert_leaf_maps (self)

data (self, index, role=Qt.DisplayRole)
Returns the data associated with the given role.

flags (self, index)
Returns flags at index.

headerData (self, section, orientation, role=Qt.DisplayRole)
Returns row numbers for vertical headers and column titles for horizontal ones.

insertRows (self, row, count, parent=QModellndex())
Inserts new rows into the map.

Parameters

¢ row (int) — an index where to insert the new data

¢ count (int)— number of rows to insert

* parent (OModelIndex)— an index to a parent model
Returns True if the operation was successful

reset (self, map_value)
Resets the model to given map_value.

rowCount (self, parent=QModellndex())
Returns the number of rows.

removeRows (self, row, count, parent=QModellndex())
Removes rows from the map.

Parameters

e row (int) - an index where to remove the data

e count (int)— number of rows pairs to remove

* parent (QModelIndex)— an index to a parent model
Returns True if the operation was successful

setData (self, index, value, role=Qt.EditRole)
Sets data in the map.

Parameters
* index (OModelIndex) — an index to the model
* value (str)— JSON representation of the value
e role (int)-arole

Returns True if the operation was successful

trim_columns (self)
Removes empty columns from the right.

value (self)
Returns the Map.

spinetoolbox.mvcmodels.map_model._as_rows (map_value, row_this_far=None)
Converts given Map into list of rows recursively.
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spinetoolbox.mvcmodels.map_model._make_square (rows)
Makes a list of rows a 2D table by appending None to the row ends.

spinetoolbox.mvcmodels.map_model._rows_to_dict (rows)
Turns table into nested dictionaries.

Parameters rows (11ist) - a list of row data
Returns a nested dictionary
Return type dict

spinetoolbox.mvcmodels.map_model._reconstruct_map (free)
Constructs a Map from a nested dictionary.

Parameters tree (dict) — anested dictionary
Returns reconstructed Map

Return type Map

spinetoolbox.mvcmodels .minimal_table_model

Contains a minimal table model.
authors
M. Marin (KTH)
date 20.5.2018

Module Contents

Classes

MinimalTableModel Table model for outlining simple tabular data.

class spinetoolbox.mvcmodels.minimal_table_model.MinimalTableModel (parent=None,
header=None,

lazy=True)
Bases: PySide2.QtCore.QAbstractTableModel

Table model for outlining simple tabular data.
Parameters parent (Q0Object) — the parent object

clear (self)
Clear all data in model.

flags (self, index)
Return index flags.

canFetchMore (self, parent=None)
Return True if the model hasn’t been fetched.

fetchMore (self, parent=None)
Fetch data and use it to reset the model.

rowCount (self, parent=QModellndex())
Number of rows in the model.
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columnCount (self, parent=QModellndex())
Number of columns in the model.

headerData (self, section, orientation=0Qt.Horizontal, role=Qt.DisplayRole)
Returns headers.

set_horizontal_header labels (self, labels)
Set horizontal header labels.

insert_horizontal_header_labels (self, section, labels)
Insert horizontal header labels at the given section.

horizontal_header_labels (self)

setHeaderData (self, section, orientation, value, role=Qt.EditRole)
Sets the data for the given role and section in the header with the specified orientation to the value supplied.

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
¢ index (OModel Index) — Index of item
* role (int) - Datarole

Returns Item data for given role.

row_data (self, row, role=Qt.DisplayRole)
Returns the data stored under the given role for the given row.

Parameters

* row (int)— Item row

e role (int) - Datarole
Returns Row data for given role.

setData (self, index, value, role=Qt.EditRole)
Set data in model.

batch_set_data (self, indexes, data)
Batch set data for indexes.

insertRows (self, row, count, parent=QModellndex())
Inserts count rows into the model before the given row. Items in the new row will be children of the item
represented by the parent model index.

Parameters
* row (int)— Row number where new rows are inserted
¢ count (int) - Number of inserted rows
e parent (QOModelIndex) — Parent index
Returns True if rows were inserted successfully, False otherwise

insertColumns (self, column, count, parent=QModellndex())
Inserts count columns into the model before the given column. Items in the new column will be children
of the item represented by the parent model index.

Parameters

¢ column (int)— Column number where new columns are inserted
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¢ count (int) - Number of inserted columns
* parent (QOModelIndex) — Parent index
Returns True if columns were inserted successfully, False otherwise

removeRows (self, row, count, parent=QModellndex())
Removes count rows starting with the given row under parent.

Parameters
* row (int)— Row number where to start removing rows
¢ count (int) - Number of removed rows
e parent (QOModelIndex) — Parent index
Returns True if rows were removed successfully, False otherwise

removeColumns (self, column, count, parent=QModellndex())
Removes count columns starting with the given column under parent.

Parameters
* column (int)— Column number where to start removing columns
¢ count (int) - Number of removed columns
e parent (OModel Index) — Parent index

Returns True if columns were removed successfully, False otherwise

reset_model (self, main_data=None)
Reset model.

spinetoolbox.mvcmodels.minimal_ tree_model

Models to represent items in a tree.
authors
P. Vennstrém (VTT), M. Marin (KTH)
date 11.3.2019

Module Contents

Classes
Treeltem A tree item that can fetch its children.
Minimal TreeModel Base class for all tree models.

class spinetoolbox.mvcmodels.minimal_tree_model.TreeItem (model=None)
A tree item that can fetch its children.

Initializes item.
Parameters model (MinimalTreeModel, NoneType)—The model where the item belongs.

model
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child_item_ type

Returns the type of child items. Reimplement in subclasses to return something more meaningful.

children
parent_item
display_ data
edit_data

child (self, row)
Returns the child at given row or None if out of bounds.

last_child (self)
Returns the last child.

child_count (self)
Returns the number of children.

child_number (self)
Returns the rank of this item within its parent or -1 if it’s an orphan.

find_children (self, cond=lambda child: True)
Returns children that meet condition expressed as a lambda function.

find_child (self, cond=lambda child: True)
Returns first child that meet condition expressed as a lambda function or None.

next_sibling (self)
Returns the next sibling or None if it’s the last.

previous_sibling (self)
Returns the previous sibling or None if it’s the first.

index (self)

insert_children (self, position, *children)
Insert new children at given position. Returns a boolean depending on how it went.

Parameters
e position (int) - insert new items here
e children (iter) - insert items from this iterable

append_children (self, *children)
Append children at the end.

remove_children (self, position, count)
Removes count children starting from the given position.

clear_ children (self)
Clear children list.

flags (self, column)
Enables the item and makes it selectable.

data (self, column, role=Qt.DisplayRole)
Returns data for given column and role.

has_children (self)
Returns whether or not this item has or could have children.

can_fetch_more (self)
Returns whether or not this item can fetch more.
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fetch_more (self)
Fetches more children.

set_data (self, column, value, role)
Sets data for this item.

Parameters

e column (int)— column index

* value (object) — anew value

e role (int) —role of the new value
Returns True if data was set successfully, False otherwise
Return type bool

class spinetoolbox.mvcmodels.minimal_tree_model .MinimalTreeModel (parent=None)
Bases: PySide2.QtCore.QAbstractItemModel

Base class for all tree models.
Init class.
Parameters parent (SpineDBEditor)—

visit_all (self, index=0QModellndex())
Iterates all items in the model including and below the given index. Iterative implementation so we don’t
need to worry about Python recursion limits.

item_from_index (self, index)
Return the item corresponding to the given index.

index_from_item (self, item)
Return a model index corresponding to the given item.

index (self, row, column, parent=QModellndex())
Returns the index of the item in the model specified by the given row, column and parent index.

parent (self, index)
Returns the parent of the model item with the given index.

columnCount (self, parent=QModellndex())
rowCount (self, parent=QModellndex())

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the index.

setData (self, index, value, role=Qt.EditRole)
Sets data for given index and role. Returns True if successful; otherwise returns False.

flags (self, index)
Returns the item flags for the given index.

hasChildren (self, parent)
canFetchMore (self, parent)

fetchMore (self, parent)
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spinetoolbox.mvcmodels.project_item factory models

Contains a class for storing Tool specifications.
authors
P. Savolainen (VTT)
date 23.1.2018

Module Contents

Classes
ProjectItemFactoryModel A model for listing project items in the Item Palette
view.
ProjectItemSpecFactoryModel Class to store specs that are available in a project e.g.

GAMS or Julia models.

FilteredSpecFactoryModel

class spinetoolbox.mvcmodels.project_item_ factory_models.ProjectItemFactoryModel
Bases: PySide2.QtGui.QStandardItemModel

A model for listing project items in the Item Palette view.

add_item (self, item_type, factory)
Add item to model.

Parameters
* item type (str)-
e factory (ProjectItemFactory)—
flags (self, index)
static is_index_draggable (index)
get_mime_data_text (self, index)

class spinetoolbox.mvcmodels.project_item_factory_models.ProjectItemSpecFactoryModel (icons)
Bases: PySide2.QtCore.QAbstractListModel

Class to store specs that are available in a project e.g. GAMS or Julia models.

rowCount (self, parent=None)
Returns the number of specs in the model.

Parameters parent (QModelIndex)— Not used (because this is a list)
Returns Number of rows (available specs) in the model

data (self, index, role=None)
Must be reimplemented when subclassing.

Parameters
* index (OModelIndex) — Requested index

* role (int) - Datarole
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Returns Data according to requested role

flags (self, index)
Returns enabled flags for the given index.

Parameters index (OModelIndex) - Index of spec

insertRow (self, spec, row=None, parent=QModellndex())
Insert row (specification) into model.

Parameters
* spec (ProjectItemSpecification)— specadded to the model
* row (str)— Row to insert spec to
* parent (QOModelIndex) — Parent of child (not used)

Returns Void

removeRow (self, row, parent=QModellndex())
Remove row (spec) from model.

Parameters

e row (int)— Row to remove the spec from

* parent (OModelIndex)— Parent of spec on row (not used)
Returns Boolean variable

update_specification (self, row, spec)
Updates specification.

Parameters
* row (int) — Position of the spec to be updated
* spec (ProjectItemSpecification)—new spec, to replace the old one
Returns Boolean value depending on the result of the operation
undo_update_specification (self, row)

specification (self, row)
Returns spec specification on given row.

Parameters row (int)— Row of spec specification
Returns ProjectltemSpecification from specification list or None if given row is zero

specifications (self)
Yields all specs.

find_specification (self, name)
Returns specification with the given name.

Parameters name (str)— Name of specification to find

specification_row (self, name)
Returns the row on which the given specification is located or -1 if it is not found.

specification_index (self, name)
Returns the QModellndex on which a specification with the given name is located or invalid index if it is
not found.

static is_index_draggable (index)
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get_mime_data_text (self, index)

class spinetoolbox.mvcmodels.project_item_factory_models.FilteredSpecFactoryModel (item_type)
Bases: PySide2.QtCore.QSortFilterProxyModel

filterAcceptsRow (self, source_row, source_parent)

spinetoolbox.mvcmodels.project_item model

Contains a class for storing project items.
authors
P. Savolainen (VTT)
date 23.1.2018

Module Contents

Classes

ProjectItemModel Class to store project tree items and ultimately project
items in a tree structure.

class spinetoolbox.mvcmodels.project_item model.ProjectItemModel (foolbox,

root)
Bases: PySide2.QtCore.QAbstractItemModel

Class to store project tree items and ultimately project items in a tree structure.
Parameters
* toolbox (ToolboxUT) - QMainWindow instance
* root (RootProjectTreeltem)— Rootitem for the project item tree

root (self)
Returns the root item.

rowCount (self, parent=QModellndex())
Reimplemented rowCount method.

Parameters parent (OModelIndex)— Index of parent item whose children are counted.
Returns Number of children of given parent
Return type int

columnCount (self, parent=QModellndex())
Returns model column count which is always 1.

flags (self, index)
Returns flags for the item at given index

Parameters index (OModelIndex) — Flags of item at this index.

parent (self, index=QModellndex())
Returns index of the parent of given index.

Parameters index (OModelIndex)— Index of item whose parent is returned
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Returns Index of parent item
Return type QModellndex

index (self, row, column, parent=0QModellndex())
Returns index of item with given row, column, and parent.

Parameters

e row (int) — Item row

e column (int)— Item column

e parent (OModel Index) — Parent item index
Returns Item index
Return type QModellndex

data (self, index, role=None)
Returns data in the given index according to requested role.

Parameters
* index (OModelIndex) - Index to query
e role (int) - Role to return

Returns Data depending on role.

Return type object

item (self, index)
Returns item at given index.

Parameters index (QModelIndex) - Index of item
Returns
Item at given index or root project item if index is not valid
Return type RootProjectTreeltem, CategoryProjectTreeltem or LeafProjectTreeltem

find_category (self, category_name)
Returns the index of the given category name.

Parameters category_name (str)— Name of category item to find
Returns index of a category item or None if it was not found
Return type QModellndex

find_item (self, name)
Returns the QModellndex of the leaf item with the given name

Parameters name (st r)— The searched project item (long) name
Returns Index of a project item with the given name or None if not found
Return type QModellndex

get_item (self, name)
Returns leaf item with given name or None if it doesn’t exist.

Parameters name (str)— Project item name

Returns LeafProjectTreeltem, NoneType
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category_of_item (self, name)
Returns the category item of the category that contains project item with given name

Parameters name (str)— Project item name
Returns category item or None if the category was not found

insert_item (self, item, parent=0QModellndex())
Adds a new item to model. Fails if given parent is not a category item nor a leaf item. New item is inserted
as the last item of its branch.

Parameters

e item (CategoryProjectTreeltem or LeafProjectTreeltem) — Project
item to add to model

* parent (OModelIndex)— Parent project item
Returns True if successful, False otherwise
Return type bool

remove_item (self, item, parent=0QModellndex())
Removes item from model.

Parameters

* item (BaseProjectTreeItem)— Projectitem to remove

* parent (QModelIndex) — Parent of item that is to be removed
Returns True if item removed successfully, False if item removing failed
Return type bool

setData (self, index, value, role=Qt.EditRole)
Changes the name of the leaf item at given index to given value.

Parameters

¢ index (OModelIndex) — Tree item index

* value (str)— New project item name

e role (int) - Item data role to set
Returns True or False depending on whether the new name is acceptable and renaming succeeds
Return type bool

items (self, category_name=None)
Returns a list of leaf items in model according to category name. If no category name given, returns all
leaf items in a list.

Parameters category_name (str) — Item category. Data Connections, Data Stores, Im-
porters, Exporters, Tools or Views permitted.

Returns obj:’list’ of :obj:’LeafProjectTreeltem’: Depending on category_name argument, re-
turns all items or only items according to category. An empty list is returned if there are no
items in the given category or if an unknown category name was given.

n_items (self)
Returns the number of all items in the model excluding category items and root.

Returns Number of items

Return type int
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item_names (self)
Returns all leaf item names in a list.

Returns ‘list’ of obj:’str’: Item names
Return type obj

items_per_category (self)
Returns a dict mapping category indexes to a list of items in that category.

Returns dict(QModellndex,list(LeafProjectTreeltem))

short_name_reserved (self, short_name)
Checks if the directory name derived from the name of the given item is in use.

Parameters short_name (str) — Item short name
Returns True if short name is taken, False if it is available.

Return type bool

spinetoolbox.mvcmodels. shared

Contains stuff that is used by more than one model
author
M. Marin (KTH)
date 23.3.2020

Module Contents

spinetoolbox.mvcmodels.shared.PARSED_ROLE

spinetoolbox.mvcmodels.time_pattern_model

A model for time patterns, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 4.7.2019

Module Contents

Classes

TimePatternModel A model for time pattern type parameter values.

class spinetoolbox.mvcmodels.time_pattern_model.TimePatternModel (value)
Bases: spinetoolbox.mvcmodels.indexed value table model.
IndexedValueTableModel

A model for time pattern type parameter values.
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Parameters value (TimePattern)— atime pattern value

flags (self, index)
Returns flags at index.

insertRows (self, row, count, parent=QModellndex())
Inserts new time period - value pairs into the pattern.

New time periods are initialized to empty strings and the corresponding values to zeros.
Parameters
¢ row (int) — an index where to insert the new data
* count (int)—number of time period - value pairs to insert
* parent (QModelIndex)— an index to a parent model
Returns True if the operation was successful

removeRows (self, row, count, parent=QModellndex())
Removes time period - value pairs from the pattern.

Parameters
e row (int) - an index where to remove the data
* count (int)—number of time period - value pairs to remove
e parent (QModelIndex)— an index to a parent model
Returns True if the operation was successful

setData (self, index, value, role=Qt.EditRole)
Sets a time period or a value in the pattern.

Column index O corresponds to the time periods while 1 corresponds to the values.
Parameters
¢ index (OModelIndex) — an index to the model
* value (str, float)-anew time period or value
e role (int)-arole
Returns True if the operation was successful

batch_set_data (self, indexes, values)
Sets data for several indexes at once.

Parameters
¢ indexes (Sequence) — a sequence of model indexes

* values (Sequence) — a sequence of time periods/floats corresponding to the indexes

spinetoolbox.mvcmodels.time_series_model_ fixed resolution

A model for fixed resolution time series, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 4.7.2019
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Module Contents

Classes

TimeSeriesModelFixedResolution A model for fixed resolution time series type parameter
values.

class spinetoolbox.mvcmodels.time_series_model_ fixed_resolution.TimeSeriesModelFixedResolut
Bases: spinetoolbox.mvcmodels.indexed_value table_model.
IndexedValueTableModel

A model for fixed resolution time series type parameter values.

series
a time series

Type TimeSeriesFixedResolution
A base class for time pattern and time series models.
Parameters

* value (TimePattern, TimeSeriesFixedStep,
TimeSeriesVariableStep) — a parameter_value

* index_header (str) - a header for the index column
¢ value_header (str)— a header for the value column

indexes
Returns the time stamps as an array.

values
Returns the values of the time series as an array.

data (self, index, role=Qt.DisplayRole)
Returns the time stamp or the corresponding value at given model index.

Column index 0 refers to time stamps while index 1 to values.
Parameters
¢ index (OModelIndex) — an index to the model
e role (int)-arole

flags (self, index)
Returns flags at index.

insertRows (self, row, count, parent=QModellndex())
Inserts new values to the series.

The new values are set to zero. Start time or resolution are left unchanged.
Parameters
e row (int)— anumeric index to the first stamp/value to insert
* count (int)— number of stamps/values to insert
* parent (OModelIndex) — index to a parent model

Returns True if the operation was successful
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removeRows (self, row, count, parent=QModellndex())
Removes values from the series.

Parameters
e row (int)— a numeric index to the series where to begin removing
* count (int)—how many stamps/values to remove
* parent (QModelIndex)— an index to the parent model
Returns True if the operation was successful.

reset (self, value)
Resets the model with new time series data.

setData (self, index, value, role=Qt.EditRole)
Sets a given value in the series.

Column index 1 refers to values. Note it does not make sense to set the time stamps in fixed resolution
series.

Parameters
* index (OModelIndex) — an index to the model
* value (numpy.datetime64, float)-—anew stamp or value
e role (int)—arole

Returns True if the operation was successful

batch_set_data (self, indexes, values)
Sets data for several indexes at once.

Only the values of the series are modified as the time stamps are immutable.
Parameters
* indexes (Sequence) — a sequence of model indexes
* values (Sequence) — a sequence of floats corresponding to the indexes

set_ignore_year (self, ignore_year)
Sets the ignore_year option of the time series.

set_repeat (self, repeat)
Sets the repeat option of the time series.

set_resolution (self, resolution)
Sets the resolution.

set_start (self, start)
Sets the start datetime.

spinetoolbox.mvcmodels.time_series_model_variable_resolution

A model for variable resolution time series, used by the parameter_value editors.
authors
A. Soininen (VTT)
date 5.7.2019
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Module Contents

Classes

TimeSeriesModelVariableResolution A model for variable resolution time series type param-
eter values.

class spinetoolbox.mvcmodels.time_series_model_variable_resolution.TimeSeriesModelVariablel
Bases: spinetoolbox.mvcmodels.indexed_value table_model.
IndexedValueTableModel

A model for variable resolution time series type parameter values.

series
a time series

Type TimeSeriesVariableResolution
A base class for time pattern and time series models.
Parameters

* value (TimePattern, TimeSeriesFixedStep,
TimeSeriesVariableStep) — a parameter_value

* index_header (str) - a header for the index column
¢ value_header (str)— a header for the value column

indexes
Returns the time stamps as an array.

values
Returns the values of the time series as an array.

data (self, index, role=Qt.DisplayRole)
Returns the time stamp or the corresponding value at given model index.

Column index 0 refers to time stamps while index 1 to values.
Parameters
¢ index (OModelIndex) — an index to the model
* role (int)-arole

flags (self, index)
Returns the flags for given model index.

insertRows (self, row, count, parent=QModellndex())
Inserts new time stamps and values to the series.

When inserting in the middle of the series the new time stamps are distributed evenly among the time span
between the two time stamps around the insertion point. When inserting at the beginning or at the end of
the series the duration between the new time stamps is set equal to the first/last duration in the original
series.

The new values are set to zero.
Parameters

e row (int)— anumeric index to the first stamp/value to insert
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* count (int)—number of stamps/values to insert
e parent (QModelIndex)—index to a parent model
Returns True if the insertion was successful

removeRows (self, row, count, parent=QModellndex())
Removes time stamps/values from the series.

Parameters
* row (int)— anumeric index to the series where to begin removing
* count (int)-—how many stamps/values to remove
* parent (QModelIndex) — an index to the parent model
Returns True if the operation was successful.

reset (self, value)
Resets the model with new time series data.

setData (self, index, value, role=Qt.EditRole)
Sets a given time stamp or value in the series.

Column index 0 refers to time stamps while index 1 to values.
Parameters
¢ index (OModelIndex) — an index to the model
* value (numpy.datetimeé64, float)-—anew stamp or value
* role (int)—arole
Returns True if the operation was successful

batch_set_data (self, indexes, values)
Sets data for several indexes at once.

Parameters
* indexes (Sequence) — a sequence of model indexes
* values (Sequence) — a sequence of datetimes/floats corresponding to the indexes

set_ignore_year (self, ignore_year)
Sets the ignore_year option of the time series.

set_repeat (self, repeat)
Sets the repeat option of the time series.

spinetoolbox.project_items

Standard project item plugins.
author A.Soininen (VTT)
date 27.9.2019

178 Chapter 17. API Reference



Spine Toolbox Documentation, Release 0.5.0-beta.0

Subpackages
spinetoolbox.project_items.combiner

Combiner plugin.
author
M. Marin (KTH)
date 12.9.2019

Subpackages
spinetoolbox.project_items.combiner.widgets

Widgets for the Combiner project item.
author
M. Marin (KTH)
date 31.5.2020

Submodules
spinetoolbox.project_items.combiner.widgets.add combiner_ widget

Widget shown to user when a new Combiner is created.
author
P. Savolainen (VTT)
date 19.1.2017

Module Contents

Classes

AddCombinerWidget A widget to query user’s preferences for a new item.

class spinetoolbox.project_items.combiner.widgets.add_combiner_ widget.AddCombinerWidget (foo
X,
ys
spe
Bases: spinetoolbox.widgets.add project_item widget.AddProjectItemWidget
A widget to query user’s preferences for a new item.

toolbox
Parent widget

Type ToolboxUI
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X coordinate of new item

Type int

Y coordinate of new item
Type int
Initialize class.

call_add_item (self)
Creates new Item according to user’s selections.

spinetoolbox.project_items.combiner.widgets.combiner properties_widget

Combiner properties widget.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 12.9.2019

Module Contents

Classes

CombinerPropertiesWidget Widget for the Combiner Project Item Properties.

class spinetoolbox.project_items.combiner.widgets.combiner_properties_widget.CombinerPrope:
Bases: PySide2.QtWidgets.QWidget

Widget for the Combiner Project Item Properties.

Parameters toolbox (ToolboxUTI) — The toolbox instance where this widget should be embed-
ded

Init class.

connect_signals (self)
Connect signals to slots.

show_combiner properties_context_menu (self, pos)
Create and show a context-menu in Combiner properties.

Parameters pos (QPoint)— Mouse position

spinetoolbox.project_items.combiner.widgets.custom menus

Classes for custom context menus and pop-up menus.
author
P. Savolainen (VTT)
date 9.1.2018
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Module Contents

Classes

CombinerPropertiesContextMenu Context menu class for the references tree view of the
Combiner project item properties.

class spinetoolbox.project_items.combiner.widgets.custom_menus.CombinerPropertiesContextMe:

Bases: spinetoolbox.widgets.custom menus.CustomContextMenu
Context menu class for the references tree view of the Combiner project item properties.
Parameters
* parent (QWidget) — Parent for menu widget (ToolboxUI)
* position (QPoint)— Position on screen

* index (OModelIndex)— Index of item that requested the context-menu

Submodules
spinetoolbox.project_items.combiner.combiner

Module for view class.
authors
P. Savolainen (VTT), M. Marin (KHT), J. Olauson (KTH)
date 14.07.2018

Module Contents

Classes
Combiner Class for project items that are not category nor root.
class spinetoolbox.project_items.combiner.combiner.Combiner (toolbox, project,

logger, name, de-
scription, x, y, can-

cel_on_error=Fualse)
Bases: spinetoolbox.project_item.ProjectItem

Class for project items that are not category nor root. These items can be executed, refreshed, and so on.

X
horizontal position in the screen
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Type float

vertical position in the screen
Type float
Combiner class.

Parameters
* toolbox (ToolboxUT) — a toolbox instance
* project (SpineToolboxProject) — the project this item belongs to
* logger (LoggerInterface) — alogger instance
* name (str)— Object name
* description (str) — Object description
e x (float) — Initial X coordinate of item icon
* y(float)—Initial Y coordinate of item icon
* cancel_on_error (bool, optional)—if True, changes will be reverted on errors

static item_type ()
See base class.

static item_category ()
See base class.

execution_item (self)
Creates project item’s execution counterpart.

make_signal_handler_dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting.

_handle_cancel_on_error_changed (self, _state)
set_cancel_on_error (self, cancel_on_error)

restore_selections (self)
Restore selections into shared widgets when this project item is selected.

save_selections (self)
Save selections in shared widgets for this project item into instance variables.

open_db_editor (self, checked=False)
Opens selected db in the Spine database editor.

populate_reference_list (self)
Populates reference list.

update_name_label (self)
Update Combiner tab name label. Used only when renaming project items.

handle_execution_successful (self, execution_direction, engine_state)
Notifies Toolbox of successful database import.

_do_handle_dag_changed (self, resources)
Update the list of references that this item is viewing.

_update_references_1list (self, resources_upstream)
Updates the references list with resources upstream.
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Parameters resources_upstream (1ist)— ProjectltemResource instances

_selected_indexes (self)
Returns selected indexes.

_db_url_codenames (self, indexes)
Returns a dict mapping url to provider’s name for given indexes in the reference model.

item_dict (self)
Returns a dictionary corresponding to this item.

notify destination (self, source_item)
See base class.

static default_name_prefix ()
see base class

spinetoolbox.project_items.combiner.combiner_factory

The ViewFactory class.
author
M. Marin (KTH)
date 15.4.2020

Module Contents

Classes

CombinerFactory Class for project item factories.

class spinetoolbox.project_items.combiner.combiner_factory.CombinerFactory (toolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form maker
Returns a QWidget subclass to create and edit specifications.

Returns class
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specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon|()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

spinetoolbox.project_items.combiner.combiner_ icon

Module for view icon class.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 4.4.2018

Module Contents

Classes

CombinerIcon View icon for the Design View.

class spinetoolbox.project_items.combiner.combiner_icon.CombinerIcon (toolbox,
x3 ys

project_item,
icon)
Bases: spinetoolbox.graphics_items.ProjectItemIcon
View icon for the Design View.
Parameters
¢ toolbox (ToolBoxUI)— QMainWindow instance
e x (float) - Icon x coordinate
* y(float)-Icony coordinate
* project_item (ProjectItem)— Item
* icon (str)—icon resource path
_SHAKE_FACTOR = 0.05
_handle_time_line_value_changed (self, value)

_handle_time_line_state_changed (self, new_state)

start_animation (self)
Start the animation that plays when the Combiner associated to this Graphicsltem is running.
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stop_animation (self)
Stop animation

spinetoolbox.project_items.combiner.combiner_ worker

Contains Combiner program.
authors
M. Marin (KTH)
date 12.5.2020

Module Contents

Classes

CombinerWorker
param from_urls list of urls to read data
from

class spinetoolbox.project_items.combiner.combiner_ worker.CombinerWorker (from_urls,
to_urls,
logs_dir,
can-
cel_on_error,
log-
ger)

Bases: PySide2.QtCore.Q0Object

Parameters

e from_urls (I1ist (str))— list of urls to read data from
e to_urls (1ist (str))— list of urls to write data into
* logs_dir (str) - path to the directory where logs should be written
* cancel_on_error (bool)— whether or not to rollback and stop execution if errors
* logger (LoggerInterface)—somewhere to log important messages

finished

_get_db_map (self, url)

do_work (self)
Does the work and emits finished when done.

spinetoolbox.project_items.combiner.executable_item

Contains Combiner’s executable item as well as support utilities.
authors

A. Soininen (VTT)
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date 2.4.2020

Module Contents

Classes

Executableltem The part of a project item that is executed by the Spine
Engine.

class spinetoolbox.project_items.combiner.executable_item.ExecutableItem (name,
logs_dir,
can-
cel_on_error,
log-

ger)
Bases: spinetoolbox.executable item base.ExecutableltemBase, PySide2.QtCore.

QObject
The part of a project item that is executed by the Spine Engine.
Parameters
* name (str) —item’s name
* logs_dir (str) — path to the directory where logs should be stored
* cancel_on_error (bool) —if True, revert changes on error and move on
* logger (LoggerInterface)—alogger

static item_type ()
Returns Combiner’s type identifier string.

classmethod from dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.

stop_execution (self)
Stops execution.

_execute_backward (self, resources)
See base class.

static _urls_from_ resources (resources)

_execute_forward (self, resources)
See base class.

_handle_worker_finished (self)
Runs when Combiner worker has finished.

_destroy_ current_worker (self)
Runs when starting execution and after worker has finished. Destroys current loop, worker and quits
thread, if any.

spinetoolbox.project_items.combiner.item_info

Combiner project item info.
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authors
A. Soininen (VTT)
date 29.4.2020

Module Contents

Classes

ItemInfo

class spinetoolbox.project_items.combiner.item _info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type ()
See base class.

Package Contents

Classes

ItemFactory

Class for project item factories.

ItemInfo

class spinetoolbox.project_items.combiner.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.

Parameters toolbox (ToolboxUT)—

item maker

Returns a Projectltem subclass.

Returns class

icon_maker

Returns a ProjectltemIcon subclass.

Returns class

add form maker

Returns an AddProjectltem subclass.
Returns class

specification_form maker

Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.
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Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.combiner.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

spinetoolbox.project_items.data_connection

Data connection plugin.
author
M. Marin (KTH)
date 12.9.2019

Subpackages
spinetoolbox.project_items.data_connection.widgets

Widgets for the Data Connection project item.
author A.Soininen (VTT)
date 27.9.2019

Submodules
spinetoolbox.project_items.data_connection.widgets.add data_connection_widget

Widget shown to user when a new Data Connection is created.
author
P. Savolainen (VTT)
date 19.1.2017
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Module Contents

Classes

AddDataConnectionWidget A widget to query user’s preferences for a new item.

class spinetoolbox.project_items.data_connection.widgets.add_data_connection_widget .AddDat:

Bases: spinetoolbox.widgets.add _project_item widget.AddProjectItemWidget
A widget to query user’s preferences for a new item.

toolbox
Parent widget

Type ToolboxUI

x
X coordinate of new item
Type int
y
Y coordinate of new item
Type int
spec
The name of a spec
Type str

Initialize class.

call_add_item (self)
Creates new Item according to user’s selections.

spinetoolbox.project_items.data_connection.widgets.custom_menus

Classes for custom context menus and pop-up menus.
author
P. Savolainen (VTT)
date 9.1.2018

Module Contents

Classes

DcRefContextMenu Context menu class for references view in Data Connec-
tion properties.

Continued on next page
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Table 46 — continued from previous page
DcDataContextMenu Context menu class for data view in Data Connection
properties.

class spinetoolbox.project_items.data_connection.widgets.custom_menus.DcRefContextMenu (pare

po-
Si-
tion,
in-
dex)
Bases: spinetoolbox.widgets.custom _menus.CustomContextMenu
Context menu class for references view in Data Connection properties.

parent
Parent for menu widget (ToolboxUI)

Type QWidget

position
Position on screen

Type QPoint

index
Index of item that requested the context-menu

Type QModellndex
Class constructor.

class spinetoolbox.project_items.data_connection.widgets.custom_menus.DcDataContextMenu (par

po-
Si-
tior

dex
Bases: spinetoolbox.widgets.custom menus.CustomContextMenu

Context menu class for data view in Data Connection properties.

parent
Parent for menu widget (ToolboxUT)

Type QWidget

position
Position on screen

Type QPoint

index
Index of item that requested the context-menu

Type QModellndex

Class constructor.

spinetoolbox.project_items.data_connection.widgets.data_connection_properties_widget

Data connection properties widget.
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author
M. Marin (KTH)
date 12.9.2019

Module Contents

Classes

DataConnectionPropertiesWidget Widget for the Data Connection Item Properties.

class spinetoolbox.project_items.data_connection.widgets.data_connection_properties_widget
Bases: PySide2.QtWidgets.QWidget

Widget for the Data Connection Item Properties.

Parameters toolbox (ToolboxUTI) — The toolbox instance where this widget should be embed-
ded

connect_signals (self)
Connect signals to slots.

show_references_context_menu (self, pos)
Create and show a context-menu in data connection properties references view.

Parameters pos (QPoint)— Mouse position

show_data_context_menu (self, pos)
Create and show a context-menu in data connection properties data view.

Parameters pos (QPoint)— Mouse position

Submodules
spinetoolbox.project_items.data connection.commands

Undo/redo commands for the DataConnection project item.
authors
M. Marin (KTH)
date 5.5.2020

Module Contents

Classes
AddDCReferencesCommand Command to add DC references.
RemoveDCReferencesCommand Command to remove DC references.
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class spinetoolbox.project_items.data_connection.commands.AddDCReferencesCommand (dc,

paths)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to add DC references.
Parameters
e dc (DataConnection)—the DC
* paths (set (str)) - set of paths to add
redo (self)
undo (self)

class spinetoolbox.project_items.data_connection.commands.RemoveDCReferencesCommand (dc,

paths)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to remove DC references.
Parameters
¢ de (DataConnection) - the DC
* paths (1ist (str)) - list of paths to remove
redo (self’)

undo (self)

spinetoolbox.project_items.data_connection.data_ connection

Module for data connection class.
author
P. Savolainen (VTT)
date 19.12.2017

Module Contents

Classes

DataConnection Class for project items that are not category nor root.
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class spinetoolbox.project_items.data_connection.data_connection.DataConnection (foolbox,

project,
log-
ger,
name,
de-
scrip-
tion,
X,
Y,
ref-
er-
ences=None)

Bases: spinetoolbox.project_item.ProjectItem

Class for project items that are not category nor root. These items can be executed, refreshed, and so on.

X
horizontal position in the screen

Type float

vertical position in the screen
Type float
Data Connection class.

Parameters
* toolbox (ToolboxUT) - QMainWindow instance
* project (SpineToolboxProject) — the project this item belongs to
* logger (LoggerInterface)— alogger instance
* name (str)— Object name
* description (str)— Object description
* x (float) — Initial X coordinate of item icon
e y(float) - Initial Y coordinate of item icon
» references (1ist)—alist of file paths

set_up (self)
Sets up this item. Called when adding the item to the project. Implement in subclasses to eg recreate
attributes destroyed by tear_down.

static item_type ()
See base class.

static item_category ()
See base class.

execution_item (self)
Creates DataConnection’s execution counterpart.

make_signal_handler_ dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting.
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restore_selections (self)
Restore selections into shared widgets when this project item is selected.

add_files_to_references (self, paths)
Add multiple file paths to reference list.

Parameters paths (11ist)— A list of paths to files
do_add_files_to_references (self, paths)

receive_files_dropped_on_icon (self, icon, file_paths)
Called when files are dropped onto a data connection graphics item. If the item is this Data Connection’s
graphics item, add the files to data.

add_files_to_data_dir (self, file_paths)
Add files to data directory

add_references (self, checked=False)
Opens a file browser where user can select the files to be added as references for this Data Connection.

remove_references (self, checked=False)
Pushes a remove references command to undo stack

do_remove_references (self, references)
Removes given references from this Data Connection. Removes references to file paths that do not exist.

Parameters references (1ist)— List of selected paths.

copy_to_project (self, checked=False)
Copy selected file references to this Data Connection’s data directory.

open_reference (self, index)
Open reference in default program.

open_data_file (self, index)
Open data file in default program.

show_spine_datapackage_form (self)
Show spine_datapackage_form widget.

datapackage_form_destroyed (self)
Notify a connection that datapackage form has been destroyed.

make_new_file (self)
Create a new blank file to this Data Connections data directory.

remove_files (self)
Remove selected files from data directory.

file references (self)
Returns a list of paths to files that are in this item as references.

data_files (self)
Returns a list of files that are in the data directory.

refresh (self, _=None)
Refresh data files in Data Connection Properties. NOTE: Might lead to performance issues.

populate_reference_list (self, items, emit_item_changed=True)
List file references in QTreeView. If items is None or empty list, model is cleared.

populate_data_1list (self, items)
List project internal data (files) in QTreeView. If items is None or empty list, model is cleared.

194

Chapter 17. API Reference



Spine Toolbox Documentation, Release 0.5.0-beta.0

update_name_label (self)
Update Data Connection tab name label. Used only when renaming project items.

resources_for_direct_successors (self)
see base class

_do_handle_dag_changed (self, resources)
See base class.

item_dict (self)
Returns a dictionary corresponding to this item.

rename (self, new_name)
Rename this item.

Parameters new_name (str) - New name
Returns True if renaming succeeded, False otherwise
Return type bool

tear_down (self)
Tears down this item. Called by toolbox just before closing. Closes the SpineDatapackageWidget instances
opened.

notify destination (self, source_item)
See base class.

static default_name_prefix ()
See base class.

spinetoolbox.project_items.data_connection.data_connection_factory

The DataConnectionFactory class.
author
M. Marin (KTH)
date 15.4.2020

Module Contents

Classes

DataConnectionFactory Class for project item factories.

class spinetoolbox.project_items.data_connection.data_connection_factory.DataConnectionFac
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT)—

item maker
Returns a Projectltem subclass.

Returns class
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icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add form maker
Returns an AddProjectltem subclass.

Returns class

specification_form maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
See base class.

spinetoolbox.project_items.data_connection.data_ connection_icon

Module for data connection icon class.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 4.4.2018

Module Contents

Classes

DataConnectionIcon Data Connection icon for the Design View.

class spinetoolbox.project_items.data_connection.data_connection_icon.DataConnectionIcon (fo
X,
y,
pi
iC1
Bases: spinetoolbox.graphics_items.ProjectItemIcon
Data Connection icon for the Design View.
Parameters
* toolbox (ToolboxUT) — main window instance
e x (float) - Icon x coordinate

* y(float)—Icony coordinate
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* project_item (ProjectItem)— Item

* icon (str)—icon resource path
class _SignalHolder
Bases: PySide2.QtCore.Q0bject

files_dropped on_icon

A signal that it triggered when files are dragged and dropped on the item
dragEnterEvent (self, event)

Drag and drop action enters. Accept file drops from the filesystem.

Parameters event (0GraphicsSceneDragDropEvent)— Event
dragLeaveEvent (self, event)

Drag and drop action leaves.

Parameters event (O0GraphicsSceneDragDropEvent)— Event
dragMoveEvent (self, event)
Accept event.

dropEvent (self, event)

Emit files_dropped_on_dc signal from scene, with this instance, and a list of files for each dropped url.
select_on_drag_over (self)

Called when the timer started in drag_enter_event is elapsed. Select this item if the drag action is still over
it.

spinetoolbox.project_items.data_connection.executable_item

Contains Data Connection’s executable item as well as support utilities.
authors

A. Soininen (VTT)
date 1.4.2020

Module Contents

Classes

Executableltem

The executable parts of Data Connection.

class spinetoolbox.project_items.data_connection.executable_item.ExecutableItem (name,

file_references,
data_files,
log-

ger)
Bases: spinetoolbox.executable item base.ExecutableltemBase

The executable parts of Data Connection.

Parameters

* name (str)—item’s name
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» file references (1ist)—alistof absolute paths to connected files
* data_files (1ist)— alist of absolute paths to files in data connection’s data directory

static item type ()
Returns DataConnectionExecutable’s type identifier string.

_output_resources_forward (self)
See base class.

classmethod from dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.

spinetoolbox.project_items.data_connection.item info

Data Connection project item info.
authors
A. Soininen (VTT)
date 29.4.2020

Module Contents

Classes

ItemInfo

class spinetoolbox.project_items.data_connection.item_info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type ()
See base class.

Package Contents

Classes

ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.data_connection.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a Projectltem subclass.
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Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
See base class.

class spinetoolbox.project_items.data_connection.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type ()
See base class.

spinetoolbox.project_items.data_store

Data store plugin.
author
M. Marin (KTH)
date 12.9.2019

Subpackages
spinetoolbox.project_items.data_ store.widgets

Widgets for the Data Store project item.
author A.Soininen (VTT)
date 27.9.2019

17.1. spinetoolbox 199



Spine Toolbox Documentation, Release 0.5.0-beta.0

Submodules

spinetoolbox.project_items.data_store.widgets.add_data_store_widget

Widget shown to user when a new Data Store is created.
author
P. Savolainen (VTT)
date 19.1.2017

Module Contents

Classes

AddDataStoreWidget A widget to query user’s preferences for a new item.

class spinetoolbox.project_items.data_store.widgets.add_data_store_widget .AddDataStoreWidge

Bases: spinetoolbox.widgets.add project_item widget.AddProjectItemWidget
A widget to query user’s preferences for a new item.

toolbox
Parent widget

Type ToolboxUI

X coordinate of new item

Type int

Y coordinate of new item
Type int
Initialize class.

call_add_item (self)
Creates new Item according to user’s selections.

spinetoolbox.project_items.data_store.widgets.custom_menus

Classes for custom context menus and pop-up menus.
author
P. Savolainen (VTT)
date 9.1.2018
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Module Contents

Classes

DataStoreContextMenu Context menu for Data Stores in the QTreeView and in
the QGraphicsView.

class spinetoolbox.project_items.data_store.widgets.custom_menus.DataStoreContextMenu (parent
po-
Si-
tion)
Bases: spinetoolbox.widgets.custom menus.ProjectItemContextMenu
Context menu for Data Stores in the QTreeView and in the QGraphicsView.

parent
Parent for menu widget (ToolboxUI)

Type QWidget

position
Position on screen

Type QPoint

Class constructor.

spinetoolbox.project_items.data_ store.widgets.data_store_ properties_widget

Data store properties widget.
author
M. Marin (KTH)
date 12.9.2019

Module Contents

Classes

DataStorePropertiesWidget Widget for the Data Store Item Properties.

class spinetoolbox.project_items.data_store.widgets.data_store_properties_widget.DataStorel
Bases: PySide2.QtWidgets.QWidget

Widget for the Data Store Item Properties.

Parameters toolbox (ToolboxUTI) — The toolbox instance where this widget should be embed-
ded

Submodules
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spinetoolbox.project_items.data_store.commands

Undo/redo commands for the DataStore project item.
authors
M. Marin (KTH)
date 5.5.2020

Module Contents

Classes

UpdateDSURLCommand Command to update DS url.

class spinetoolbox.project_items.data_store.commands.UpdateDSURLCommand (ds,

*tkwargs)
Bases: spinetoolbox.project_commands.SpineToolboxCommand
Command to update DS url.
Parameters
e ds (DataStore) —the DS
* kwargs — url keys and their values
redo (self’)
undo (self)
spinetoolbox.project_items.data_store.data_store
Module for data store class.
authors
P. Savolainen (VTT), M. Marin (KTH)
date 18.12.2017
Module Contents
Classes
DataStore Class for project items that are not category nor root.
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class spinetoolbox.project_items.data_store.data_store.DataStore (toolbox,

project, log-
ger,  name,
descrip-
tion, x, Y,
url=None)

Bases: spinetoolbox.project_item.ProjectItem

Class for project items that are not category nor root. These items can be executed, refreshed, and so on.

X
horizontal position in the screen

Type float

Yy
vertical position in the screen

Type float
Data Store class.
Parameters
¢ toolbox (ToolboxUI) - QMainWindow instance
* project (SpineToolboxProject) — the project this item belongs to
* logger (LoggerInterface) — alogger instance
* name (str)— Object name
* description (str)— Object description
e x (float) — Initial X coordinate of item icon
* y(float)—Initial Y coordinate of item icon
e url (str or dict)- SQLAlchemy url

static item_type ()
See base class.

static item_category ()
See base class.

execution_item (self)
Creates DataStore’s execution counterpart.

parse_url (self, url)
Return a complete url dictionary from the given dict or string

make_signal_handler_dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting.

restore_selections (self)
Load url into selections.

url (self)
Returns the url attribute.

sql_alchemy url (self)
Returns the URL as an SQLAlchemy URL object or None if no URL is set.

_update_sa_url (self, log_errors=True)

17.1. spinetoolbox 203



Spine Toolbox Documentation, Release 0.5.0-beta.0

project (self)

Returns current project or None if no project open.

set_path_to_sqlite_file (self, file_path)

Set path to SQLite file.

open_sqlite_f£file (self, checked=False)

Open file browser where user can select the path to an SQLite file that they want to use.

load_url_into_selections (self, url)
Load given url attribute into shared widget selections.

update_url (self, **kwargs)
Set url key to value.

do_update_url (self, **kwargs)

refresh_host (self)
Refresh host from selections.

refresh_port (self)
Refresh port from selections.

refresh_database (self)
Refresh database from selections.

refresh_username (self)
Refresh username from selections.

refresh_password (self)
Refresh password from selections.

refresh_dialect (self, dialect)

enable_dialect (self, dialect)

Enable the given dialect in the item controls.

enable_no_dialect (self)

Adjust widget enabled status to default when no dialect is selected.

enable_mssql (self)

Adjust controls to mssql connection specification.

enable_sqglite (self)

Adjust controls to sqlite connection specification.

enable_common (self)

Adjust controls to ‘common’ connection specification.

open_ds_form (self, checked=False)

Opens current url in the Spine database editor.

data_files (self)

Return a list of files that are in this items data directory.

copy_url (self, checked=False)
Copy db url to clipboard.

create_new_spine_database (self, checked=False)
Create new (empty) Spine database.

update_name_label (self)

Update Data Store tab name label. Used only when renaming project items.
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_do_handle_dag_changed (self, resources)
See base class.

item_dict (self)
Returns a dictionary corresponding to this item.

static upgrade_from no_version_to_version_1 (item_name, old_item_dict,

old_project_dir)
See base class.

static custom_context_menu (parent, pos)
Returns the context menu for this item.

Parameters
* parent (QWidget) — The widget that is controlling the menu
* pos (QPoint) — Position on screen

apply_context_menu_action (self, parent, action)
Applies given action from context menu. Implement in subclasses as needed.

Parameters
* parent (OWidget)— The widget that is controlling the menu
e action (str) - The selected action

rename (self, new_name)
Rename this item.

Parameters new_name (str)— New name
Returns True if renaming succeeded, False otherwise
Return type bool

notify destination (self, source_item)
See base class.

static default_name_prefix()
see base class

resources_for_direct_successors (self)
See base class.

spinetoolbox.project_items.data_store.data_store_ factory

The DataStoreFactory class.
author
M. Marin (KTH)
date 15.4.2020

Module Contents

Classes
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DataStoreFactory Class for project item factories.

class spinetoolbox.project_items.data_store.data_store_factory.DataStoreFactory (toolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item_ maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
See base class

spinetoolbox.project_items.data_store.data_store_icon

Module for data store icon class.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 4.4.2018

Module Contents

Classes

DataStoreIcon Data Store icon for the Design View.
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class spinetoolbox.project_items.data_store.data_store_icon.DataStoreIcon (foolbox,

X,
y, . .
project_item,
icon)
Bases: spinetoolbox.graphics_items.ProjectItemIcon
Data Store icon for the Design View.
Parameters
¢ toolbox (ToolBoxUI) - QMainWindow instance
* x (float)—Icon x coordinate
* y(float)—Icony coordinate
* project_item (ProjectItem)— Item
* icon (str) - icon resource path
mouseDoubleClickEvent (self, ¢)
Opens Spine database editor when this Data Store icon is double-clicked.
Parameters e (0GraphicsSceneMouseEvent)— Event
spinetoolbox.project_items.data_store.executable_item
Contains Data Store’s executable item as well as support utilities.
authors
A. Soininen (VTT)
date 1.4.2020
Module Contents
Classes
Executableltem The part of a project item that is executed by the Spine

Engine.

class spinetoolbox.project_items.data_store.executable_item.ExecutableItem (name,
url,
log-
ger)
Bases: spinetoolbox.executable_item base.ExecutableltemBase

The part of a project item that is executed by the Spine Engine.
Parameters
* name (str)—item’s name
* url (str)— database’s URL

* logger (LoggerInterface)—alogger
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static item_type ()
Returns the data store executable’s type identifier string.

_output_resources_backward (self)
See base class.

_output_resources_forward (self)
See base class.

classmethod from_ dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.

spinetoolbox.project_items.data_store.item_info

Data Store project item info.
authors
A. Soininen (VTT)
date 29.4.2020

Module Contents

Classes

ItemInfo

class spinetoolbox.project_items.data_store.item_info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type ()
See base class.

spinetoolbox.project_items.data_store.utils

Contains utility Data Store’s utility functions.
authors
A. Soininen (VTT)
date 6.5.2020

Module Contents

Functions
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convert_to_sqglalchemy_ url(urllib_url, Returns a sqlalchemy url from the url or None if not
item_name, logger, log_errors) valid.

spinetoolbox.project_items.data_store.utils.convert_to_sqlalchemy_ url (urllib_url,
item_name,
log-
ger,
log_errors)
Returns a sqlalchemy url from the url or None if not valid.

Package Contents

Classes

ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.data_store.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a Projectltemlcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
See base class

class spinetoolbox.project_items.data_store.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo
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static item_category ()
See base class.

static item type ()
See base class.

spinetoolbox.project_items.exporter

Exporter project item plugin.
author
A. Soininen (VTT)
date 25.9.2019

Subpackages
spinetoolbox.project_items.exporter.mvcmodels

This subpackage contains models for Exporter’s UI widgets.
author
A. Soininen (VTT)
date 25.8.2020

Submodules
spinetoolbox.project_items.exporter.mvcmodels.indexing domain_list_model

Contains TndexingDomainListModel.
author
A. Soininen (VTT)
date 25.8.2020

Module Contents

Classes
IndexingDomainListItem Holds additional indexing domain information.
IndexingDomainListModel A model to manage additional domains needed for in-

dexed parameter expansion.

class spinetoolbox.project_items.exporter.mvcmodels.indexing domain_list_model.IndexingDom:
Holds additional indexing domain information.

name
domain’s name
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Type str

description
domain’s description

Type str

expression
record key generator expression, or None

Type str or NoneType

length
length of the domain

Type int

extract_from
parameter name if the record keys are to be extracted from a parameter

Type str
Parameters name (str)— domain’s name
records (self, db_map)
Generates Records

Parameters db_map (DatabaseMappingBase) — a database mapping, needed to extract
parameter indexes

Returns domain’s records
Return type Records

class spinetoolbox.project_items.exporter.mvcmodels.indexing _domain_list_model.IndexingDom:
Bases: PySide2.QtCore.QAbstractListModel

A model to manage additional domains needed for indexed parameter expansion.
Parameters set_settings (SetSettings)—export settings

domain_ renamed
Emitted after a domain has been renamed.

indexes_changed
Emitted when a domain’s records change.

create_new_domain (self)
Adds a new domain as the last element in the list.

data (self, index, role=Qt.DisplayRole)
Returns the domain name at given row on DisplayRole.

Parameters
¢ index (OModelIndex) — an index to the list
* role (int) - datarole

item_at (self, row)
Returns TndexingDomainList Item atthe given row.

Parameters row (int)—arow in the list.

Returns item at the given row
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Return type IndexingDomainListltem

flags (self, index)
Returns item flags.

Parameters index (OModelIndex) — list index
Returns item flags
Return type int

gather_domains (self, db_map)
Returns domain name and records.

Parameters db_map (DatabaseMappingBase)— a database map
Returns mapping from domain name to records
Return type dict

insertRows (self, row, count, parent=QModellndex())
Inserts new rows to the list.

Parameters
* row (int) — first row occupied by the inserted items
¢ count (int) - number of inserted items
* parent (QModelIndex) —ignored

Returns True if the operation was successful

Return type bool

removeRows (self, row, count, parent=QModellndex())
Removes rows.

Parameters

e row (int) — first row to remove

¢ count (int) - number of rows to remove

* parent (QOModelIndex) —ignored
Returns True if the operations was successful
Return type bool

remove_rows (self, rows)
Removes non-contiguous set of rows effectively resetting the model.

Parameters rows (1ist of int)—rows toremove

rowCount (self, parent=QModellndex())
Returns the list length.

Returns number of rows in the list
Return type int

setData (self, index, value, role=Qt.EditRole)
Sets domain name at given index on EditRole.

Parameters

¢ index (OModelIndex) — an index to the list
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¢ value (str)—new domain name
e role (int)—role
Returns True if a domain name was changed

Return type bool

spinetoolbox.project_items.exporter.mvcmodels.indexing table_model

Contains TndexingTableModel.
author
A. Soininen (VTT)
date 25.8.2020

Module Contents

Classes

IndexingTableModel A table model for parameter_value indexing.

class spinetoolbox.project_items.exporter.mvcmodels.indexing_ table_model.IndexingTableMode.
Bases: PySide2.QtCore.QAbstractTableModel

A table model for parameter_value indexing.

First column contains the proposed new index keys. The rest of the columns contain the parameter values for
each set of existing index keys. Only selected new index keys are used for indexing. Unselected rows are left
empty.

Parameters parameter (Parameter) — a parameter to model

selection_changed
Emitted after the values have been spread over the selected indexes.

manual_ selection
Emitted when the selection has been changed by setData().

get_picking (self)
Turns the checked record into picking.

Returns picked records
Return type FixedPicking

canFetchMore (self, parent)
Returns True if more rows are available to show.

clear (self)
Clears the model.

columnCount (self, parent=QModellndex())
Returns the number of columns.

data (self, index, role=Qt.DisplayRole)
Returns data associated with given model index and role.
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headerData (self, section, orientation, role=Qt.DisplayRole)
Returns header data.

fetchMore (self, parent)
Inserts a number of new rows to the table.

flags (self, index)
Returns flags for given index.

mapped_values_balance (self)
Returns the balance between available indexes and parameter values.

Zero means that there is as many indexes available as there are values, i.e. the parameter is ‘perfectly’
indexed. A positive value means there are more indexes than values while a negative value means there
are not enough indexes for all values.

Returns mapped values’ balance
Return type int

rowCount (self, parent=QModellndex())
Return the number of rows.

select_all (self)
Selects all indexes.

setData (self, index, value, role=Qt.EditRole)
Sets the checked state for given index.

set_index_name (self, name)
Sets the indexing domain name.

set_records (self, records, pick_list=None)
Overwrites all new indexes.

set_picking (self, picking)
Selects the indexes specified by picking.

Parameters picking (Picking) — picking

_spread_values_over_selected_rows (self, first_row)
Repopulates the table according to selected indexes.

spinetoolbox.project_items.exporter.mvcmodels.record list_model

Contains RecordListModel
author
A. Soininen (VTT)
date 25.8.2020

Module Contents

Classes
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RecordListModel A model to manage record ordering within domains and
sets.

class spinetoolbox.project_items.exporter.mvcmodels.record_list_model.RecordListModel
Bases: PySide2.QtCore.QAbstractListModel

A model to manage record ordering within domains and sets.

data (self, index, role=Qt.DisplayRole)
With role == Qt.DisplayRole returns the record’s keys as comma separated string.

flags (self, index)

headerData (self, section, orientation, role=Qt.DisplayRole)
Returns row and column header data.

moveRows (self, sourceParent, sourceRow, count, destinationParent, destinationChild)
Moves the records around.

Parameters
* sourceParent (OModelIndex) — parent from which the rows are moved
¢ sourceRow (int) —index of the first row to be moved
¢ count (int)— number of rows to move
* destinationParent (OModelIndex) — parent to which the rows are moved
¢ destinationChild (int)—index where to insert the moved rows
Returns True if the operation was successful, False otherwise

reset (self, records, set_name)
Resets the model’s record data.

rowCount (self, parent=QModellndex())
Returns the number of records in the model.

sort_alphabetically (self)
Sorts the record alphabetically

spinetoolbox.project_items.exporter.mvcmodels.set_list_model

Contains SetListModel
author
A. Soininen (VTT)
date 25.8.2020

Module Contents

Classes
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SetListModel A model to configure the domain and set name lists in
gdx export settings.

class spinetoolbox.project_items.exporter.mvcmodels.set_list_model.SetListModel (set_settings)
Bases: PySide2.QtCore.QAbstractListModel

A model to configure the domain and set name lists in gdx export settings.

This model combines domain and set names into a single list. The two ‘parts’ are differentiated by different
background colors. Items from each part cannot be mixed with the other. Both the ordering of the items within
each list as well as their exportability flags are handled here.

Parameters set_settings (gdx.SetSettings) — settings whose domain and set name lists
should be modelled

add_domain (self, domain_name, records, origin)
Adds a new additional domain.

Parameters
¢ domain_name (str)—domain’s name
¢ records (gdx.Records)—domain’s sorted records
* origin (gdx.Origin)—domain’s origin

drop_domain (self, domain_name)
Removes a domain.

Parameters domain_name (st r)—name of the domain to remove

update_domain (self, domain_name, records)
Updates the records of an existing domain.

Parameters
¢ domain_name (str)—domain’s name
* records (gdx.Records) — updated records

update_indexing domains (self, domains)
Updates additional domains needed for parameter index expansion.

Parameters domains (dict)— a mapping from domain name to records

data (self, index, role=Qt.DisplayRole)
Returns the value for given role at given index.

Qt.DisplayRole returns the name of the domain or set while Qt.CheckStateRole returns whether the ex-
portable flag has been set or not. Qt.BackgroundRole gives the item’s background depending whether it is
a domain or a set.

Parameters
¢ index (OModelIndex) — an index to the model
* role (int) —the query’s role

Returns the requested value or None

flags (self, index)
Returns an item’s flags.

headerData (self, section, orientation, role=Qt.DisplayRole)
Returns an empty string for horizontal header and row number for vertical header.
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is_domain (self, index)
Returns True if index points to a domain name, otherwise returns False.

moveRows (self, sourceParent, sourceRow, count, destinationParent, destinationChild)
Moves the domain and set names around.

The names cannot be mixed between domains and sets.

Parameters
* sourceParent (OModelIndex)— parent from which the rows are moved
¢ sourceRow (int) —index of the first row to be moved
e count (int) - number of rows to move
* destinationParent (QModelIndex) — parent to which the rows are moved
¢ destinationChild (int) —index where to insert the moved rows

Returns True if the operation was successful, False otherwise

rowCount (self, parent=QModellndex())
Returns the number of rows.

setData (self, index, value, role=Qt.EditRole)
Sets the exportable flag status for given row.

update_global_parameters_domain (self, domain_name)

spinetoolbox.project_items.exporter.widgets

Exporter project item widgets.
author
A. Soininen (VTT)
date 3.10.2019

Submodules
spinetoolbox.project_items.exporter.widgets.add exporter_ widget

Widget shown to user when a new Exporter item is created.
author
A. Soininen (VTT)
date 6.9.2019

Module Contents

Classes

AddExporterWidget A widget to query user’s preferences for a new item.
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class spinetoolbox.project_items.exporter.widgets.add_exporter_widget.AddExporterWidget (foo

Bases: spinetoolbox.widgets.add project_item widget.AddProjectItemWidget
A widget to query user’s preferences for a new item.
Parameters
* toolbox (ToolboxUI) — Parent widget
¢ x (int)— X coordinate of new item
* y (int)—Y coordinate of new item

call_add_item (self)
Creates new Item according to user’s selections.

spinetoolbox.project_items.exporter.widgets.export_list_item

A small widget to set up a database export in Gdx Export settings.

author
A. Soininen (VTT)
date 10.9.2019

Module Contents

Classes

ExportListItem A widget with few controls to select the output file name
and open a settings window.

spinetoolbox.project_items.exporter.widgets.export_list_item._ BASE_ALTERNATIVE_TEXT = Expo:

class spinetoolbox.project_items.exporter.widgets.export_list_item.ExportListItem (url,

Bases: PySide2.QtWidgets.QWidget
A widget with few controls to select the output file name and open a settings window.
Parameters
* url (str) - database’s identifier to be shown on a label
* file_name (str) —relative path to the exported file name
* settings_state (SettingsState) — settings state

* parent (QWidget) — a parent widget
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open_settings_clicked
Emitted when settings window should be opened.

file_name_changed
Emitted when the file name field is changed.

scenario_changed
Emitted when selected scenario has changed.

out_file name_ edit
export file name QLineEdit

url field
Text in the database URL field.

update_notification_label (self, state)
Updates the UI and the message label according to settings pack state.

Parameters state (SettingsState) — settings state

update_scenarios (self, scenarios, selected)
Updates the scenarios combo box.

Parameters
* scenarios (dict)—a map from scenario name to boolean active flag

* selected(str, optional)-— currently selected scenario, None for the ‘Base’ alter-
native

make_sure_ this_scenario_is_shown_in the combo_box (self, scenario)
Makes sure the given scenario is selected in the combo box.

Parameters scenario (str, optional)— scenario name

_emit_file_ name_changed (self)
Emits file_name_changed signal.

_emit_open_settings_clicked (self, )
Emits open_settings_clicked signal.

_emit_scenario_changed (self, selected)
Emits scenario_changed signal.

spinetoolbox.project_items.exporter.widgets.exporter_ properties

Exporter properties widget.
author
A. Soininen (VTT)
date 25.9.2019

Module Contents

Classes
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ExporterProperties A main window widget to show Gdx Export item’s
properties.

class spinetoolbox.project_items.exporter.widgets.exporter_properties.ExporterProperties (7o
Bases: PySide2.QtWidgets.QWidget

A main window widget to show Gdx Export item’s properties.
Parameters toolbox (ToolboxUT) — a main window instance

ui
The UI form of this widget.

spinetoolbox.project_items.exporter.widgets.gdx export_settings

Export item’s settings window for .gdx export.
author
A. Soininen (VTT)
date 9.9.2019

Module Contents

Classes
State Gdx Export Settings window state
GdxExportSettings A setting window for exporting .gdx files.

class spinetoolbox.project_items.exporter.widgets.gdx_export_settings.State
Bases: enum.Enum

Gdx Export Settings window state
Create and return a new object. See help(type) for accurate signature.

OK
Settings are ok.

BAD_INDEXING
Not all indexed parameters are set up correctly.
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class spinetoolbox.project_items.exporter.widgets.gdx_export_settings.GdxExportSettings (ser

Bases: PySide2.QtWidgets.QWidget

A setting window for exporting .gdx files.

Parameters

set_settings (gdx.SetSettings) — export settings for GAMS sets

indexing settings (dict) — indexing domain information for indexed parameter
values

merging_settings (dict)— parameter merging settings
none_fallback (NoneFallback) — fallback for None parameter values
none_export (NoneExport) —how to handle None values while exporting
scenario (str, optional)— scenario name

database_url (str) - database URL

parent (QWidget) — a parent widget

reset_requested
Emitted when Reset Defaults button has been clicked.

settings_accepted
Emitted when the OK button has been clicked.

settings_rejected
Emitted when the Cancel button has been clicked.

set_settings
the settings object

indexing_settings
indexing settings dict

merging_settings
dictionary of merging settings

none_fallback

none_export

reset_settings (self, set_settings, indexing_settings, merging_settings)
Resets all settings.

_check_state (self)
Checks if there are parameters in need for indexing.
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_set_none_fallback (self, option)
Sets the None fallback option.

Parameters option (str)— option as a label in the combo box

_init_none_fallback_combo_box (self, fallback)
Sets the current text in None fallback combo box.

Parameters fallback (NoneFallback)— option

_set_none_export (self, option)
Sets the None export option.

Parameters option (str)— option as a label in the combo box

_init_none_export_combo_box (self, export)
Sets the current text in None export combo box

Parameters export (NoneExport) — option

_populate_global_parameters_combo_box (self, settings)
(Re)populates the global parameters combo box.

_set_records_ordering_ controls_enabled (self, enabled)
Sets or unsets the enabled state of buttons that control the record key order.

Parameters enabled — True if the buttons should be enabled, False otherwise
handle_settings_state_changed (self, state)

_accept (self)
Emits the settings_accepted signal.

_move_sets_up (self, checked=False)
Moves selected domains and sets up one position.

_move_sets_down (self, checked=False)
Moves selected domains and sets down one position.

_move_records_up (self, checked=False)
Moves selected records up and position.

_move_records_down (self, checked=False)
Moves selected records down on position.

_reject (self)
Closes the window.

closeEvent (self, event)

_reset_settings (self, button)
Requests for fresh settings to be read from the database.

_update_global_parameters_domain (self, text)
Updates the global parameters domain name.

_populate_set_contents (self, selected, _)
Populates the record list by the selected domain’s or set’s records.

_sort_records_alphabetically (self, _)
Sorts the lists of set records alphabetically.

_show_indexed_parameter_settings (self, _)
Shows the indexed parameter settings window.
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_show_parameter_merging_settings (self, _)
Shows the parameter merging settings window.

_gather_ parameter_indexing_settings (self)
Gathers settings from the indexed parameters settings window.

_parameter merging_approved (self)
Collects merging settings from the parameter merging window.

_dispose_parameter_indexing_ settings_window (self)
Removes references to the indexed parameter settings window.

_dispose_parameter_merging_window (self)
Removes references to the parameter merging settings window.

_domains_sets_exportable_state_changed (self, top_left, bottom_right, _)

spinetoolbox.project_items.exporter.widgets.merging error flag

Error condition flags for Parameter merging.
author
A. Soininen (VTT)
date 2.3.2020

Module Contents

Classes

MergingErrorFlag Error flags for parameter merging.

class spinetoolbox.project_items.exporter.widgets.merging error_flag.MergingErrorFlag
Bases: enum.Flag

Error flags for parameter merging.

Create and return a new object. See help(type) for accurate signature.
NO_ERRORS = 0

PARAMETER_ NAME_MISSING

DOMAIN NAME MISSING

NO_PARAMETER SELECTED

spinetoolbox.project_items.exporter.widgets.parameter_ index_settings

Parameter indexing settings window for .gdx export.
author
A. Soininen (VTT)
date 26.11.2019
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Module Contents

Classes
IndexSettingsState An enumeration indicating the state of the settings win-
dow.
ParameterIndexSettings A widget showing setting for a parameter with indexed
values.
Functions
_freely update_domains_combo(widget) A context manager which temporarily disables the mon-

itoring of current text changes in domains combo box.

class spinetoolbox.project_items.exporter.widgets.parameter_index_settings.IndexSettingsSt:
Bases: enum.Enum

An enumeration indicating the state of the settings window.

Create and return a new object. See help(type) for accurate signature.
OK

DOMAIN_MISSING_INDEXES

class spinetoolbox.project_items.exporter.widgets.parameter_index_settings.ParameterIndexSe

Bases: PySide2.QtWidgets.QWidget
A widget showing setting for a parameter with indexed values.
Parameters
* parameter_name (str)— parameter’s name
* indexing_setting (IndexingSetting)— indexing settings for the parameter
* available_domains (dict) - adict from existing domain name to Records
* parent (QWidget, optional)— aparent widget

state
widget’s state

indexing domain_name (self)
Returns the selected indexing domain’s name

Returns domain name
Return type str

picking (self)
Returns picking.
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Returns picking
Return type Picking

set_domains (self, domains)
Sets new domains and record keys.

Parameters domains (dict)— mapping from domain name to records

set_domains_combo_monitoring_enabled (self, enabled)
Enables or disables monitoring of current text in domains combo box.

Parameters enabled (bool) — True enables monitoring, False disables

update_domain_name (self, old_name, new_name)
Renames a domain.

Parameters
* 0old_name (str) - previous name
* new_name (str)—new name

update_records (self, domain_name)
Updates existing domain’s records.

Parameters domain_name (st r) - domain’s name

notification_message (self, message)
Shows a notification message on the widget.

warning message (self, message)
Shows a warning message on the widget.

error_message (self, message)
Shows an error message on the widget.

_check_state (self)
Updated the widget’s state.

_check_errors (self, mapped_values_balance)
Checks if the parameter is correctly indexed.

_check_warnings (self, mapped_values_balance)
Checks if there are non-fatal issues with parameter indexing.

_update_indexing domains_name (self)
Updates the model’s header and the label showing the indexing domains.

_clear_pick_expression_silently (self)
Clears the pick expression line edit.

_change_domain (self, domain_name)
Change the domain used on the table.

_update_index_ list_selection (self, expression)
Updates selection according to changed selection expression.

_move_indexing domain_left (self, )
Moves the indexing domain name left on the indexing label.

_move_indexing_domain_right (self, )
Moves the indexing domain name right on the indexing label.

spinetoolbox.project_items.exporter.widgets.parameter_index_settings._freely update_domain:
A context manager which temporarily disables the monitoring of current text changes in domains combo box.
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Parameters widget (ParameterIndexSettings)— settings widget

spinetoolbox.project_items.exporter.widgets.parameter_ index_settings_window

Parameter indexing settings window for .gdx export.
author
A. Soininen (VTT)
date 25.11.2019

Module Contents

Classes
ParameterIndexSettingsWindow A window which shows a list of ParameterIndexSettings
widgets, one for each parameter with indexed values.
Functions
_disable domain_updates(window) A context manager which disables updates on the index-

ing settings widgets.

class spinetoolbox.project_items.exporter.widgets.parameter_index_settings_window.Paramete:

Bases: PySide2.QtWidgets.QWidget
A window which shows a list of ParameterIndexSettings widgets, one for each parameter with indexed values.
Parameters
* indexing_settings (dict)—a map from parameter name to IndexingSetting
* set_settings (SetSettings)— export settings
* database_path (str) — a database url
e scenario (str) - scenario name
* parent (QWidget) — a parent widget

settings_approved
Emitted when the settings have been approved.

settings_rejected
Emitted when the settings have been rejected.

indexing_ settings
indexing settings dictionary
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additional_indexing domains (self)

set_domain_updated_enabled (self, enabled)
Enables or disables updating the indexing settings widgets.

Parameters enabled (bool) —if True, allow the widgets to update

_switch_additional_domain_widgets_enabled_state (self, using_expression)
Enabled and disables additional domain widgets.

Parameters using_expression (bool) — True if expression is used, False if record keys
are extracted from existing parameter

_set_additional_domain_widgets_enabled (self, enabled)

_add_domain (self, _)
Creates a new additional domain.

_collect_and_hide (self)
Collects settings from individual ParameterIndexSettings widgets and hides the window.

_load_additional_domain (self, current, previous)
_reject_and_close (self)
_remove_selected_domains (self, _)

_send_domains_to_indexing_ widgets (self, parent, first, last)
Updates the available domains combo boxes in indexing widgets.

_update_after_ domain_rename (self, old_name, new_name)
Propagates changes in domain names to widgets.

Parameters
* 0ld_name (str)—domain’s previous name
* new_name (str)— domain’s current name

_update_expression (self, expression)
Updates the domain’s record key expression.

Parameters expression (str)— new expression

_update_length (self, length)
Updates the number of additional domain’s records.

Parameters length (int)—new record count
_use_expression (self, _)
_use_extraction (self, _)

_set_extraction_domain (self, domain_name)
Sets the domain from which domain’s records are extracted.

Parameters domain_ name (st r)— domain name

closeEvent (self, event)
Handles the close event.

spinetoolbox.project_items.exporter.widgets.parameter_index_settings_window._disable_domaii
A context manager which disables updates on the indexing settings widgets.

Parameters window (ParameterIndexSettingsWindow) — settings window
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spinetoolbox.project_items.exporter.widgets.parameter merging settings

Parameter merging settings widget.

author
A. Soininen (VTT)
date 19.2.2020

Module Contents

Classes
ParameterMergingSettings A widget for configure parameter merging.
_DomainNamelListModel Model for domains_list_view.
_ParameterNameListModel Model for parameter_name_list_view.

spinetoolbox.project_items.exporter.widgets.parameter_merging_settings._ERROR_MESSAGE = <sj

class spinetoolbox.project_items.exporter.widgets.parameter_merging_settings.ParameterMerg:

Bases: PySide2.QtWidgets.QWidget
A widget for configure parameter merging.
Parameters
* entity class_infos (1ist) - list of EntityClassInfo objects
* parent (QWidget) — a parent widget
* parameter_name (str)— merged parameter name of None for widget
* merging_setting (MergingSetting)— merging settings or None for empty widget

removal_requested
Emitted when the settings widget wants to get removed from the parent window.

error_flags

parameter_name
Name of the merged parameter.

merging_setting (self)
Constructs the MergingSetting object from the widget’s contents.

update (self, entity_class_infos)
Updates the settings after database commit.

_check_state (self)
Updates the message label according to widget’s error state.
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_clear_flag (self, state)
Clears a state flag.

_set_flag (self, state)
Sets a state flag.

_reset_indexing_domains_label (self, domain_name=None, domain_names=None)
Rewrites the contents of indexing_domains_label.

_update_parameter_name (self, name)
Updates the merged parameter name.

_remove_self (self, )
Requests removal from the parent window.

_handle_domain_selection_change (self, selected, _)
Resets the settings after another item has been selected in domains_list_view.

_update_indexing domain_name (self, name)
Resets indexing_domains_label.

_move_domain_left (self, _)
Moves the new indexing domain left in indexing_domains_label.

_move_domain_right (self, )
Moves the new indexing domain left in indexing_domains_label.

class spinetoolbox.project_items.exporter.widgets.parameter_merging_settings._DomainNameLi:
Bases: PySide2.QtCore.QAbstractListModel

Model for domains_list_view.
Stores EntityClassInfo objects displaying the entity name in domains_list_view.
Parameters entity_classes (11ist)— alist of EntityClassObjects

data (self, index, role=Qt.DisplayRole)
Returns model’s data for given index.

headerData (self, section, orientation)
Returns None.

index_for (self, set_name)
Returns the QModellndex for given set name.

item_at (self, row)
Returns the EntityClassInfo object at given row.

rowCount (self, parent=QModellndex())
Returns the size of the model.

update (self, entity_classes)
Updates the model.

class spinetoolbox.project_items.exporter.widgets.parameter_merging_settings._ParameterName
Bases: PySide2.QtCore.QAbstractListModel

Model for parameter_name_list_view.
Parameters names (11ist)— list of parameter names to show in the view

data (self, index, role=Qt.DisplayRole)
Returns the model’s data.
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flags (self, index)
Returns flags for given index.

headerData (self, section, orientation)
Returns None.

reset (self, names)
Resets the model’s contents when a new index is selected in domains_list_view.

rowCount (self, parent=QModellndex())
Returns the number of parameter names.

select (self, names)
Selects parameters for inclusion in the merged parameter.

selected (self)
Returns a list of the selected parameters.

setData (self, index, value, role=Qt.EditRole)
Selects or deselects the parameter at given index for inclusion in the merged parameter.

update (self, names)
Updates the parameter names keeping the previous selection where it makes sense.

spinetoolbox.project_items.exporter.widgets.parameter merging settings_window

Parameter merging settings window.
author
A. Soininen (VTT)
date 19.2.2020

Module Contents

Classes
ParameterMergingSettingsWindow A window which shows a list of ParameterMergingSet-
tings widgets, one for each merged parameter.
EntityClassInfo Contains information of an entity_class (object or rela-
tionship_class) for use in the parameter merging widget.
Functions
_gather_entity class_infos(db_map) Collects entity_class infos from database.

class spinetoolbox.project_items.exporter.widgets.parameter_merging_settings_window.Paramef

Bases: PySide2.QtWidgets.QWidget

A window which shows a list of ParameterMergingSettings widgets, one for each merged parameter.
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Parameters
* merging_ settings (dict)— a map from merged parameter name to merging settings
* database_path (str)— database URL
* parent (QWidget) — a parent widget

settings_approved
Emitted when the settings have been approved.

settings_rejected
Emitted when the settings have been rejected.

merging_settings
a dict that maps merged parameter names to their merging settings

update (self)
Updates the settings according to changes in the database.

_add_setting (self, parameter_name=None, merging_setting=None)
Inserts a new settings widget to the widget list.

_ok_to_accept (self)
Returns True if it is OK to accept the settings, otherwise shows a warning dialog and returns False.

_add_empty_setting (self, _)
Adds an empty settings widget to the widget list.

_remove_setting (self, settings_widget)
Removes a setting widget from the widget list.

_collect_and_hide (self)
Collects settings from individual ParameterMergingSettings widgets and hides the window.

_reject_and_close (self)
Emits settings_rejected and closes the window.

class spinetoolbox.project_items.exporter.widgets.parameter_merging_settings_window.Entity!

Contains information of an entity_class (object or relationship_class) for use in the parameter merging widget.

name
entity’s name

Type str

class_id
entity’s database id

Type int

domain_names
object classes that index the entities in this class; for object classes this list contains the entity’s name only,
for relationship classes the list contains the relationship’s object classes

Type list
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parameter_names
entity’s defined parameters

Type list

is_object_class
True if the entity is a object_class, False if it is a relationship_class

Type bool

Parameters
* name (str)— entity’s name
* class_id (int) — entity’s database id

* domain_names (1ist) — object classes that index the entities in this class; for object
classes this list contains the entity’s name only, for relationship classes the list contains the
relationship’s object classes

* parameter_names (1ist)—entity’s defined parameters
* is_object_class (bool) — True if the entity is a object_class, False if it is a relation-
ship_class
spinetoolbox.project_items.exporter.widgets.parameter_merging_settings_window._gather_entif
Collects entity_class infos from database.
Parameters db_map (spinedb_api.DatabaseMapping)— a database map
Returns a list of EntityClassInfo objects

Return type list

Submodules
spinetoolbox.project_items.exporter.commands

Undo/redo commands for the Exporter project item.
authors
A. Soininen (VTT)
date 30.4.2020

Module Contents

Classes
UpdateExporterOutFileName Command to update Exporter output file name.
UpdateScenario
param exporter the Exporter
UpdateExporterSettings Command to update Exporter settings.
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class spinetoolbox.project_items.exporter.commands.UpdateExporterOutFileName (exporter,
file_name,

database_path)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Exporter output file name.
Parameters
* exporter (Exporter) - the Exporter
* file_ name (str)— the output filename
* database_path (str) — the associated db path
redo (self’)
undo (self)

class spinetoolbox.project_items.exporter.commands.UpdateScenario (exporter,
scenario,

database_url)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Parameters
* exporter (Exporter) — the Exporter
* scenario (str, optional)-new scenario name
¢ database_url (str)— database URL
redo (self)
undo (self)

class spinetoolbox.project_items.exporter.commands.UpdateExporterSettings (exporter,
set-
tings,
in-
dex-
ing_settings,
merg-
ing_settings,
none_fallback,
none_export,

database_path)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Exporter settings.
Parameters

* exporter (Exporter) - the Exporter
* settings (SetSettings)— gdx settings
* indexing_settings (dict) — parameter indexing settings
* merging_settings (dict) — parameter merging settings
* none_fallback (NoneFallback) — fallback option on None values
* none_export (NoneExport)—how to handle Nones while exporting

* database_path (str) — the db path to update settings for
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redo (self)
undo (self)

spinetoolbox.project_items.exporter.db_utils

Contains utility functions to help with Spine databases.
author
A. Soininen (VTT)
date 5.9.2019

Module Contents

Functions

latest_database commit_time stamp(databaseSeaaghes the latest commit timestamp from given

database
scenario_filtered database_ map(database_urlCreates a database mapping and applies scenario filter-
scenario) ing to it.

spinetoolbox.project_items.exporter.db_utils.latest_database_commit_time_stamp (database_map)
Searches the latest commit timestamp from given database

Parameters database_map (DatabaseMappingBase)— database map
Returns latest time stamp or None if there are no commits.
Return type datetime

spinetoolbox.project_items.exporter.db_utils.scenario_filtered_database_map (database_url,
sce-

nario)
Creates a database mapping and applies scenario filtering to it.

Parameters

e database_url (str) - database URL

* scenario (str, optional)- scenario name or None for the ‘Base’ alternative
Returns database mapping

Return type DatabaseMapping

spinetoolbox.project_items.exporter.executable item

Contains Exporter’s executable item as well as support utilities.
authors
A. Soininen (VTT)
date 2.4.2020
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Module Contents

Classes

Executableltem The part of a project item that is executed by the Spine
Engine.

class spinetoolbox.project_items.exporter.executable_item.ExecutableItem (name,
set-
tings_packs,
can-
cel_on_error,
data_dir,
gams_path,
log-

ger)
Bases: spinetoolbox.executable_item base.ExecutableltemBase

The part of a project item that is executed by the Spine Engine.
Parameters
* name (str)—item’s name
* settings_packs (dict) - mapping from database URLSs to SettingsPacks

e cancel_on_error (bool) — True if execution should fail on all errors, False if certain
errors can be ignored

* data_ dir (str) - absolute path to exporter’s data directory
* gams_path (str)— GAMS path from Toolbox settings
* logger (LoggerInterface)—alogger

static item type ()
Returns Exporter’s type identifier string.

_execute_forward (self, resources)
See base class.

_output_resources_forward (self)
See base class.

_resolve_gams_system_directory (self)
Returns GAMS system path from Toolbox settings or None if GAMS default is to be used.

classmethod from_ dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.

spinetoolbox.project_items.exporter.exporter

Exporter project item.
author
A. Soininen (VTT)
date 5.9.2019
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Module Contents

Classes
Exporter This project item handles all functionality regarding ex-
porting a database to a file.
Functions
_normalize_url(url) Normalized url’s path separators to their OS specific
characters.
_latest_database_commit_time_stamp(url) Returns the latest commit timestamp from database at
given URL or None.

class spinetoolbox.project_items.exporter.exporter.Exporter (toolbox, project, log-
ger, name, descrip-
tion, settings_packs,

X, y, can-
cel_on_export_error=None,
can-

cel_on_error=None)
Bases: spinetoolbox.project_item.ProjectItem

This project item handles all functionality regarding exporting a database to a file.
Currently, only .gdx format is supported.
Parameters
* toolbox (ToolboxUT) —a ToolboxUI instance
* project (SpineToolboxProject) — the project this item belongs to
* logger (LoggerInterface) — alogger instance
* name (str) - item name
* description (str) — item description
* settings_packs (11ist) - dicts mapping database URLs to _SettingsPack objects
* x (float) —initial X coordinate of item icon
* y(float)—initial Y coordinate of item icon

* cancel_on_export_error (bool, options)-legacy cancel_on_error op-
tion

* cancel_on_error (bool, options) — True if execution should fail on all export
errors, False to ignore certain error cases; optional to provide backwards compatibility

set_up (self)
See base class.

static item_type ()
See base class.

static item category ()
See base class.
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execution_item (self)
Creates Exporter’s execution counterpart.

settings_pack (self, database_path)

make_signal_handler_dict (self)
Returns a dictionary of all shared signals and their handlers.

restore_selections (self)
Restores selections and connects signals.

_connect_signals (self)
Connect signals to handlers.

_read_scenarios (self, database_url)
Reads scenarios from database.

Parameters database_url (str) — database url
Returns a mapping from scenario name to boolean ‘active’ flag
Return type dict

_update_properties_tab (self)
Updates the database list and scenario combo boxes in the properties tab.

_do_handle_dag_changed (self, resources)
See base class.

_start_worker (self, database_url, update_settings=False)
Starts fetching settings using a worker in another thread.

_worker_msq (self, database_url, text)
_worker_msg_warning (self, database_url, text)
_worker_msg_error (self, database_url, text)

_worker_finished (self, database_url, result)
Gets and updates and export settings pack from a worker.

_worker_failed (self, database_url, exception)
Clean up after a worker has failed fetching export settings.

_cancel_worker (self, database_url)
Cleans up after worker has given up fetching export settings.

_check_state (self, clear_before_check=True)
Checks the status of database export settings.

Updates both the notification message (exclamation icon) and settings states.

_check_missing file_names (self)
Checks the status of output file names.

_check_duplicate_file_ names (self)
Checks for duplicate output file names.

_check_missing parameter_indexing (self)
Checks the status of parameter indexing settings.

_check_erroneous_databases (self)
Checks errors in settings fetching from a database.

_report_notifications (self)
Updates the exclamation icon and notifications labels.
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_show_settings (self, database_url)
Opens the item’s settings window.

_reset_settings_window (self, database_url)
Sends new settings to Gdx Export Settings window.

_dispose_settings_window (self, database_url)
Deletes rejected export settings windows.

_update_out_file_name (self, file_name, database_path)
Pushes a new UpdateExporterOutFileNameCommand to the toolbox undo stack.

_update_scenario (self, scenario, database_url)
Updates the selected scenario.

Parameters
* scenario (str or NoneType) - selected scenario
e database_url (str) - database URL

set_scenario (self, scenario, database_url)
Sets the selected scenario in settings pack.

Parameters
e scenario (str or NoneType) - selected scenario
e database_url (str)— database URL

_update_settings_from settings_window (self, database_path)
Pushes a new UpdateExporterSettingsCommand to the toolbox undo stack.

_cancel_on_error_option_changed (self, checkbox_state)
Handles changes to the Cancel export on error option.

set_cancel_on_error (self, cancel)
Sets the Cancel export on error option.

undo_redo_out_file_name (self, file_name, database_path)
Updates the output file name for given database

undo_or_redo_settings (self, settings, indexing_settings, merging_settings, none_fallback,
none_export, database_path)
Updates the export settings for given database.

item_dict (self)
Returns a dictionary corresponding to this item’s configuration.

_discard_settings_window (self, database_path)
Discards the settings window for given database.

_send_settings_to_window (self, database_url)
Resets settings in given export settings window.

update_name_label (self)
See base class.

notify destination (self, source_item)
See base class.

_update_settings_after_db_commit (self, committed_db_maps, cookie)
Refreshes export settings for databases after data has been committed to them.

_update_settings_after_db_creation (self, url)
Triggers settings override.
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static default_name_prefix()
See base class.

resources_for_direct_successors (self)
See base class.

tear_down (self)
See base class.

static upgrade_vl_to_v2 (item_name, item_dict)
Upgrades item’s dictionary from v1 to v2.

Changes: - output_file_name and database_url stay the same but state is set to Fetching.
Parameters
e item_ name (str)-item’s name
e item dict (dict) - Version 1 item dictionary
Returns Version 2 Exporter dictionary
Return type dict

spinetoolbox.project_items.exporter.exporter._normalize_url (url)
Normalized url’s path separators to their OS specific characters.

This function is needed during the transition period from no-version to version 1 project files. It should be
removed once we are using version 1 files.

spinetoolbox.project_items.exporter.exporter._latest_database_commit_time_stamp (url)
Returns the latest commit timestamp from database at given URL or None.

spinetoolbox.project_items.exporter.exporter_ factory

The ExporterFactory class.
author
M. Marin (KTH)
date 15.4.2020

Module Contents

Classes

ExporterFactory Class for project item factories.

class spinetoolbox.project_items.exporter.exporter_factory.ExporterFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT)—

item maker
Returns a Projectltem subclass.

Returns class
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icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add form maker
Returns an AddProjectltem subclass.

Returns class

specification_form maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
See base class.

spinetoolbox.project_items.exporter.exporter_icon

Icon class for the Exporter project item.
authors
A. Soininen (VTT)
date 25.9.2019

Module Contents

Classes

ExporterIcon Exporter icon for the Design View.

class spinetoolbox.project_items.exporter.exporter_icon.ExporterIcon (toolbox,

x3 ys
project_item,
icon)

Bases: spinetoolbox.graphics_items.ProjectItemIcon

Exporter icon for the Design View.

Parameters
* toolbox (ToolBoxUI) - QMainWindow instance

* x (float)—Icon x coordinate

* y(float)-Icony coordinate
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* project_item (ProjectItem)— Item

* icon (str)—icon resource path

spinetoolbox.project_items.exporter.item info

Exporter project item info.
authors
A. Soininen (VTT)
date 29.4.2020

Module Contents

Classes

ItemInfo

class spinetoolbox.project_items.exporter.item_info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

spinetoolbox.project_items.exporter.list_utils

Contains list helper functions for list manipulation.
author
A. Soininen (VTT)
date 12.12.2019

Module Contents

Functions

move_1list_element s(originals, first, last, target) Moves elements in a list.
move_selected elements_by(list_view, delta) Moves selected items in a QListView by given delta.

spinetoolbox.project_items.exporter.list_utils.move_list_elements (originals,
first,  last,

target)
Moves elements in a list.

Parameters
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* originals (1ist)—alist

e first (int)—index of the first element to move

* last (int) - index of the last element to move

* target (int)—index where the elements [first:last] should be inserted
Returns a new list with the elements moved

spinetoolbox.project_items.exporter.list_utils.move_selected_elements_by (list view,
) ) o ) delta)
Moves selected items in a QListView by given delta.

Parameters
e list_view (QListView)—a list view

* delta (int) - positive values move the items up, negative down

spinetoolbox.project_items.exporter.notifications

Contains the Notifications class.
author
A. Soininen (VTT)
date 6.5.2020

Module Contents

Classes

Notifications Holds flags for different error conditions.

class spinetoolbox.project_items.exporter.notifications.Notifications
Bases: PySide2.QtCore.Q0bject

Holds flags for different error conditions.

duplicate_output_file name
if True there are duplicate output file names

Type bool

missing_output_file_ name
if True the output file name is missing

Type bool

missing parameter_ indexing
if True there are indexed parameters without indexing domains

Type bool

erroneous_database
if True the database has issues

Type bool
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changed_due_to_settings_state
Emitted when notifications have changed due to changes in settings state.

__ioxr__ (self, other)
ORs the flags with another notifications.

Parameters other (Notifications)— a Notifications object

update_settings_state (self, state)
Updates the notifications according to settings state.

spinetoolbox.project_items.exporter.settings_pack

Contains the SettingsPack class.
author
A. Soininen (VTT)
date 6.5.2020

Module Contents

Classes

SettingsPack Keeper of all settings and stuff needed for exporting a
database.

_UnsupportedValueTlTypeLogger

class spinetoolbox.project_items.exporter.settings_pack.SettingsPack (output_file_name)
Bases: PySide2.QtCore.Q0Object

Keeper of all settings and stuff needed for exporting a database.

output_file_ name
name of the export file

Type str

settings
export settings

Type gdx.SetSettings

indexing_settings
parameter indexing settings

Type dict

merging_settings
parameter merging settings

Type dict

none_fallback
fallback for None parameter values

Type NoneFallback
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none_export
how to handle None values while exporting

Type NoneExport

scenario
name of the scenario to export; None for ‘Base’ alternative

Type str

last_database commit
latest database commit time stamp

Type datetime

settings_window
settings editor window

Type GdxExportSettings
Parameters output_file_name (str)—name of the export file
state_changed

Emitted when the pack’s state changes.

state
State of the pack.

to_dict (self)
Stores the settings pack into a JSON compatible dictionary.

static from_dict (pack_dict, database_url, logger)
Restores the settings pack from a dictionary.

class spinetoolbox.project_items.exporter.settings_pack

Bases: PySide2.QtCore.Q0Object
msg

msg_warning

msg_error

relay_ message (self, text)

relay_ warning (self, text)

relay_error (self, text)

spinetoolbox.project_items.exporter.settings_state

Provides the SettingsState enum.
author
A. Soininen (VTT)
date 20.12.2019
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Module Contents

Classes

SettingsState State of export settings.

class spinetoolbox.project_items.exporter.settings_state.SettingsState
Bases: enum.Enum

State of export settings.
Create and return a new object. See help(type) for accurate signature.

OK
Settings OK.

FETCHING
Settings are still being fetched/constructed.

INDEXING_PROBLEM
There is a parameter_value indexing issue.

ERROR
An error prevents the creation of export settings.

spinetoolbox.project_items.exporter.worker

A worker based machinery to construct the settings data structures needed for gdx export outside the UI loop.
author
A. Soininen (VTT)
date 19.12.2019

Module Contents

Classes
Worker A worker to construct export settings for a database.
_Result Contains fetched export settings.
_Logger A LoggerInterface compliant logger that relays

messages to Worker’s signals.

class spinetoolbox.project_items.exporter.worker.Worker (database_url, scenario,

none_fallback)
Bases: PySide2.QtCore.Q0Object

A worker to construct export settings for a database.

thread
the thread the worker executes in

Type QThread
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Parameters

e database_url (str) - database’s URL

* scenario (str, optional) - scenario name or None if ‘Base’ alternative should be

used
* none_fallback (NoneFallback)—how to handle None parameter values
database_unavailable
Emitted when opening the database fails.

errored
Emitted when an error occurs.

finished
Emitted when the worker has finished.

msg
msg_warning
msg_error

_fetch_settings (self)
Constructs settings and parameter index settings.

set_previous_settings (self, previous_settings, previous_indexing_settings,
ous_merging_settings)
Makes worker update existing settings instead of just making new ones.

Parameters
* previous_settings (gdx.SetSettings) — existing set settings
* previous_indexing_settings (dict) — existing indexing settings
* previous_merging_settings (dict) — existing merging settings
static _read_scenarios (database_map)

_read_settings (self)
Reads fresh gdx settings from the database.

_update_indexing_settings (self, updated_settings, new_indexing_settings)
Updates the parameter indexing settings according to changes in the database.

_update_merging_settings (self, updated_settings)
Updates the parameter merging settings according to changes in the database

previ-

class spinetoolbox.project_items.exporter.worker._Result (time_stamp, set_settings,

indexing_settings,

) ) narios)
Contains fetched export settings.

commit_time_stamp
time of the database’s last commit

Type datetime

set_settings
gdx export settings

Type gdx.SetSettings

sce-
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indexing_settings
parameter indexing settings

Type dict

merging_settings
parameter merging settings

Type dict

scenarios
map from scenario name to boolean ‘active’ flag

Type dict

Parameters
* time_stamp (datet ime) — time of the database’s last commit
* set_settings (gdx.SetSettings)— gdx export settings
* indexing_settings (dict) — parameter indexing settings
* scenarios (dict)— map from scenario name to boolean ‘active’ flag
class spinetoolbox.project_items.exporter.worker._Logger (database_url, worker)
Bases: PySide2.QtCore.Q0Object
A LoggerInterface compliant logger that relays messages to Worker’s signals.
Parameters
e database_url (str) - a database url
* worker (Worker) —a worker
msg
msg_warning
msg_error
relay_ message (self, text)
relay_warning (self, text)

relay_ error (self, text)

Package Contents

Classes

ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.exporter.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.

Parameters toolbox (ToolboxUT)—
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item_maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon|()
Returns the icon resource path.

Returns str

static _make_properties_widget (roolbox)
See base class.

class spinetoolbox.project_items.exporter.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

spinetoolbox.project_items.gimlet

Gimlet project item plugin.
author
P. Savolainen (VTT)
date 15.4.2020

Subpackages
spinetoolbox.project_items.gimlet.widgets

Widgets for the Gimlet project item.
author

P. Savolainen (VTT)
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date 15.4.2020

Submodules

spinetoolbox.project_items.gimlet.widgets.add gimlet_widget

Widget shown to user when a new Gimlet is created.
author
P. Savolainen (VTT)
date 15.4.2020

Module Contents

Classes

AddGimletWidget A widget to query user’s preferences for a new item.

class spinetoolbox.project_items.gimlet.widgets.add_gimlet_widget .AddGimletWidget (foolbox,
X,
ys
spec="")
Bases: spinetoolbox.widgets.add _project_item widget.AddProjectItemWidget
A widget to query user’s preferences for a new item.
Parameters
* toolbox (ToolboxUTI) — Parent widget
e x (int) - X coordinate of new item
e y (int)—Y coordinate of new item
* spec (str)— Gimlet specification

call_add_item (self)
Creates new project item according to user’s selections.

spinetoolbox.project_items.gimlet.widgets.custom_menus

Classes for custom context menus and pop-up menus for Gimlets
author
P. Savolainen (VTT)
date 15.4.2020

Module Contents
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Classes

GimletPropertiesContextMenu Context menu class for a Gimlet project item properties.

class spinetoolbox.project_items.gimlet.widgets.custom_menus.GimletPropertiesContextMenu (pc

Bases: spinetoolbox.widgets.custom menus.CustomContextMenu
Context menu class for a Gimlet project item properties.
Parameters
* parent (QWidget) — Parent for menu widget (ToolboxUI)
* position (QPoint)— Position on screen

* index (OModelIndex)— Index of item that requested the context-menu

spinetoolbox.project_items.gimlet.widgets.gimlet_properties_widget

Gimlet properties widget.
author
P. Savolainen (VTT)
date 15.4.2020

Module Contents

Classes

GimletPropertiesWidget Widget for the Gimlet Item Properties.

pC
Si-
tic
in
de

class spinetoolbox.project_items.gimlet.widgets.gimlet_properties_widget.GimletPropertieswW:

Bases: PySide2.QtWidgets.QWidget

Widget for the Gimlet Item Properties.

Parameters toolbox (ToolboxUT) — The toolbox instance where this widget should be embed-

ded

Submodules
spinetoolbox.project_items.gimlet.commands

Undo/redo commands for the Gimlet project item.

authors
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P. Savolainen (VTT)
date 30.4.2020

Module Contents

Classes
UpdateShellCheckBoxCommand Command to update Gimlet shell check box state.
UpdateShellComboboxCommand Command to update Gimlet shell combobox state.
UpdatecmdCommand Command to update Gimlet command line edit.
UpdatelWorkDirModeCommand Command to update Gimlet work_in_dir setting.

class spinetoolbox.project_items.gimlet.commands .UpdateShellCheckBoxCommand (gimlet,

use_shell)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Gimlet shell check box state.
Parameters

* gimlet (spinetoolbox.project_items.gimlet.gimlet.Gimlet) — The
Gimlet issuing the command

e use_shell (bool)— New check box state
redo (self)
undo (self)

class spinetoolbox.project_items.gimlet.commands.UpdateShellComboboxCommand (gimlet,

new_index)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Gimlet shell combobox state.
Parameters

* gimlet (spinetoolbox.project_items.gimlet.gimlet.Gimlet) — The
Gimlet issuing the command

* new_index (int)— New combobox index
redo (self)
undo (self)

class spinetoolbox.project_items.gimlet.commands .UpdatecmdCommand (gimlet, txt)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Gimlet command line edit.
Parameters

* gimlet (spinetoolbox.project_items.gimlet.gimlet.Gimlet) — The
Gimlet issuing the command

* txt (str)— New text in command line edit after editing is finished
redo (self)
undo (self)
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class spinetoolbox.project_items.gimlet.commands .UpdateWorkDirModeCommand (gimlet,

work_dir_mode)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Gimlet work_in_dir setting.
Parameters
* gimlet (Gimlet) — The Gimlet
* work_dir_ mode (bool) - True or False
redo (self)
undo (self)

spinetoolbox.project_items.gimlet.executable_item

Contains Gimlet Executableltem class.
author
P. Savolainen (VTT)
date 15.4.2020

Module Contents

Classes
ExecutableItem The part of a project item that is executed by the Spine
Engine.
Functions
_file paths from resources(resources) Pries file paths from resources.
_database_urls_from resources(resources) Pries database URLs and their providers’ names from
resources.

class spinetoolbox.project_items.gimlet.executable_item.ExecutableItem (name,
log-
ger,
shell,
cmd,
work_dir,
se-

lected_files)
Bases: spinetoolbox.executable item base.ExecutableltemBase, PySide2.QtCore.

QObject
The part of a project item that is executed by the Spine Engine.
Parameters

* name (str)— Project item name
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* logger (LoggerInterface)— Logger instance

* shell (str)— Shell name or empty string if no shell should be used
e emd (11ist)— Command to execute

* work_dir (str) - Full path to work directory

* selected_files (1ist)— List of file paths that were selected

gimlet_finished
Emitted after the Gimlet process has finished.

static item_type ()
Returns Gimlet’s type identifier string.

classmethod from dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.

stop_execution (self)
Stops executing this Gimlet.

_execute_forward (self, resources)
See base class.

Note: resources given here in args is not used. Files to be copied are given by the Gimlet project item
based on user selections made in Gimlet properties.

Parameters resources (11ist) — List of resources from direct predecessor items
Returns True if execution succeeded, False otherwise

_execute_backward (self, resources)
Executes this item in the backward direction.

output_resources_forward (self)
Returns output resources for forward execution.

Returns (list) List of ProjectItemResources.

_output_resources_backward (self)
Returns output resources for backward execution. The default implementation returns an empty list.

Returns (list) List of ProjectItemResources. Just an empty list for now.

_handle_gimlet_process_finished (self, ret_code)
Handles clean up after Gimlet process has finished. After clean up, emits a signal indicating that this
project item execution is done.

_copy_£files (self, files, work_dir)
Copies selected resources (files) to work directory.

Parameters

e files (1ist)— List of full paths to files that will be copied to work dir

* work_dir (str)— Full path to selected work dir
Returns True when files were copied successfully, False when something went wrong
Return type bool

_expand_gimlet_tags (self, cmd, resources)
Returns Gimlet’s command as list with special tags expanded.

Tags that will be replaced:
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* @ @optional_inputs@ @ expands to a space-separated list of Gimlet’s optional input files
* @ @url:<Data Store name>@ @ expands to the URL provided by a named data store
* @@url_inputs@ @ expands to a space-separated list of Gimlet’s input database URLSs

e @ @url_outputs@ @ expands to a space-separated list of Gimlet’s output database URLs

Parameters
* cmd (11ist)— Command that may include tags that should be expanded
* resources (1ist) — List of resources from direct predecessor items
Returns Expanded command
Return type list
spinetoolbox.project_items.gimlet.executable_item._file paths_from resources (resources)
Pries file paths from resources.
Parameters resources (1ist) — a list of ProjectltemResource objects
Returns List of file paths.
Return type list

spinetoolbox.project_items.gimlet.executable_item._database_urls_from_resources (resources)
Pries database URLs and their providers’ names from resources.

Parameters resources (1ist) — a list of ProjectltemResource objects
Returns a mapping from resource provider’s name to a database URL.

Return type dict

spinetoolbox.project_items.gimlet.gimlet

Gimlet class module.
author
P. Savolainen (VTT)
date 15.4.2020

Module Contents

Classes
Gimlet Gimlet class.
class spinetoolbox.project_items.gimlet.gimlet.Gimlet (foolbox, project, log-
ger, name, description,
X, v, use_shell=True,
shell_index=0, cmd=",

selections=None,

work_dir_mode=True)
Bases: spinetoolbox.project_item.ProjectItem
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Gimlet class.

Parameters

toolbox (ToolboxUT)— QMainWindow instance

project (SpineToolboxProject)— Project this item belongs to
logger (LoggerInterface)— Logger instance

name (str)— Project item name

description (str) - Description

x (float) — Initial X coordinate of item icon

y (float) —Initial Y coordinate of item icon

use_shell (bool, optional)- Use shell flag

shell index (int, optional)— Selected shell as index

emd (str, optional)-— Command that this Gimlet executes at run time
selections (I1ist, optional)— Listof selected files in a serialized format

work_dir_mode (bool)—True uses Gimlet’s default work dir, False uses a unique work

dir on every execution

static item_type ()
See base class.

static item_category ()
See base class.

execution_item (self)
Creates project item’s execution counterpart.

_split_gimlet_cmd (self, cmd)
Splits given string command to a list.

Parameters cmd (str)—- Command to execute as a string

Returns Same command as a list

Return type list

make_signal_handler_dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting.

restore_selections (self)
Restores selections into shared widgets when this project item is selected.

save_selections (self)
Saves selections in shared widgets for this project item into instance variables.

shell_checkbox_clicked (self, state)
Pushes a new shell check box command to undo stack. Pushing the command calls the commands redo

method.

Parameters state (str)— New check box state (Qt.CheckState enum)

toggle_shell_state (self, use_shell)

Sets the use shell check box state. Disables shell combobox when shell check box is unchecked.

Parameters use_shell (bool)— New check box state
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shell_combobox_index_changed (self, ind)
Pushes a shell combobox selection changed command to undo stack, which in turn calls
set_shell_combobox_index() below.

Parameters ind (int)— New index in combo box

set_shell_ combobox_index (self, ind)
Sets new index to shell combobox.

Parameters ind (int)— New index in shell combo box

cmd_edited (self)
Updates the command instance variable when user has finished editing text in the line edit.

set_command (self, txt)

_push_file_ selection_change_to_undo_stack (self, selected, label)
Makes changes to file selection undoable.

set_file_selected (self, label, selected)
Handles selecting files in Gimlet file list.

push_work_dir mode_cmd (self, checked)
Pushes a new UpdateWorkDirModeCommand to the undo stack.

update_work_dir mode (self, work_dir_mode)
Updates work_dir_mode setting.

Parameters
* work_dir mode (bool) - If True, work dir is set to this Gimlet’s data dir,

* False, a unique work dir is created for every execution. (IF)

update_work_dir button_state (self)
Sets the work dir radio button check state according to work_dir_mode instance variable.

_do_handle_dag_changed (self, resources)
Saves a copy of ProjectltemResources for handling changes in the DAG on Design View.

See also base class.
Parameters resources (1ist)— ProjectltemResources available from direct predecessors

item_dict (self)
Returns a dictionary corresponding to this item.

notify destination (self, source_item)
See base class.

_notify if duplicate_file_paths (self)
Adds a notification if file list contains duplicate entries.

update_name_label (self)
Updates the name label in Gimlet properties tab. Used only when a project item is renamed.

static default_name prefix()
See base class.

resources_for_direct_successors (self)
Returns resources for direct successors.

This enables communication of resources between project items in the app.

Returns List of ProjectltemResources
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Return type list

spinetoolbox.project_items.gimlet.gimlet_factory

The GimletFactory class.
author
P. Savolainen (VTT)
date 22.4.2020

Module Contents

Classes

GimletFactory Class for project item factories.

class spinetoolbox.project_items.gimlet.gimlet_factory.GimletFactory (toolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —
properties_widget_maker

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_ maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon|()
Returns the icon resource path.

Returns str

static item_type ()
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static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

spinetoolbox.project_items.gimlet.gimlet_icon

Module for Gimlet icon class.
authors
P. Savolainen (VTT)
date 15.4.2020

Module Contents

Classes

GimletIcon Gimlet icon for the Design View.

class spinetoolbox.project_items.gimlet.gimlet_icon.GimletIcon (toolbox, x, Y,
project_item,

icon)
Bases: spinetoolbox.graphics_items.ProjectItemIcon

Gimlet icon for the Design View.
Parameters
¢ toolbox (ToolBoxUI) - QMainWindow instance
e x (float) - Icon x coordinate
* y(float)—Icony coordinate
* project_item (ProjectItem) - Item

* icon (str) - Icon resource path

spinetoolbox.project_items.gimlet.item info

Gimlet project item info.
author
P. Savolainen (VTT)
date 15.5.2020

Module Contents

Classes
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ItemInfo

class spinetoolbox.project_items.gimlet.item_info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

spinetoolbox.project_items.gimlet.utils

Utility constants and functions for the Gimlet package.
author
P. Savolainen (VTT)
date 20.4.2020

Module Contents

spinetoolbox.project_items.gimlet.utils.SHELLS = ['cmd.exe', 'powershell.exe', 'bash']

Package Contents

Classes

ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.gimlet.ItemFactory (toolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT)—
properties_widget_maker

item maker
Returns a ProjectItem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class
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specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str
static item_type ()

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.gimlet.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

spinetoolbox.project_items.importer

Importer plugin.
author
M. Marin (KTH)
date 12.9.2019

Subpackages
spinetoolbox.project_items.importer.widgets

Widgets for the Importer project item.
author A.Soininen (VTT)
date 27.9.2019

Submodules
spinetoolbox.project_items.importer.widgets.add importer_ widget

Widget shown to user when a new Importer is created.

author
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P. Savolainen (VTT)
date 19.1.2017

Module Contents

Classes

AddImporterWidget A widget to query user’s preferences for a new item.

class spinetoolbox.project_items.importer.widgets.add_importer_widget .AddImporterWidget (700
x’
Y,
spe
Bases: spinetoolbox.widgets.add project_item widget.AddProjectItemWidget
A widget to query user’s preferences for a new item.
Parameters
* toolbox (ToolboxUTI) — Parent widget
* x (float)— X coordinate of new item

* y (float)-Y coordinate of new item

call_add_item (self)
Creates new Item according to user’s selections.

spinetoolbox.project_items.importer.widgets.custom _menus

Classes for context menus used alongside the Importer project item.

author
P. Savolainen (VTT)
date 9.1.2018

Module Contents

Classes

FilesContextMenu Context menu class for source files view in Importer

properties tab.

class spinetoolbox.project_items.importer.widgets.custom_menus.FilesContextMenu (parent,
po-
Si-
tion,
in-

dex)

Bases: spinetoolbox.widgets.custom _menus.CustomContextMenu
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Context menu class for source files view in Importer properties tab.
Parameters
* parent (QWidget) — Parent for menu widget (ToolboxUI)
e position (QPoint) — Position on screen

* index (QModelIndex) — Index of item that requested the context-menu

spinetoolbox.project_items.importer.widgets.importer_ properties_widget

Importer properties widget.
author
M. Marin (KTH)
date 12.9.2019

Module Contents

Classes

ImporterPropertiesWidget Widget for the Importer Item Properties.

class spinetoolbox.project_items.importer.widgets.importer_properties_widget.ImporterPrope:
Bases: PySide2.QtWidgets.QWidget

Widget for the Importer Item Properties.

Parameters toolbox (ToolboxUTI) — The toolbox instance where this widget should be embed-
ded

connect_signals (self)
Connect signals to slots.

show_files_context_menu (self, pos)
Create and show a context-menu in Importer properties source files view.

Parameters pos (QPoint)— Mouse position

Submodules
spinetoolbox.project_items.importer.commands

Undo/redo commands for the Importer project item.
authors
M. Marin (KTH)
date 5.5.2020

Module Contents
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Classes

UpdateSettingsCommand Command to update Importer settings.

class spinetoolbox.project_items.importer.commands.UpdateSettingsCommand (importer,

set-
tings,
la-
bel)
Bases: spinetoolbox.project_commands.SpineToolboxCommand
Command to update Importer settings.
Parameters
* importer (spinetoolbox.project_items.importer.importer.
Importer) — the Importer
* settings (dict) — the new settings
* label (str) — settings file label
redo (self)
undo (self)
spinetoolbox.project_items.importer.executable_ item
Contains Importer’s executable item as well as support utilities.
authors
A. Soininen (VTT)
date 1.4.2020
Module Contents
Classes
ExecutablelItem The part of a project item that is executed by the Spine
Engine.
Functions
_files_ from_resources(resources) Returns a list of files available in given resources.
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class spinetoolbox.project_items.importer.executable_item.ExecutableItem (name,
set-
tings,
logs_dir,
gams_path,
can-
cel_on_error,
log-

ger)
Bases: spinetoolbox.executable_item base.ExecutablelItemBase, PySide2.QtCore.

QObject
The part of a project item that is executed by the Spine Engine.
Parameters
* name (str)— Importer’s name
* settings (dict)— import mappings
* logs_dir (str) - path to the directory where logs should be stored

* gams_path (str) — path to system’s GAMS executable or empty string for the default
path

* cancel_on_error (bool) —if True, revert changes on error and quit
* logger (LoggerInterface)—alogger

importing finished
Emitted after import thread has finished.

static item_type()
Returns ImporterExecutable’s type identifier string.

stop_execution (self)
Stops execution.

_execute_backward (self, resources)
See base class.

_execute_forward (self, resources)
See base class.

_handle_worker_finished (self, exit_code)

_destroy_current_worker (self)
Runs before starting execution and after worker finishes. Destroys current worker and quits thread if
present.

_gams_system_directory (self)
Returns GAMS system path or None if GAMS default is to be used.

classmethod from_ dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.

spinetoolbox.project_items.importer.executable_item._files_from_ resources (resources)
Returns a list of files available in given resources.

spinetoolbox.project_items.importer.importer

Contains Importer project item class.
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authors
P. Savolainen (VTT), P. Vennstrom (VTT), A. Soininen (VTT)
date 10.6.2019

Module Contents

Classes
Importer Class for project items that are not category nor root.
Functions
_fix_1d _array_to_array(mappings) Replaces ‘1d array’ with ‘array’ for parameter type in
mappings.
_fix csv_connector_settings(settings) CSVConnector saved the table names as the filepath,
change that

spinetoolbox.project_items.importer.importer._ CONNECTOR_NAME TO_CLASS

class spinetoolbox.project_items.importer.importer.Importer (toolbox, project,
logger, name,
description,  map-

pings, x, y, can-

cel_on_error=True,

map-

ping_selection=None)
Bases: spinetoolbox.project_item.ProjectItem

Class for project items that are not category nor root. These items can be executed, refreshed, and so on.

X
horizontal position in the screen

Type float

y
vertical position in the screen

Type float
Importer class.
Parameters
¢ toolbox (ToolboxUTI) - QMainWindow instance
* project (SpineToolboxProject) — the project this item belongs to
* logger (LoggerInterface) — alogger instance
* name (str)— Project item name
* description (str)— Project item description

* mappings (1ist) — List where each element contains two dicts (path dict and mapping
dict)
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e x (float) — Initial icon scene X coordinate
* y (float)— Initial icon scene Y coordinate

* cancel_on_error (bool, optional) — if True the item’s execution will stop on
import error

* mapping_selection (list, optional) — serialized checked states for each file
item either selected or unselected

static item type ()
See base class.

static item_category ()
See base class.

execution_item (self)
Creates project item’s execution counterpart.

handle_execution_successful (self, execution_direction, engine_state)
Notifies Toolbox of successful database import.

make_signal_handler_ dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting.

_handle_cancel_on_error_changed (self, _state)
set_cancel_on_error (self, cancel_on_error)
set_file_selected (self, label, selected)

restore_selections (self)
Restores selections into shared widgets when this project item is selected.

save_selections (self)
Saves selections in shared widgets for this project item into instance variables.

update_name_label (self)
Update Importer properties tab name label. Used only when renaming project items.

_handle_import_editor_clicked (self, checked=False)
Opens Import editor for the file selected in list view.

_handle_files_double_clicked (self, index)
Opens Import editor for the double clicked index.

open_import_editor (self, index)
Opens Import editor for the given index.

get_connector (self, importee)
Shows a QDialog to select a connector for the given source file. Mimics similar routine in
spine_io.widgets.import_widget.ImportDialog

Parameters importee (str)— Label of the file acting as an importee
Returns Asynchronous data reader class for the given importee

select_connector_type (self, index)
Opens dialog to select connector type for the given index.

_connection_failed (self, msg, importee)

get_settings (self, importee)
Returns the mapping dictionary for the file in given path.
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Parameters importee (str)— Label of the file whose mapping is queried
Returns Mapping dictionary for the requested importee or an empty dict if not found
Return type dict
save_settings (self, settings, importee)
Updates an existing mapping or adds a new mapping (settings) after closing the import preview win-
dow.
Parameters
* settings (dict) - Updated mapping (settings) dictionary
* importee (str)— Absolute path to a file, whose mapping has been updated
_preview_destroyed (self, importee)
Destroys preview widget instance for the given importee.
Parameters importee (str)— Absolute path to a file, whose preview widget is destroyed

_push_file_ selection_change_to_undo_stack (self, selected, label)
Makes changes to file selection undoable.

_do_handle_dag_changed (self, resources)
See base class.

item_dict (self)
Returns a dictionary corresponding to this item.

notify destination (self, source_item)
See base class.

static default_name_prefix()
see base class

tear_down (self)
Closes all preview widgets.

_notify if duplicate_file_paths (self)
Adds a notification if file_list contains duplicate entries.

static upgrade_from_no_version_to_version_1 (item_name, old_item_dict,

old_project_dir)
Converts mappings to a list, where each element contains two dictionaries, the serialized path dictionary
and the mapping dictionary for the file in that path.

static upgrade_vl_to_v2 (item_name, item_dict)
Upgrades item’s dictionary from v1 to v2.

Changes: - if mapping_selection does not exist or if it is a list of booleans, reset mapping_selection to an
empty list.

Parameters

* item_name (str)—item’s name

e item dict (dict)— Version 1 item dictionary
Returns Version 2 Exporter dictionary

Return type dict
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static serialize_mappings (mappings, project_path)
Serializes the importer’s mappings.

Returns a list where each element contains two dictionaries: the ‘serialized’ file label in a dictionary and
the mapping dictionary.

Parameters
* mappings (dict) — Dictionary with mapping specifications
* project_path (str) — Path to project directory

Returns serialized file item labels and mappings

Return type list

_gams_system_directory (self)
Returns GAMS system path from Toolbox settings or None if GAMS default is to be used.

spinetoolbox.project_items.importer.importer._fix 1d_array_to_array (mappings)
Replaces ‘1d array’ with ‘array’ for parameter type in mappings.

With spinedb_api >= 0.3, ‘1d array’ parameter type was replaced by ‘array’. Other settings in a mapping are
backwards compatible except the name.

spinetoolbox.project_items.importer.importer._fix csv_connector_settings (settings)
CSVConnector saved the table names as the filepath, change that to ‘csv’ instead. This function will mutate the
dictionary.

Parameters settings (dict)— Mapping settings that should be updated

spinetoolbox.project_items.importer.importer_factory

The ImporterFactory class.
author
M. Marin (KTH)
date 15.4.2020

Module Contents

Classes

ImporterFactory Class for project item factories.

class spinetoolbox.project_items.importer.importer_factory.ImporterFactory (toolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
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Returns a ProjectItemIcon subclass.
Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_ maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (roolbox)
Creates the item’s properties tab widget.

Returns QWidget

spinetoolbox.project_items.importer.importer_icon

Module for Importer icon class.

authors
M. Marin (KTH), P. Savolainen (VTT)
date 4.4.2018

Module Contents

Classes

ImporterIcon

Importer icon for the Design View.

class spinetoolbox.project_items.importer.importer_icon.ImporterIcon (toolbox,

x3 )’,
project_item,
icon)

Bases: spinetoolbox.graphics_items.ProjectItemIcon

Importer icon for the Design View.

Parameters

* toolbox (ToolBoxUI) - QMainWindow instance

e x (float) - Icon x coordinate

* y(float)-Icony coordinate
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* project_item (ProjectItem)— Item

* icon (str)—icon resource path

spinetoolbox.project_items.importer.importer_ worker

Contains importer_program script.
authors
P. Savolainen (VTT), P. Vennstrom (VTT), A. Soininen (VTT)
date 10.6.2019

Module Contents

Classes

ImporterWorker
param checked_files List of paths to
checked source files

class spinetoolbox.project_items.importer.importer_worker.ImporterWorker (checked_files,
all_import_settings,
all_source_settings,
urls_downstream,
logs_dir,
can-
cel_on_error,
log-
ger)

Bases: PySide2.QtCore.Q0bject
Parameters

* checked_files (list (str))— Listof paths to checked source files
* all_import_settings (dict)— Maps source file to setting for that file
* all_source_settings (dict)— Maps source type to setting for that type
* urls_downstream (list (str))— Listof urls to import data into
* logs_dir (str) — path to the directory where logs should be written
* cancel_on_error (bool) — whether or not to rollback and stop execution if errors
* logger (LoggerInterface)—somewhere to log important messages

import_finished
Emitted when work is finished with O if successful, -1 otherwise.

do_work (self)
Does the work and emits import_finished when done.

_import (self, all_data, url)
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spinetoolbox.project_items.importer.item _info

Importer project item info.
authors
A. Soininen (VTT)
date 29.4.2020

Module Contents

Classes

ItemInfo

class spinetoolbox.project_items.importer.item _info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type()
See base class.

spinetoolbox.project_items.importer.utils

Contains Importer’s utility functions.
authors
A. Soininen (VTT)
date 6.5.2020

Module Contents

Functions

deserialize mappings(mappings, project_path) Returns mapping settings as dict with absolute paths as
keys.

spinetoolbox.project_items.importer.utils.deserialize_mappings (mappings,
project_path)
Returns mapping settings as dict with absolute paths as keys.

Parameters

* mappings (list) — List where each element contains two dictionaries (path dict and
mapping dict)

* project_path (str) — Path to project directory

Returns Dictionary with absolute paths as keys and mapping settings as values

17.1. spinetoolbox 271



Spine Toolbox Documentation, Release 0.5.0-beta.0

Return type dict

Package Contents

Classes

ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.importer.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT)—

item maker
Returns a ProjectItem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.importer.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.
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spinetoolbox.project_items.shared

Submodules

spinetoolbox.project_items.shared.animations

Animation class for the Exporter and Importer items.
authors
M. Marin (KTH)
date 12.11.2019

Module Contents

Classes
ImporterExporterAnimation Initializes animation stuff.
ImporterAnimation Initializes animation stuff.
ExporterAnimation Initializes animation stuff.

class spinetoolbox.project_items.shared.animations.ImporterExporterAnimation (item,

du-
ra-
tion=2000,
count=>5,
per-
cent-
age_size=0.24,
x_shift=0)
Initializes animation stuff.
Parameters item (OGraphicsItem)— The item on top of which the animation should play.
_handle_time_line_value_changed (self, value)
_handle_ time_line_state_changed (self, new_state)
start (self)
Starts the animation.
static percent (value)
stop (self)
Stops the animation
class spinetoolbox.project_items.shared.animations.ImporterAnimation (ifem,
dura-
tion=2000,
count=>5,
per-
cent-
age_size=0.24,
x_shift=0)

Bases: spinetoolbox.project_items.shared.animations.ImporterExporterAnimation
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Initializes animation stuff.
Parameters item (OGraphicsItem)— The item on top of which the animation should play.
static percent (value)

class spinetoolbox.project_items.shared.animations.ExporterAnimation (item,
dura-
tion=2000,
count=3,
per-
cent-
age_size=0.24,
x_shift=0)

Bases: spinetoolbox.project_items.shared.animations.ImporterExporterAnimation

Initializes animation stuff.

Parameters item (0GraphicsItem)— The item on top of which the animation should play.

static percent (value)

spinetoolbox.project_items.shared.commands

Undo/redo commands that can be used by multiple project items.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 5.5.2020

Module Contents

Classes
UpdateCancelOnErrorCommand Command to update Importer, Exporter, and Combiner
cancel on error setting.
ChangeItemSelectionCommand Command to change file item’s selection status.

class spinetoolbox.project_items.shared.commands .UpdateCancelOnErrorCommand (project_item,
can-

cel_on_error)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Importer, Exporter, and Combiner cancel on error setting.
Parameters
* project_item (ProjectItem)—Item
* cancel_on_error (bool)— New setting
redo (self)
undo (self)
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class spinetoolbox.project_items.shared.commands.ChangeItemSelectionCommand (project_item,

se-

lected,

la-

bel)

Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to change file item’s selection status. Used by Importers and Gimlets.

Parameters

* project_item (ProjectItem)— Item

¢ selected (bool) — True if the item is selected, False otherwise

* label (str) - File label
redo (self)
undo (self)

spinetoolbox.project_items.shared.helpers

Helper functions and classes.
authors
M. Marin (KTH)
date 12.5.2020

Module Contents

Classes

CmdlineTag

Functions

create_log_file_timestamp()

Creates a new timestamp string that is used as Combiner
and Importer error log file.

serialize checked_states(files, project_path)

Serializes file paths and adds a boolean value

deserialize checked states(serialized,
project_path)

Reverse operation for serialize_checked_states above.

split_cmdline args(arg_string)

Splits a string of command line into a list of tokens.

expand_tags(args, optional_input_files, input_urls,
output_urls)

EX)

spinetoolbox.project_items.shared.helpers.CMDLINE_TAG_EDGE = @@

class spinetoolbox.project_items.shared.helpers.CmdlineTag

URL

URL_INPUTS
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URL_OUTPUTS
OPTIONAL_INPUTS

spinetoolbox.project_items.shared.helpers.create_log file_ timestamp ()
Creates a new timestamp string that is used as Combiner and Importer error log file.

Returns Timestamp string or empty string if failed.

spinetoolbox.project_items.shared.helpers.serialize_checked_states (files,
project_path)
Serializes file paths and adds a boolean value for each, which indicates whether the path is selected or not. Used
in saving checked file states to project.json.

Parameters

* files (1ist)— List of absolute file paths

* project_path (str)— Absolute project directory path
Returns List of serialized paths with a boolean value
Return type list

spinetoolbox.project_items.shared.helpers.deserialize_checked_states (serialized,

project_path)
Reverse operation for serialize_checked_states above. Returns absolute file paths with their check state as
boolean.
Parameters

* serialized (1ist) - List of serialized paths with a boolean value
* project_path (str)— Absolute project directory path
Returns Dictionary with paths as keys and boolean check states as value
Return type dict

spinetoolbox.project_items.shared.helpers.split_cmdline_args (arg_string)
Splits a string of command line into a list of tokens.

o

Things in single (**) and double (*’) quotes are kept as single tokens while the quotes themselves are stripped
away. Thus, —file="a long quoted ‘file’ name.txt becomes [“—file=a long quoted ‘file’ name.txt”]

Parameters arg_string (str) - command line arguments as a string
Returns a list of tokens
Return type list

spinetoolbox.project_items.shared.helpers.expand_tags (args, optional_input_files, in-

put_urls, output_urls)
” Expands first @ @ tags found in given list of command line arguments.

Parameters
* args (1ist)—alist of command line arguments
* optional_input_files (1ist)— alist of Tool’s optional input file names

* input_urls (dict) — a mapping from URL provider (input Data Store name) to URL
string

* output_urls (dict)—amapping from URL provider (output Data Store name) to URL
string

Returns
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a boolean flag, if True, indicates that tags were expanded and a list of expanded command
line arguments

Return type tuple

spinetoolbox.project_items.shared.models

Contains a generic File list model and an Item for that model. Used by the Importer project item but this may be handy
for other project items as well.

authors
P. Savolainen (VTT), P. Vennstrom (VTT), A. Soininen (VTT)
date 5.6.2020

Module Contents

Classes

FileListItem An item for FileListModel.

FileListModel A model for files to be shown in a file list view.
Functions

_file label(resource) Picks a label for given file resource.

spinetoolbox.project_items.shared.models._file_label (resource)
Picks a label for given file resource.

class spinetoolbox.project_items.shared.models.FileListItem (label, path,
provider_name,

is_pattern="False)
An item for FileListModel.

Parameters

* label (str) — File label; a full path for ‘permanent’ files or just the basename for ‘tran-
sient’ files like Tool’s output.

* path (str)— Absolute path to the file, empty if not known

* provider_name (str)— Name of the project item providing the file

* is_pattern (bool) — True if the file is actually a file name pattern
Initialize self. See help(type(self)) for accurate signature.

classmethod from_ resource (cls, resource)
Constructs a FileListltem from ProjectltemResource.

Parameters resource (ProjectItemResource)— Resource
Returns An item based on given resource

Return type FileListltem
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Raises RuntimeError — If given resource has an unknown type

exists (self)
Returns True if the file exists, False otherwise.

update (self, resource)
Updates item information.

Parameters resource (ProjectItemResource)— A fresh file resource

class spinetoolbox.project_items.shared.models.FileListModel
Bases: PySide2.QtCore.QAbstractListModel

A model for files to be shown in a file list view. Used by Importer.

selected_state_changed
Emitted when a file check box state changes.

files
All model’s file items.

data (self, index, role=Qt.DisplayRole)
Returns data associated with given role at given index.

flags (self, index)
Returns item’s flags.

headerData (self, section, orientation, role=Qt.DisplayRole)
Returns header information.

find_file (self, label)
Returns a file item with given label.

labels (self)
Returns a list of file labels.

mark_as_nonexistent (self, index)
Marks item at given index as non-existing.

update (self, resources)
Updates the model according to given list of resources.

rowCount (self, parent=QModellndex())
Returns the number of rows in the model.

set_selected (self, label, selected)
Changes the given item’s selection status.

Parameters
* label (str)—item’s label
¢ selected (bool) - True to select the item, False to deselect

setData (self, index, value, role=Qt.EditRole)
Sets data in the model.

set_initial_state (self, selected_items)
Fills model with incomplete data; needs a call to update () to make the model usable.

spinetoolbox.project_items.tool

Tool plugin.
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author
M. Marin (KTH)
date 12.9.2019

Subpackages
spinetoolbox.project_items.tool.widgets

Widgets for the Tool project icon.
author A.Soininen (VTT)
date 27.9.2019

Submodules
spinetoolbox.project_items.tool.widgets.add_tool_widget

Widget shown to user when a new Tool is created.
author
P. Savolainen (VTT)
date 19.1.2017

Module Contents

Classes

AddToolWidget A widget that queries user’s preferences for a new item.

class spinetoolbox.project_items.tool.widgets.add_tool_widget .AddToolWidget (foolbox,
X,
ya
spec="")
Bases: spinetoolbox.widgets.add project_item widget.AddProjectItemWidget
A widget that queries user’s preferences for a new item.

toolbox
Parent widget

Type ToolboxUI

X coordinate of new item
Type int

y
Y coordinate of new item

Type int
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spec
Tool specification

Type str
Initialize class.

call_add_item (self)
Creates new Item according to user’s selections.

spinetoolbox.project_items.tool.widgets.custom_menus

Classes for custom context menus and pop-up menus.
author
P. Savolainen (VTT)
date 9.1.2018

Module Contents

Classes

ToolPropertiesContextMenu Common context menu class for all Tool QTreeViews
in Tool properties.

ToolContextMenu Context menu for Tools in the QTreeView and in the
QGraphicsView.

ToolSpecificationMenu Context menu class for Tool specifications.

AddIncludesPopupMenu Popup menu class for add includes button in Tool spec-
ification editor widget.

CreateMainProgramPopupMenu Popup menu class for add main program QToolButton

in Tool specification editor widget.

class spinetoolbox.project_items.tool.widgets.custom_menus.ToolPropertiesContextMenu (parent,

po-
Si-
tion,
in-
dex)

Bases: spinetoolbox.widgets.custom menus.CustomContextMenu

Common context menu class for all Tool QTreeViews in Tool properties.

parent
Parent for menu widget (ToolboxUI)

Type QWidget

position
Position on screen

Type QPoint

index
Index of item that requested the context-menu

280 Chapter 17. API Reference



Spine Toolbox Documentation, Release 0.5.0-beta.0

Type QModellndex
Class constructor.

class spinetoolbox.project_items.tool.widgets.custom_menus.ToolContextMenu (parent,
tool,

po-
Si-
tion)
Bases: spinetoolbox.widgets.custom menus.ProjectItemContextMenu
Context menu for Tools in the QTreeView and in the QGraphicsView.

parent
Parent for menu widget (ToolboxUT)

Type QWidget

position
Position on screen

Type QPoint
Class constructor.

class spinetoolbox.project_items.tool.widgets.custom_menus.ToolSpecificationMenu (parent,
in-

dex)

Bases: spinetoolbox.widgets.custom _menus.ItemSpecificationMenu
Context menu class for Tool specifications.
Parameters
* parent (QWidget) — Parent for menu widget (ToolboxUI)
* index (OModelIndex) — the index from specification model
open_main_program file (self)
open_main_program_ dir (self)

class spinetoolbox.project_items.tool.widgets.custom_menus.AddIncludesPopupMenu (parent)
Bases: spinetoolbox.widgets.custom menus.CustomPopupMenu

Popup menu class for add includes button in Tool specification editor widget.
Parameters parent (OWidget) — Parent widget (ToolSpecificationWidget)

class spinetoolbox.project_items.tool.widgets.custom_menus.CreateMainProgramPopupMenu (parent
Bases: spinetoolbox.widgets.custom menus.CustomPopupMenu

Popup menu class for add main program QToolButton in Tool specification editor widget.

Parameters parent (OWidget) — Parent widget (ToolSpecificationWidget)

spinetoolbox.project_items.tool.widgets.tool_properties_widget

Tool properties widget.
author
M. Marin (KTH)
date 12.9.2019
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Module Contents

Classes

ToolPropertiesWidget Widget for the Tool Item Properties.

class spinetoolbox.project_items.tool.widgets.tool_properties_widget.ToolPropertiesWidget (i
Bases: PySide2.QtWidgets.QWidget

Widget for the Tool Item Properties.

Parameters toolbox (ToolboxUTI) — The toolbox instance where this widget should be embed-
ded

Init class.

connect_signals (self)
Connect signals to slots.

update_combo_box_tool_model (self)

show_tool_properties_context_menu (self, pos)
Create and show a context-menu in Tool properties if selected Tool has a Tool specification.

Parameters pos (QPoint)— Mouse position

spinetoolbox.project_items.tool.widgets.tool_specification_widget

QWidget that is used to create or edit Tool specifications. In the former case it is presented empty, but in the latter it is
filled with all the information from the specification being edited.

author
M. Marin (KTH), P. Savolainen (VTT)
date 12.4.2018

Module Contents

Classes

ToolSpecificationWidget A widget to query user’s preferences for a new tool
specification.

class spinetoolbox.project_items.tool.widgets.tool_specification_widget.ToolSpecificationW:

Bases: PySide2.QtWidgets.QWidget
A widget to query user’s preferences for a new tool specification.

Parameters
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* toolbox (ToolboxUT) - QMainWindow instance

* specification (ToolSpecification) — If given, the form is pre-filled with this
specification

connect_signals (self)
Connect signals to slots.

populate_sourcefile_list (self, items)
List source files in QTreeView. If items is None or empty list, model is cleared.

populate_inputfiles_list (self, items)
List input files in QTreeView. If items is None or empty list, model is cleared.

populate_inputfiles_opt_1list (self, items)
List optional input files in QTreeView. If items is None or empty list, model is cleared.

populate_outputfiles_1list (self, items)
List output files in QTreeView. If items is None or empty list, model is cleared.

browse_main_program (self, checked=False)
Open file browser where user can select the path of the main program file.

set_main_program_path (self, file_path)
Set main program file and folder path.

new_main_program_file (self)
Creates a new blank main program file. Let’s user decide the file name and path. Alternative version using
only one getSaveFileName dialog.

new_source_file (self)
Let user create a new source file for this tool specification.

show_add_source_files_dialog (self, checked=False)
Let user select source files for this tool specification.

show_add_source_dirs_dialog (self, checked=False)
Let user select a source directory for this tool specification. All files and sub-directories will be added to
the source files.

add_dropped_includes (self, file_paths)
Adds dropped file paths to Source files list.

add_single_include (self, path)
Add file path to Source files list.

open_includes_file (self, index)
Open source file in default program.

remove_source_files_with_del (self)
Support for deleting items with the Delete key.

remove_source_files (self, checked=False)
Remove selected source files from include list. Do not remove anything if there are no items selected.

add_inputfiles (self, checked=False)
Let user select input files for this tool specification.

remove_inputfiles_with_del (self)
Support for deleting items with the Delete key.

remove_inputfiles (self, checked=False)
Remove selected input files from list. Do not remove anything if there are no items selected.
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add_inputfiles_opt (self, checked=False)
Let user select optional input files for this tool specification.

remove_inputfiles_opt_with_del (self)
Support for deleting items with the Delete key.

remove_inputfiles_opt (self, checked=False)
Remove selected optional input files from list. Do not remove anything if there are no items selected.

add_outputfiles (self, checked=False)
Let user select output files for this tool specification.

remove_outputfiles_with_del (self)
Support for deleting items with the Delete key.

remove_outputfiles (self, checked=False)
Remove selected output files from list. Do not remove anything if there are no items selected.

handle_ok_clicked (self)
Checks that everything is valid, creates Tool spec definition dictionary and adds Tool spec to project.

_make_tool_specification (self, def_path)
Returns a ToolSpecification from current form settings.

Parameters def path (str) — path to definition .json file
Returns ToolSpecification

call_add_tool_specification (self)

Adds or updates Tool specification according to user’s selections. If the name is the same as an existing
tool specification, it is updated and auto-saved to the definition file. (User is editing an existing tool
specification.) If the name is not in the tool specification model, creates a new tool specification and offers
to save the definition file. (User is creating a new tool specification from scratch or spawning from an

existing one).

keyPressEvent (self, ¢)
Close Setup form when escape key is pressed.

Parameters e (OKeyEvent) — Received key press event.

closeEvent (self, event=None)
Handle close window.

Parameters event (QEvent) — Closing event if ‘X’ is clicked.

_make_add_cmdline_tag_menu (self)
Constructs a popup menu for the ‘@ @’ button.

_insert_spaces_around_tag_in_args_edit (self, tag_length, re-

store_cursor_to_tag_end=False)
Inserts spaces before/after @ @ around cursor position/selection

Expects cursor to be at the end of the tag.

_add_cmdline_tag_url_inputs (self, )
Inserts @ @url_inputs@ @ tag to command line arguments.

_add_cmdline_tag url_outputs (self, )
Inserts @ @url_outputs@ @ tag to command line arguments.

_add_cmdline_tag _data_store_url (self, )

Inserts @ @url:<data-store-name>@ @ tag to command line arguments and selects ‘<data-store-name>’.

_add_cmdline_tag optional_inputs (self, _)
Inserts @ @optional_inputs@ @ tag to command line arguments.
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Submodules

spinetoolbox.project_items.tool.commands

Undo/redo commands for the Tool project item.
authors
M. Marin (KTH)
date 5.5.2020

Module Contents

Classes
UpdateToolExecuteInWorkCommand Command to update Tool execute_in_work setting.
UpdateToolCmdLineArgsCommand Command to update Tool command line args.

class spinetoolbox.project_items.tool.commands.UpdateToolExecuteInWorkCommand (f0ool,
ex-
e_
cute_in_work)
Bases: spinetoolbox.project_commands.SpineToolboxCommand
Command to update Tool execute_in_work setting.
Parameters
¢ tool (Tool) —the Tool
e execute_in_work (bool) — True or False
redo (self)
undo (self)

class spinetoolbox.project_items.tool.commands.UpdateToolCmdLineArgsCommand (fool,
cmd_line_args)
Bases: spinetoolbox.project_commands.SpineToolboxCommand

Command to update Tool command line args.
Parameters
¢ tool (Tool) — the Tool
* cmd_1line_args (1ist)— list of str args
redo (self)
undo (self)

spinetoolbox.project_items.tool.executable_item

Contains Tool’s executable item and support functionality.

authors
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A. Soininen (VTT)
date 30.3.2020

Module Contents

Classes
Executableltem Tool project item’s executable parts.
_ExecutionToken A token that acts as a callback after the tool process has
finished execution.
Functions
_count_files_and_dirs(paths) Counts the number of files and directories in given
paths.
_create output_dir_ timestamp() Creates a new timestamp string that is used as Tool out-
put
_database_urls_from resources(resources) Pries database URLs and their providers’ names from
resources.
_execution_directory(work_dir, Returns the path to the execution directory, depending
tool_specification) on execute_in_work.
_find_files_in_pattern(pattern, avail- Returns a list of files that match the given pattern.
able_file_paths)
_unique_dir_name(tool_specification) Builds a unique name for Tool’s work directory.

class spinetoolbox.project_items.tool.executable_item.ExecutableItem (name,
work_dir,
out-
put_dir,
tool_specification,
cmd_line_args,
log-

ger)
Bases: spinetoolbox.executable item base.ExecutableltemBase

Tool project item’s executable parts.
Parameters
* name (str)—item’s name

* work_dir (str)— an absolute path to Spine Toolbox work directory or None if the Tool
should not execute in work directory

* output_dir (str) - path to the directory where output files should be archived

* tool_specification (ToolSpecification)— atool specification

* emd_1line_args (1ist)— alist of command line argument to pass to the tool instance
* logger (LoggerInterface)—alogger

static item_type ()
Returns the item’s type identifier string.
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execution_finished (self, execution_token, return_code, execution_dir)
Handles things after execution has finished.

stop_execution (self)
Stops executing this Tool.

_copy_input_files (self, paths, execution_dir)
Copies input files from given paths to work or source directory, depending on where the Tool specification
requires them to be.

Parameters
* paths (dict) —key is path to destination file, value is path to source file
* execution_dir (str)— absolute path to the execution directory
Returns True if the operation was successful, False otherwise
Return type bool

_copy_optional_input_files (self, paths)
Copies optional input files from given paths to work or source directory, depending on where the Tool
specification requires them to be.

Parameters paths (dict) —key is the source path, value is the destination path

_copy_output_files (self, target_dir, execution_dir)
Copies Tool specification output files from work directory to given target directory.

Parameters
* target_dir (str)— Destination directory for Tool specification output files
e execution_dir (str)— path to the execution directory

Returns Contains two lists. The first list contains paths to successfully copied files. The second
list contains paths (or patterns) of Tool specification output files that were not found.

Return type tuple
Raises OSError — If creating a directory fails.

_copy_program_files (self, execution_dir)
Copies Tool specification source files to base directory.

_create_input_dirs (self, execution_dir)
Iterates items in required input files and check if there are any directories to create. Create found directories
directly to work or source directory.

Parameters execution_dir (str) — the execution directory

Returns True if the operation was successful, False otherwiseBoolean variable depending on
success

Return type bool

_create_output_dirs (self, execution_dir)
Makes sure that work directory has the necessary output directories for Tool output files. Checks only
“outputfiles” list. Alternatively you can add directories to “inputfiles” list in the tool definition file.

Parameters execution_dir (str)— a path to the execution directory
Returns True for success, False otherwise.
Return type bool

Raises OSError — If creating an output directory to work fails.
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_execute_backward (self, resources)
Stores resources for forward execution.

_execute_forward (self, resources)
Executes the Tool according to the Tool specification.

Before launching the tool script in a separate instance, prepares the execution environment by creating all
necessary directories and copying input files where needed. After execution archives the output files.

Parameters resources (11ist) — alist of resources from direct predecessor items
Returns True if execution succeeded, False otherwise

_find_input_files (self, resources)
Iterates required input files in tool specification and looks for them in the given resources.

Parameters resources (1ist) - resources available
Returns Dictionary mapping required files to path where they are found, or to None if not found

_find optional_input_f£files (self, resources)
Tries to find optional input files from previous project items in the DAG.

Parameters resources (11ist) - resources available
Returns

Dictionary of optional input file paths or an empty dictionary if no files found. Key is the
optional input item and value is a list of paths that matches the item.

Return type dict

_handle_ output_files (self, return_code, execution_dir)
Copies Tool specification output files from work directory to result directory.

Parameters
* return_code (int) - Tool specification process return value
e execution_dir (str)— path to the execution directory

_optional_output_destination_paths (self, paths, execution_dir)
Returns a dictionary telling where optional output files should be copied to before execution.

Parameters

* paths (dict) — key is the optional file name pattern, value is a list of paths to source
files

* execution_dir (str)—apath to the execution directory
Returns a map from source path to destination path
Return type dict

_output_resources_forward (self)
Returns a list of resources, i.e. the output files produced by the tool.

Returns the files that were actually created during the execution. The URL points to the archive directory.
Returns a list of Tool’s output resources
Return type list

classmethod from dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.
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spinetoolbox.project_items.tool.executable_item._count_files_and_dirs (paths)
Counts the number of files and directories in given paths.

Parameters paths (1ist) - list of paths
Returns Tuple containing the number of required files and directories.

spinetoolbox.project_items.tool.executable_item._create_output_dir timestamp ()
Creates a new timestamp string that is used as Tool output directory.

Returns Timestamp string or empty string if failed.

spinetoolbox.project_items.tool.executable_item._database_urls_from resources (resources)
Pries database URLs and their providers’ names from resources.

Parameters resources (1ist) — a list of ProjectltemResource objects
Returns a mapping from resource provider’s name to a database URL.
Return type dict

spinetoolbox.project_items.tool.executable_item._execution_directory (work_dir,

tool_specification)
Returns the path to the execution directory, depending on execute_in_work.

If execute_in_work is True, a new unique path will be returned. Otherwise, the main program file path
from tool specification is returned.

Returns a full path to next basedir
Return type str

spinetoolbox.project_items.tool.executable_item._find files_in_pattern (pattern,
avail-

able_file_paths)
Returns a list of files that match the given pattern.

Parameters

* pattern (str)—file pattern

* available_ file_paths (1ist) - list of available file paths from upstream items
Returns List of (full) paths
Return type list

spinetoolbox.project_items.tool.executable_item._unique_dir_name (tool_specification)
Builds a unique name for Tool’s work directory.

class spinetoolbox.project_items.tool.executable_item._ExecutionToken (tool_executable,

exe-
cu-
) ) tion_dir)
A token that acts as a callback after the tool process has finished execution.
Parameters
* tool_executable (spinetoolbox.project_items.tool.

executable_item.ExecutableItem) - the object that has initiated the execution
* execution_dir (str)— absolute path to the execution working directory

handle_execution_finished (self, return_code)
Handles Tool specification execution finished.

Parameters return_code (int)— Process exit code
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spinetoolbox.project_items.tool.item_info

Tool project item info.
authors
A. Soininen (VTT)
date 29.4.2020

Module Contents

Classes

ItemInfo

class spinetoolbox.project_items.tool.item_info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type ()
See base class.

spinetoolbox.project_items.tool.specification_factory

Tool’s specification factory.
authors
A. Soininen (VTT)
date 6.5.2020

Module Contents

Classes

SpecificationFactory A factory to make tool specifications.

class spinetoolbox.project_items.tool.specification_factory.SpecificationFactory
Bases: spinetoolbox.project_item specification_ factory.
ProjectItemSpecificationFactory

A factory to make tool specifications.

static item type ()
See base class.

static make_specification (definition, definition_path, app_settings, logger, embed-

ded_julia_console, embedded_python_console)
Returns a tool specifications.
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spinetoolbox.project_items.tool.tool

Tool class.
author
P. Savolainen (VTT)
date 19.12.2017

Module Contents

Classes

Tool Class for project items that are not category nor root.

class spinetoolbox.project_items.tool.tool.Tool (foolbox, project, logger, name,
description, X, Y, specifica-
tion=", execute_in_work=True,

cmd_line_args=None)
Bases: spinetoolbox.project_item.ProjectItem

Class for project items that are not category nor root. These items can be executed, refreshed, and so on.

X
horizontal position in the screen
Type float
y
vertical position in the screen
Type float
Tool class.
Parameters

* toolbox (ToolboxUT) - QMainWindow instance

* project (SpineToolboxProject) — the project this item belongs to
* logger (LoggerInterface)— alogger instance

* name (str)— Object name

* description (str)— Object description

* x (float) — Initial X coordinate of item icon

e y(float) - Initial Y coordinate of item icon

* specification (str)— Tool specification name

* execute_in_work (bool) — Execute associated Tool specification in work (True) or
source directory (False)

* emd_line_args (1ist)— Tool command line arguments

static item_type()
See base class.
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static item_category ()
See base class.

make_signal_handler_ dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting.

restore_selections (self)
Restore selections into shared widgets when this project item is selected.

update_execution_mode (self, checked)
Pushes a new UpdateToolExecuteInWorkCommand to the toolbox stack.

do_update_execution_mode (self, execute_in_work)
Updates execute_in_work setting.

update_execute_in_work button (self)
Sets the execute in work radio button check state according to execute_in_work instance variable.

update_specification (self, text)
Update Tool specification according to selection in the specification comboBox.

Parameters text (str) - Tool specification name in the comboBox

tool_args_text_edited (self, txt)
Calls the editingFinished slot when the line edit is cleared. Needed in order to clear the cmd line args list
in case the line edit clear button is clicked.

Parameters txt (str)-— Text in line edit after edit

tool_args_editing_finished (self)
Processed when the user has finished editing the cmd line args line edit. Pushes a new command to undo
stack if the args were changed.

update_tool_cmd line_args (self, cmd_line_args)
Updates instance cmd line args list and sets the list as text to the line edit widget.

Parameters cmd_line_args (1ist)— Tool cmd line args

do_set_specification (self, specification)
Sets Tool specification for this Tool. Removes Tool specification if None given as argument.

Parameters specification (ToolSpecification) — Tool specification of this Tool.
None removes the specification.

undo_set_specification (self)

update_tool_ui (self)
Updates Tool UI to show Tool specification details. Used when Tool specification is changed. Overrides
execution mode (work or source) with the specification default.

update_tool_models (self)
Update Tool models with Tool specification details. Used when Tool specification is changed. Overrides
execution mode (work or source) with the specification default.

open_results (self, checked=False)
Open output directory in file browser.

edit_specification (self)
Open Tool specification editor for the Tool specification attached to this Tool.

open_specification_file (self)
Open Tool specification file.
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open_main_program_file (self)
Open Tool specification main program file in an external text edit application.

open_main_directory (self)
Open directory where the Tool specification main program is located in file explorer.

specification (self)
Returns Tool specification.

populate_source_file_model (self, items)
Add required source files (includes) into a model. If items is None or an empty list, model is cleared.

populate_input_file_model (self, items)
Add required Tool input files into a model. If items is None or an empty list, model is cleared.

populate_opt_input_file_model (self, items)
Add optional Tool specification files into a model. If items is None or an empty list, model is cleared.

populate_output_file_model (self, items)
Add Tool output files into a model. If items is None or an empty list, model is cleared.

populate_specification_model (self, populate)
Add all tool specifications to a single QTreeView.

Parameters populate (bool)— False to clear model, True to populate.

update_name_label (self)
Update Tool tab name label. Used only when renaming project items.

resources_for_direct_successors (self)
Returns a list of resources, i.e. the outputs defined by the tool specification.

The output files are available only after tool has been executed, therefore the resource type is ‘transient_file’
or ‘file_pattern’. A ‘file_pattern’ type resource is returned only if the pattern doesn’t match any output file.
For ‘transient_file’ resources, the url attribute is set to an empty string if the file doesn’t exist yet or it
points to a file from most recent execution. The metadata attribute’s label key gives the base name or file
pattern of the output file.

Returns a list of Tool’s output resources
Return type list

execution_item (self)
Creates project item’s execution counterpart.

_find_input_files (self, resources)
Iterates files in required input files model and looks for them in the given resources.

Parameters resources (11ist) - resources available
Returns Dictionary mapping required files to path where they are found, or to None if not found

_do_handle_dag_changed (self, resources)
See base class.

item_dict (self)
Returns a dictionary corresponding to this item.

custom_context_menu (self, parent, pos)
Returns the context menu for this item.

Parameters

* parent (QWidget)— The widget that is controlling the menu
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* pos (QPoint) — Position on screen

apply_context_menu_action (self, parent, action)

Applies given action from context menu. Implement in subclasses as needed.

Parameters

* parent (OWidget) — The widget that is controlling the menu

e action (str) - The selected action

rename (self, new_name)
Rename this item.

Parameters new_name (str)— New name
Returns Boolean value depending on success
Return type bool

notify destination (self, source_item)
See base class.

static default_name_prefix ()
see base class

static _file_path_duplicates (file_paths)
Returns a list of lists of duplicate items in file_paths.

_notify if duplicate_file_paths (self, duplicates)
Adds a notification if duplicates contains items.

static upgrade_vl_to_v2 (item_name, item_dict)
Upgrades item’s dictionary from v1 to v2.

Changes: - ‘tool’ key is renamed to ‘specification’
Parameters
e item_ name (str)—item’s name
e item dict (dict)— Version 1 item dictionary
Returns Version 2 Tool dictionary

Return type dict

spinetoolbox.project_items.tool.tool_factory

The ToolFactory class.
author
M. Marin (KTH)
date 15.4.2020

Module Contents

Classes
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ToolFactory Class for project item factories.

class spinetoolbox.project_items.tool.tool_factory.ToolFactory (toolbox)

Bases: spinetoolbox.project_item.ProjectItemFactory
Class for project item factories.
Parameters toolbox (ToolboxUT) —

item_ maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static supports_specifications ()
Returns whether or not this factory supports specs.

If the subclass implementation returns  True, then it  must
specification_form_maker, and specification_menu_maker.

Returns bool

static _make_ properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

spinetoolbox.project_items.tool.tool_icon

Module for tool icon class.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 4.4.2018

also

implement
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Module Contents

Classes
ToolIcon Tool icon for the Design View.
class spinetoolbox.project_items.tool.tool_icon.ToolIcon (toolbox, X, Y,

project_item, icon)
Bases: spinetoolbox.graphics_items.ProjectItemIcon

Tool icon for the Design View.
Parameters
* toolbox (ToolBoxUI) - QMainWindow instance
* x (float) - Icon x coordinate
* y(float)-Icony coordinate
* project_item (ProjectItem)—Item
* icon (str)—icon resource path
_handle time_line_ value_changed (self, value)
_handle_time_line_state_changed (self, new_state)

start_animation (self)
Starts the item execution animation.

stop_animation (self)
Stop animation

spinetoolbox.project_items.tool.tool_instance

Contains Toollnstance class.
authors
P. Savolainen (VTT), E. Rinne (VTT)
date 1.2.2018

Module Contents

Classes
ToolInstance Tool instance base class.
GAMSToolInstance Class for GAMS Tool instances.
JuliaToolInstance Class for Julia Tool instances.
PythonToolInstance Class for Python Tool instances.
ExecutableToolInstance Class for Executable Tool instances.
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class spinetoolbox.project_items.tool.tool_instance.ToolInstance (tool_specification,
basedir,
settings,
logger)
Bases: PySide2.QtCore.Q0Object

Tool instance base class.
Parameters

* tool_specification (ToolSpecification) — the tool specification for this in-
stance

* basedir (str) — the path to the directory where this instance should run
* settings (0Settings)— Toolbox settings
* logger (LoggerInterface)—alogger instance

instance_finished
Signal to emit when a Tool instance has finished processing

is_running (self)

terminate_instance (self)
Terminates Tool instance execution.

remove (self)
[Obsolete] Removes Tool instance files from work directory.

prepare (self, optional_input_files, input_database_urls, output_database_urls, tool_args)
Prepares this instance for execution.

Implement in subclasses to perform specific initialization.
Parameters
* optional_input_files (1ist) - listof tool’s optional input files

e input_database_urls (dict) — a mapping from upstream Data Store name to
database URL

* output_database_urls (dict)— a mapping from downstream Data Store name to
database URL

* tool_args (list)—Tool cmd line args

execute (self, **kwargs)
Executes a prepared instance. Implement in subclasses.

handle_execution_finished (self, ret)
Handles execution finished.

Parameters ret (int) -

append_cmdline_args (self, optional_input_files, input_database_urls, output_database_urls,

tool_args)
Appends Tool specification command line args into instance args list.

Parameters
* optional_ input_files (1ist) - listof tool’s optional input files

* input_database_urls (dict) — a mapping from upstream Data Store name to
database URL
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* output_database_urls (dict)— a mapping from downstream Data Store name to
database URL

* tool_args (1ist)—List of Tool cmd line args

class spinetoolbox.project_items.tool.tool_instance.GAMSToolInstance (fool_specification,

basedir,
set-
tings,
log-
ger)

Bases: spinetoolbox.project_items.tool.tool_instance.ToolInstance

Class for GAMS Tool instances.

Parameters

* tool_specification (ToolSpecification) — the tool specification for this in-
stance

* basedir (str) — the path to the directory where this instance should run
* settings (0Settings)— Toolbox settings
* logger (LoggerInterface)—alogger instance

prepare (self, optional_input_files, input_database_urls, output_database_urls, tool_args)
See base class.

execute (self, **kwargs)
Executes a prepared instance.

handle_execution_finished (self, ret)
Handles execution finished.

Parameters ret (int)-—

class spinetoolbox.project_items.tool.tool_instance.JuliaToolInstance (fool_specification,

basedir,
set-
tings,
em-
bed-
ded_julia_console,
log-
ger)

Bases: spinetoolbox.project_items.tool.tool_instance.ToolInstance

Class for Julia Tool instances.

Parameters

* tool_specification (ToolSpecification) — the tool specification for this in-
stance

* basedir (str)— the path to the directory where this instance should run
* settings (0Settings)— Toolbox settings

* embedded_3julia_console (JuliaREPLWidget) — aJulia console for execution in
the embedded console

* logger (LoggerInterface)—alogger instance
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prepare (self, optional_input_files, input_database_urls, output_database_urls, tool_args)
See base class.

execute (self, **kwargs)
Executes a prepared instance.

handle_repl_execution_finished (self, ret)
Handles repl-execution finished.

Parameters ret (int) - Tool specification process return value

handle_execution_finished (self, ret)
Handles execution finished.

Parameters ret (int) - Tool specification process return value

class spinetoolbox.project_items.tool.tool_instance.PythonToolInstance (tool_specification,

basedir,
set-
tings,
em-
bed-
ded_python_console,
log-
ger)

Bases: spinetoolbox.project_items.tool.tool_instance.ToolInstance

Class for Python Tool instances.

Parameters

* tool_specification (ToolSpecification) — the tool specification for this in-
stance

* basedir (str) - the path to the directory where this instance should run
* settings (0Settings)— Toolbox settings

* embedded_python_console (PythonReplWidget) — a Python console widget for
execution in embedded console

* logger (LoggerInterface)— A logger instance

prepare (self, optional_input_files, input_database_urls, output_database_urls, tool_args)
See base class.

execute (self, **kwargs)
Executes a prepared instance.

handle_console_execution_finished (self, ret)
Handles console-execution finished.

Parameters ret (int)— Tool specification process return value

handle_execution_finished (self, ret)
Handles execution finished.

Parameters ret (int)— Tool specification process return value
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class spinetoolbox.project_items.tool.tool_instance.ExecutableToolInstance (fool_specification,
basedir,
set-
tings,
log-

ger)
Bases: spinetoolbox.project_items.tool.tool_instance.ToolInstance

Class for Executable Tool instances.
Parameters

* tool_specification (ToolSpecification) — the tool specification for this in-
stance

* basedir (str) - the path to the directory where this instance should run
* settings (0Settings)— Toolbox settings
* logger (LoggerInterface) — alogger instance

prepare (self, optional_input_files, input_database_urls, output_database_urls, tool_args)
See base class.

execute (self, **kwargs)
Executes a prepared instance.

handle_execution_finished (self, ret)
Handles execution finished.

Parameters ret (int)— Tool specification process return value

spinetoolbox.project_items.tool.tool_specifications

Contains Tool specification classes.
authors
P. Savolainen (VTT), E. Rinne (VTT), M. Marin (KTH)
date 24.1.2018

Module Contents

Classes
ToolSpecification Super class for all tool specifications.
GAMSTool Class for GAMS tool specifications.
JuliaTool Class for Julia tool specifications.
PythonTool Class for Python tool specifications.
ExecutableTool Class for Executable tool specifications.

spinetoolbox.project_items.tool.tool_specifications.TOOL_TYPES = ['Julia', 'Python', 'GAMS
spinetoolbox.project_items.tool.tool_specifications.REQUIRED_KEYS = ['name', 'tooltype',K ':
spinetoolbox.project_items.tool.tool_specifications.OPTIONAL_KEYS = ['description', 'short.

spinetoolbox.project_items.tool.tool_specifications.LIST_REQUIRED_KEYS = ['includes', 'inp
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class spinetoolbox.project_items.tool.tool_specifications.ToolSpecification (name,

Bases: spinetoolbox.project_item specification.ProjectItemSpecification

Super class for all tool specifications.

Parameters

save (self)

name (st r) — Tool specification name

tooltype (str)— Type of Tool (e.g. Python, Julia, ..)

path (str) — Path to Tool specification

includes (1ist) — List of files belonging to the tool specification (relative to ‘path’)
settings (0Settings)— Toolbox settings

logger (LoggerInterface)— alogger instance

description (str)— Description of the Tool specification

inputfiles (1ist)— List of required data files

inputfiles_opt (1ist, optional)— List of optional data files (wildcards may be

used)

outputfiles (1ist, optional)-— Listof output files (wildcards may be used)

cmdline_args (str, optional) — Tool command line arguments (read from tool

definition file)

execute_in_work (bool) — Execute in work folder

Saves this specification to a .json file in the definition path.

Returns How it went

tooltype,

path,

in-

cludes,

set-

tings,

log-

ger,

de-

scrip-
tion=None,

in-

put-
files=None,

in-

put-
files_opt=None,
out-

put-
files=None,
cmd-
line_args=None,
ex-

e-
cute_in_work=True)
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Return type bool

is_equivalent (self, definition)
Checks if this spec is equivalent to the given definition dictionary. Used by the tool spec widget when
updating specs.

Parameters definition (dict)—
Returns True if equivalent
Return type bool

set_return_code (self, code, description)
Sets a return code and an associated text description for the tool specification.

Parameters
e code (int) - Return code
* description (str)— Description

static check_definition (data, logger)
Checks that a tool specification contains the required keys and that it is in correct format.

Parameters
* data (dict) - Tool specification
* logger (LoggerInterface)— A logger instance
Returns Dictionary or None if there was a problem in the tool definition.

get_cmdline_args (self, optional_input_files, input_urls, output_urls)
Returns tool specification’s command line args as list.

Replaces special tags in arguments:
* @ @optional_inputs@ @ expands to a space-separated list of Tool’s optional input files
* @ @url:<Data Store name>@ @ expands to the URL provided by a named data store
e @ @url_inputs@ @ expands to a space-separated list of Tool’s input database URLs

* @ @url_outputs@ @ expands to a space-separated list of Tool’s output database URLSs

Parameters
* optional_input_files (1ist)— alist of Tool’s optional input file names

e input_urls (dict)— a mapping from URL provider (input Data Store name) to URL
string

* output_urls (dict) — a mapping from URL provider (output Data Store name) to
URL string

Returns a list of expanded command line arguments
Return type list
create_tool_instance (self, basedir)

Returns an instance of the tool specification configured to run in the given directory. Needs to be imple-
mented in subclasses.

Parameters basedir (str)— Path to directory where the instance will run
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static toolbox_load (definition, definition_path, app_settings, logger, embedded_julia_console,

embedded_python_console)

Deserializes and constructs a tool specification from definition.

Parameters

* definition (dict) — a dictionary containing the serialized specification.
* definition_path (str) — path to the definition file

* app_settings (0Settings)— Toolbox settings

* logger (LoggerInterface)—alogger

* embedded_julia_console (JuliaREPLWidget, optional) — Julia console
widget, required if a Julia tool is to be run in the console

* embedded_python_console (PythonReplWidget, optional) — Python
console widget, required if a Python tool is to be run in the console

Returns

a tool specification constructed from the given definition, or None if there was an error

Return type ToolSpecification

open_main_program file (self)
Open this specification’s main program file in the default editor.

class spinetoolbox.project_items.tool.tool_specifications.GAMSTool (name,

tooltype,

path,

includes,
settings,

logger,

descrip-
tion=None,
input-
files=None,
input-
files_opt=None,
output-
files=None,
cmd-
line_args=None,
exe-
cute_in_work=True)

Bases: spinetoolbox.project_items.tool.tool_specifications.ToolSpecification

Class for GAMS tool specifications.

Parameters

name (str) - GAMS Tool name
tooltype (str)— Tool specification type
path (str) — Path to model main file

includes (1ist) — List of files belonging to the tool (relative to ‘path’). # TODO:
Change to src_files

settings (0Settings)— Toolbox settings
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* logger (LoggerInterface)—alogger instance

e file in the list is the main GAMS program. (First)-—
* description (str)— GAMS Tool description

* inputfiles (11ist)— List of required data files

* inputfiles_opt (1ist, optional)— List of optional data files (wildcards may be
used)

* outputfiles (1ist, optional)- Listof output files (wildcards may be used)

* cmdline_args (str, optional)- GAMS tool command line arguments (read from
tool definition file)

update_gams_options (self, key, value)
[OBSOLETE?] Updates GAMS command line options. Only ‘cerr’ and ‘logoption’ keywords supported.

Parameters
* key (str)— Option name
e value (int, float)- Option value

static load (path, data, settings, logger)
Creates a GAMSTool according to a tool specification file.

Parameters
e path (str)— Base path to tool files
* data (dict) — Dictionary of tool definitions
* settings (0Settings)— Toolbox settings
* logger (LoggerInterface)— A logger instance
Returns GAMSTool instance or None if there was a problem in the tool specification file.

create_tool_instance (self, basedir)
Returns an instance of this tool specification that is configured to run in the given directory.

Parameters basedir (str)— the path to the directory where the instance will run
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class spinetoolbox.project_items.tool.tool_specifications.JuliaTool (name,

tooltype,

path,

includes,

settings,

embed-
ded_julia_console,
logger,

descrip-
tion=None,

input-

files=None,

input-
files_opt=None,
output-
files=None,

cmd-
line_args=None,
exe-
cute_in_work=True)

Bases: spinetoolbox.project_items.tool.tool specifications.ToolSpecification

Class for Julia tool specifications.

Parameters

name (st r) — Julia Tool name
tooltype (str) - Tool specification type
path (str) — Path to model main file

includes (1ist) — List of files belonging to the tool (relative to ‘path’). # TODO:
Change to src_files

file in the list is the main Julia program. (First)-—
settings (0Settings)— Toolbox settings

embedded_julia_console (JuliaREPLWidget) — a Julia console widget for exe-
cution in the embedded console

logger (LoggerInterface)— A logger instance
description (str) - Julia Tool description
inputfiles (1ist)— List of required data files

inputfiles_opt (list, optional) - Listof optional data files (wildcards may be
used)

outputfiles (1ist, optional)-— Listof output files (wildcards may be used)

cmdline_args (str, optional) — Julia tool command line arguments (read from
tool definition file)

update_julia_options (self, key, value)
[OBSOLETE?] Updates Julia command line options.

Parameters

* key (str)— Option name

e value (int, float)— Option value
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static load (path, data, settings, embedded_julia_console, logger)
Creates a JuliaTool according to a tool specification file.

Parameters

e path (str)— Base path to tool files
* data (dict)— Dictionary of tool definitions
* settings (0Setting) - Toolbox settings

* embedded_julia_console (JuliaREPLWidget) — a Julia console for execution
in the embedded console

* logger (LoggerInterface)— A logger instance

Returns JuliaTool instance or None if there was a problem in the tool definition file.

create_tool_instance (self, basedir)
Returns an instance of this tool specification that is configured to run in the given directory.

Parameters basedir (str) — the path to the directory where the instance will run

class spinetoolbox.project_items.tool.tool_specifications.PythonTool (name,

tooltype,

path,

in-

cludes,

set-

tings,

embed-
ded_python_console,
logger,

de-

scrip-
tion=None,
input-
files=None,
input-
files_opt=None,
output-
files=None,

cmd-
line_args=None,
exe-
cute_in_work=True)

Bases: spinetoolbox.project_items.tool.tool_specifications.ToolSpecification

Class for Python tool specifications.

Parameters

name (str)— Python Tool name
tooltype (str)— Tool specification type
path (str) — Path to model main file

includes (l1ist) — List of files belonging to the tool (relative to ‘path’). # TODO:
Change to src_files

settings (0Settings)— Toolbox settings
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* embedded_python_console (PythonReplWidget) — a Python console widget for
embedded console execution

* logger (LoggerInterface)— A logger instance

e file in the list is the main Python program. (First)-—
* description (str)— Python Tool description

* inputfiles (11ist)— List of required data files

* inputfiles_opt (1ist, optional)— List of optional data files (wildcards may be
used)

* outputfiles (list, optional)— Listof output files (wildcards may be used)

* ecmdline_args (str, optional)— Python tool command line arguments (read from
tool definition file)

update_python_options (self, key, value)
[OBSOLETE?] Updates Python command line options.

Parameters
* key (str)— Option name
* value (int, float)- Option value

static load (path, data, settings, embedded_python_console, logger)
Creates a PythonTool according to a tool specification file.

Parameters
* path (str)— Base path to tool files
* data (dict) — Dictionary of tool definitions
* settings (0Settings)— Toolbox settings

* embedded_python_console (PythonReplWidget) — Python console widget for
execution in the embedded console

* logger (LoggerInterface)— A logger instance
Returns PythonTool instance or None if there was a problem in the tool definition file.

create_tool_instance (self, basedir)
Returns an instance of this tool specification that is configured to run in the given directory.

Parameters basedir (str)— the path to the directory where the instance will run
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class spinetoolbox.project_items.tool.tool_specifications.ExecutableTool (name,

tooltype,

path,

in-

cludes,

set-

tings,

log-

ger,

de-

scrip-
tion=None,

in-

put-
files=None,

in-

put-
files_opt=None,
out-

put-
files=None,
cmd-
line_args=None,
ex-

e-
cute_in_work=True)

Bases: spinetoolbox.project_items.tool.tool_specifications.ToolSpecification

Class for Executable tool specifications.
Parameters
* name (str) - Tool name
* tooltype (str)— Tool specification type

* path (str) - Path to main script file

includes (1ist) — List of files belonging to the tool (relative to ‘path’). # TODO:
Change to src_files

file in the list is the main script file. (First)-
settings (0Settings)— Toolbox settings

logger (LoggerInterface)— A logger instance

description (str) - Tool description

inputfiles (1ist)— List of required data files

inputfiles_opt (1ist, optional) - Listof optional data files (wildcards may be
used)

outputfiles (list, optional)— Listof output files (wildcards may be used)

cmdline_args (str, optional) — Tool command line arguments (read from tool
definition file)

static load (path, data, settings, logger)
Creates an ExecutableTool according to a tool specification file.
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Parameters
e path (str)— Base path to tool files
* data (dict) - Tool specification
* settings (0Settings)— Toolbox settings
* logger (LoggerInterface)— A logger instance
Returns ExecutableTool instance or None if there was a problem in the tool specification.

create_tool_instance (self, basedir)
Returns an instance of this tool specification that is configured to run in the given directory.

Parameters basedir (str)— the path to the directory where the instance will run

spinetoolbox.project_items.tool.utils

Utility functions for the Tool project item.
author
A. Soininen (VTT)
date 1.4.2020

Module Contents

Classes
_LatestOutputFile A class to hold information on a latest output file.
Functions
flatten_ file_path_duplicates(file_paths, Flattens the extra duplicate dimension in file_paths.
logger, log_duplicates=False)
file paths_from_resources(resources) Returns file paths from given resources.
find_f1ile(filename, resources) Returns all occurrences of full paths to given file name
in resources available.
find_last_output_files(output_files, out- Returns latest output files.
put_dir)
1s_pattern(file_name) Returns True if file_name is actually a file pattern.

spinetoolbox.project_items.tool.utils.flatten_file_path_duplicates (file_paths,
logger,

log_duplicates=False)
Flattens the extra duplicate dimension in file_paths.

spinetoolbox.project_items.tool.utils.file_paths_from_ resources (resources)
Returns file paths from given resources.

Parameters resources (11ist)—resources available

Returns a list of file paths, possibly including patterns
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spinetoolbox.project_items.tool.utils.find_£ile (filename, resources)
Returns all occurrences of full paths to given file name in resources available.

Parameters

» filename (str)— Searched file name (no path)

* resources (1ist) - list of resources available from upstream items
Returns Full paths to file if found, None if not found
Return type list

spinetoolbox.project_items.tool.utils.find_last_output_files (output_files, out-

put_dir)
Returns latest output files.

Parameters

* output_files (1ist) - output file patterns from tool specification

* output_dir (str)— path to the execution output directory
Returns a mapping from a file name pattern to the path of the most recent files in the results archive.
Return type dict

spinetoolbox.project_items.tool.utils.is_pattern (file_name)
Returns True if file_name is actually a file pattern.

class spinetoolbox.project_items.tool.utils._LatestOutputFile (label, path)
A class to hold information on a latest output file.

label
file label, e.g. file pattern or relative path

Type str

path
absolute path to the file

Type str

Initialize self. See help(type(self)) for accurate signature.

static from_ paths (path, archive_dir)
Constructs a _LatestOutputFile object from an absolute path and archive directory.

Package Contents

Classes

ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.tool.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT)—

item maker
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Returns a ProjectItem subclass.
Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static supports_specifications ()
Returns whether or not this factory supports specs.

If the subclass implementation returns  True, then it must also implement
specification_form_maker, and specification_menu_maker.
Returns bool
static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.
Returns QWidget
class spinetoolbox.project_items.tool.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo
static item_category ()
See base class.
static item_type ()
See base class.
spinetoolbox.project_items.view
View plugin.
author
M. Marin (KTH)
date 12.9.2019
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Subpackages
spinetoolbox.project_items.view.widgets

Widgets for the View project item.
author A.Soininen (VTT)
date 27.9.2019

Submodules
spinetoolbox.project_items.view.widgets.add view_widget

Widget shown to user when a new View is created.
author
P. Savolainen (VTT)
date 19.1.2017

Module Contents

Classes

AddViewWidget A widget to query user’s preferences for a new item.

class spinetoolbox.project_items.view.widgets.add_view_widget .AddViewWidget (foolbox,
'x’
y’
spec="")
Bases: spinetoolbox.widgets.add project_item widget.AddProjectItemWidget
A widget to query user’s preferences for a new item.

toolbox
Parent widget

Type ToolboxUI

X coordinate of new item

Type int

Y coordinate of new item
Type int
Initialize class.

call_add_item (self)
Creates new Item according to user’s selections.
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spinetoolbox.project_items.view.widgets.custom menus

Classes for custom context menus and pop-up menus.
author
P. Savolainen (VTT)
date 9.1.2018

Module Contents

Classes

ViewPropertiesContextMenu Context menu class for the references tree view of the
View project item properties.

class spinetoolbox.project_items.view.widgets.custom _menus.ViewPropertiesContextMenu (parent,
po-
Si-
tion,
in-
dex)
Bases: spinetoolbox.widgets.custom _menus.CustomContextMenu
Context menu class for the references tree view of the View project item properties.
Parameters
* parent (QWidget) — Parent for menu widget (ToolboxUI)
* position (QPoint) — Position on screen

* index (OModelIndex)— Index of item that requested the context-menu

spinetoolbox.project_items.view.widgets.view_properties_widget

View properties widget.
author
M. Marin (KTH)
date 12.9.2019

Module Contents

Classes

ViewPropertiesWidget Widget for the View Item Properties.

class spinetoolbox.project_items.view.widgets.view_properties_widget.ViewPropertiesWidget (i
Bases: PySide2.QtWidgets.QWidget
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Widget for the View Item Properties.

Parameters toolbox (ToolboxUTI) — The toolbox instance where this widget should be embed-
ded

Init class.

connect_signals (self)
Connect signals to slots.

show_view_properties_context_menu (self, pos)
Create and show a context-menu in View properties.

Parameters pos (OPoint)— Mouse position

Submodules
spinetoolbox.project_items.view.executable_item

Contains View’s executable item as well as support utilities.
authors
A. Soininen (VTT)
date 2.4.2020

Module Contents

Classes

Executableltem The part of a project item that is executed by the Spine
Engine.

class spinetoolbox.project_items.view.executable_item.ExecutableItem (name,
log-
ger)
Bases: spinetoolbox.executable_item base.ExecutableltemBase
The part of a project item that is executed by the Spine Engine.
Parameters
* name (str) —item’s name

* logger (LoggerInterface)—alogger

static item_type ()
Returns View’s type identifier string.

classmethod from dict (cls, item_dict, name, project_dir, app_settings, specifications, logger)
See base class.

spinetoolbox.project_items.view.item_info

View project item info.
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authors
A. Soininen (VTT)
date 29.4.2020

Module Contents

Classes

ItemInfo

class spinetoolbox.project_items.view.item_info.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type ()
See base class.

spinetoolbox.project_items.view.view

Module for view class.
authors
P. Savolainen (VTT), M. Marin (KHT), J. Olauson (KTH)
date 14.07.2018

Module Contents

Classes

View Class for project items that are not category nor root.

class spinetoolbox.project_items.view.view.View (foolbox, project, logger, name, descrip-

tion, x, y)
Bases: spinetoolbox.project_item.ProjectItem

Class for project items that are not category nor root. These items can be executed, refreshed, and so on.

X
horizontal position in the screen
Type float
y
vertical position in the screen
Type float
View class.
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Parameters
¢ toolbox (ToolboxUI) — atoolbox instance
* project (SpineToolboxProject) — the project this item belongs to
* logger (LoggerInterface)—alogger instance
* name (str)— Object name
* description (str)— Object description
* x (float) - Initial X coordinate of item icon
* y(float)— Initial Y coordinate of item icon

static item_type ()
See base class.

static item_ category ()
See base class.

execution_item (self)
Creates project item’s execution counterpart.

make_signal_handler_dict (self)
Returns a dictionary of all shared signals and their handlers. This is to enable simpler connecting and
disconnecting.

restore_selections (self)
Restore selections into shared widgets when this project item is selected.

save_selections (self)
Save selections in shared widgets for this project item into instance variables.

open_db_editor (self, checked=False)
Opens selected db in the Spine database editor.

populate_reference_list (self)
Populates reference list.

update_name_label (self)
Update View tab name label. Used only when renaming project items.

_do_handle_dag_changed (self, resources)
Update the list of references that this item is viewing.

_update_references_1list (self, resources_upstream)
Updates the references list with resources upstream.

Parameters resources_upstream (11ist)— ProjectltemResource instances

_selected_indexes (self)
Returns selected indexes.

_db_url_codenames (self, indexes)
Returns a dict mapping url to provider’s name for given indexes in the reference model.

notify destination (self, source_item)
See base class.

static default_name_prefix()
see base class
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spinetoolbox.project_items.view.view_factory

The ViewFactory class.
author
M. Marin (KTH)
date 15.4.2020

Module Contents

Classes

ViewFactory

Class for project item factories.

class spinetoolbox.project_items.view.view_factory.ViewFactory (toolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item _maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker

Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget
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spinetoolbox.project_items.view.view_icon

Module for view icon class.
authors
M. Marin (KTH), P. Savolainen (VTT)
date 4.4.2018

Module Contents

Classes
ViewIcon View icon for the Design View.
class spinetoolbox.project_items.view.view_icon.ViewIcon (toolbox, X, Y,

project_item, icon)
Bases: spinetoolbox.graphics_items.ProjectItemIcon

View icon for the Design View.
Parameters
¢ toolbox (ToolBoxUI) - QMainWindow instance
* x (float) - Icon x coordinate
* y (float)-Icony coordinate
* project_item (ProjectItem)— Item

* icon (str)—icon resource path

Package Contents

Classes

ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.view.ItemFactory (toolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a ProjectItem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class
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add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.view.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

Package Contents

Classes
ItemFactory Class for project item factories.
ItemInfo
ItemFactory Class for project item factories.
ItemInfo
ItemFactory Class for project item factories.
ItemInfo
ItemFactory Class for project item factories.
ItemInfo
ItemFactory Class for project item factories.
ItemInfo
ItemFactory Class for project item factories.
ItemInfo
ItemFactory Class for project item factories.
ItemInfo
ItemFactory Class for project item factories.
ItemInfo

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory
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Class for project item factories.
Parameters toolbox (ToolboxUT)—

item _maker
Returns a ProjectItem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add form maker
Returns an AddProjectltem subclass.
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Returns class

specification_form_ maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
See base class.

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT)—

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str
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static _make_properties_widget (toolbox)
See base class

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item type ()
See base class.

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item_ maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
See base class.

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
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Parameters toolbox (ToolboxUT)—
properties_widget_maker

item _maker
Returns a ProjectItem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str
static item_type ()

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item _maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class
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add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectltemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class
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static icon()
Returns the icon resource path.

Returns str

static supports_specifications ()
Returns whether or not this factory supports specs.

If the subclass implementation returns  True, then it  must
specification_form_maker, and specification_menu_maker.

Returns bool

static _make_properties_widget (toolbox)
Creates the item’s properties tab widget.

Returns QWidget

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

class spinetoolbox.project_items.ItemFactory (foolbox)
Bases: spinetoolbox.project_item.ProjectItemFactory

Class for project item factories.
Parameters toolbox (ToolboxUT) —

item maker
Returns a Projectltem subclass.

Returns class

icon_maker
Returns a ProjectItemIcon subclass.

Returns class

add_form maker
Returns an AddProjectltem subclass.

Returns class

specification_form_ maker
Returns a QWidget subclass to create and edit specifications.

Returns class

specification_menu_maker
Returns an ItemSpecificationMenu subclass.

Returns class

static icon()
Returns the icon resource path.

Returns str

static _make_ properties_widget (toolbox)
Creates the item’s properties tab widget.

also

implement
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Returns QWidget

class spinetoolbox.project_items.ItemInfo
Bases: spinetoolbox.project_item info.ProjectItemInfo

static item_category ()
See base class.

static item_type ()
See base class.

spinetoolbox.spine_db_editor

This subpackage contains GUI files for the Spine db editor.
authors
M. Marin (KTH)
date 13.5.2020

Subpackages
spinetoolbox.spine_db_editor.mvcmodels

Modules in this package contain classes that represent Spine Toolbox’s models (internal data structures) in the Model-
View-Controller design pattern. The model classes define an interface that is used by views and delegates to access
data in the application.

author
M. Marin (KTH)
date 23.5.2020

Submodules
spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item

Classes to represent alternative and scenario items in a tree.
authors
P. Vennstrom (VTT)
date 17.6.2020

Module Contents

Classes

RootItem A root item.

Continued on next page
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Table 154 — continued from previous page

LeafItem A tree item that fetches their children as they are in-
serted.

AlternativeRootItem An alternative root item.

ScenarioRootItem A scenario root item.

AlternativelLeafItem An alternative leaf item.

ScenarioLeafItem A scenario leaf item.

ScenarioAlternativelLeafItem A scenario alternative leaf item.

spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item._ ALTERNATIVE_ICON =
spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item._SCENARIO_ICON =

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.RootItem (model=None)

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree item utility.
EmptyChildMixin, spinetoolbox.spine_db_editor.mvcmodels.tree item utility.
AllBoldMixin, spinetoolbox.spine_db_editor.mvcmodels.tree item utility.
NonLazyTreeltem

A root item.

Initializes item.
Parameters model (MinimalTreeModel, NoneType)-— The model where the item belongs.
item_type
display_ data
icon_code
db_map
display_ icon

data (self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data (self, column, value, role)
Sets data for this item.

Parameters
e column (int)— column index
* value (object) — anew value
e role (int) —role of the new value
Returns True if data was set successfully, False otherwise
Return type bool
empty_ child (self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.LeafItem (identifier=None
Bases: spinetoolbox.spine_db_editor.mvcmodels.tree item utility.
NonLazyTreeltem

A tree item that fetches their children as they are inserted.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.

item_type
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tool_tip

db_map

id

item_data

name

add_item_to_db (self, db_item)
update_item in_db (self, db_item)
header_data (self, column)

data (self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data (self, column, value, role)
Sets data for this item.

Parameters
e column (int)— column index
* value (object) — anew value
e role (int) —role of the new value
Returns True if data was set successfully, False otherwise
Return type bool
handle_updated_in_db (self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.AlternativeRootItem

Bases: spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.
RootItem

An alternative root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)—- The model where the item belongs.
item_type
display_ data
icon_code

empty_child (self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioRootItem (moc

Bases: spinetoolbox.spine_db_editor.mvcmodels.alternative scenario_item.
RootItem

A scenario root item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)-—The model where the item belongs.
item_type
display data

icon_code
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empty_child (self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.AlternativelLeafItem

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree item utility.
LastGrayMixin, spinetoolbox.spine_db_editor.mvcmodels.
tree_item utility.EditableMixin, spinetoolbox.spine_db_editor.mvcmodels.

alternative_ scenario_item.LeafItem
An alternative leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)—The model where the item belongs.
item_type
tool_tip
add_item_to_db (self, db_item)
update_item_in_db (self, db_item)

flags (self, column)
Makes items editable.

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioLeafItem (idei

Bases: spinetoolbox.spine_db_editor.mvcmodels.tree item utility.
LastGrayMixin, spinetoolbox.spine_db_editor.mvcmodels.
tree_item utility.EditableMixin, spinetoolbox.spine_db_editor.mvcmodels.

alternative_scenario_item.LeafItem
A scenario leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)- The model where the item belongs.
item_type
tool_tip
alternative_id list
add_item_to_db (self, db_item)
update_item_in_db (self, db_item)

flags (self, column)
Makes items editable.

data (self, column, role=Qt.DisplayRole)
Returns data for given column and role.

set_data (self, column, value, role)
Sets data for this item.

Parameters
¢ column (int) - column index
¢ value (object) —anew value
e role (int) —role of the new value
Returns True if data was set successfully, False otherwise

Return type bool
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fetch_more (self)
Fetches more children.

handle_updated_in_db (self)
_update_alternative_id_list (self)

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_item.ScenarioAlternativel
Bases: spinetoolbox.spine_db_editor.mvcmodels.alternative scenario_item.
LeafItem

A scenario alternative leaf item.
Initializes item.
Parameters model (MinimalTreeModel, NoneType)— The model where the item belongs.
item_type
tool_tip
id
add_item_to_db (self, db_item)
update_item in_db (self, db_item)

flags (self, column)
Enables the item and makes it selectable.

spinetoolbox.spine_db_editor.mvcmodels.alternative_ scenario_model

Models to represent alternatives, scenarios and scenario alternatives in a tree.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 17.6.2020

Module Contents

Classes

AlternativeScenarioModel A model to display parameter_value_list data in a tree
view.

class spinetoolbox.spine_db_editor.mvcmodels.alternative_scenario_model.AlternativeScenaric

Bases: spinetoolbox.mvcmodels.minimal_tree_model.MinimalTreeModel
A model to display parameter_value_list data in a tree view.
Parameters
* parent (SpineDBEditor)—
* db_mngr (SpineDBManager) —

* db_maps (iter) - DiffDatabaseMapping instances
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Initialize class

columnCount (self, parent=QModellndex())
Returns the number of columns under the given parent. Always 1.

headerData (self, section, orientation, role=Qt.DisplayRole)

build_tree (self)
Builds tree.

_add_1leaves (self, db_map_data, leaf type)
_update_1leaves (self, db_map_data, leaf type)
_remove_leaves (self, db_map_data, leaf type)
add_alternatives (self, db_map_data)
add_scenarios (self, db_map_data)
update_alternatives (self, db_map_data)
update_scenarios (self, db_map_data)
remove_alternatives (self, db_map_data)
remove_scenarios (self, db_map_data)
static db_item (item)

db_row (self, item)

supportedDropActions (self)

mimeData (self, indexes)
Builds a dict mapping db name to item type to a list of ids.

Returns QMimeData
canDropMimeData (self, data, drop_action, row, column, parent)

dropMimeData (self, data, drop_action, row, column, parent)

spinetoolbox.spine_db_editor.mvcmodels.compound parameter_models

Compound models for object parameter definitions and values. These models concatenate several ‘single’ models and

one ‘empty’ model.
authors
M. Marin (KTH)
date 28.6.2019

Module Contents

Classes

CompoundParameterModel A model that concatenates several single parameter

models

Continued on next page
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Table 156 — continued from previous page

CompoundOb jectParameterMixin Implements the interface for populating and filtering a
compound object parameter model.

CompoundRelationshipParameterMixin Implements the interface for populating and filtering a
compound relationship parameter model.

CompoundParameterDefinitionMixin Handles signals from db mngr for parameter_definition
models.

CompoundParameterValueMixin Handles signals from db mngr for parameter_value
models.

CompoundOb jectParameterDefinitionModel A model that concatenates several single object param-
eter_definition models

CompoundRelationshipParameterDefinitionKomedel that concatenates several single relationship
parameter_definition models

CompoundOb jectParameterValueModel A model that concatenates several single object param-
eter_value models

CompoundRelationshipParameterValueModelA model that concatenates several single relationship
parameter_value models

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundParameterMoc

Bases: spinetoolbox.mvcmodels.compound_table_model.CompoundWithEmptyTableModel
A model that concatenates several single parameter models and one empty parameter model.
Initializes model.
Parameters
* parent (SpineDBEditor) —the parent object
* db_mngr (SpineDBManager) — the database manager
* xdb_maps (DiffDatabaseMapping)— the database maps included in the model

data_for_ single_model_received
Emitted by the fetcher when there’s data for another single model.

entity class_type
Returns the entity_class type, either ‘object_class’ or ‘relationship_class’.

Returns str

item_type
Returns the parameter item type, either ‘parameter_definition’ or ‘parameter_value’.

Returns str

_single_model_type
Returns a constructor for the single models.

Returns SingleParameterModel

_empty_model_type
Returns a constructor for the empty model.

Returns EmptyParameterModel

entity class_id_key
Returns the key corresponding to the entity_class id (either “object_class_id” or “relationship_class_id”)

Returns str
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parameter_definition_id_key
_make_header (self)

init_model (self)
Initializes the model.

_make_auto_filter_menus (self)
Makes auto filter menus.

get_auto_filter_menu (self, logical_index)
Returns auto filter menu for given logical index from header view.

Parameters logical_index (int) -
Returns ParameterViewFilterMenu

_modify data_in_filter_ menus (self, action, db_map, db_items)
Modifies data in filter menus.

Parameters

e action (str) —either ‘add’, ‘remove’, or ‘update’

* db_map (DiffDatabaseMapping)—

e db_items (list (dict))—
_do_add_data_to_filter_ menus (self, db_map, db_items)
_do_update_data_in_filter_menus (self, db_map, db_items)
_do_remove_data_from_filter menus (self, db_map, db_items)

headerData (self, section, orientation=Qt.Horizontal, role=Qt.DisplayRole)
Returns an italic font in case the given column has an autofilter installed.

_create_single_models (self)
Returns a list of single models for this compound model, one for each entity_class in each database.

Returns list

_create_empty_ model (self)
Returns the empty model for this compound model.

Returns EmptyParameterModel

filter_accepts_model (self, model)
Returns a boolean indicating whether or not the given model passes the filter for compound model.

Parameters model (SingleParameterModel, EmptyParameterModel)-—
Returns bool

_class_filter accepts_model (self, model)

_auto_filter_accepts_model (self, model)

accepted_single_models (self)
Returns a list of accepted single models by calling filter_accepts_model on each of them, just for conve-
nience.

Returns list

static _settattr_ if different (obj, attr, val)
Sets the given attribute of the given object to the given value if it’s different from the one currently stored.
Used for updating filters.
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Returns True if the attributed was set, False otherwise
Return type bool

_invalidate_filter (self)
Sets the filter invalid.

_refresh_if still_invalid (self)
set_filter class_ids (self, class_ids)
set_filter parameter_ids (self, parameter_ids)

set_auto_filter (self, field, auto_filter)
Updates and applies the auto filter.

Parameters
e field (str) - the field name

* auto_filter (dict)— mapping db_map to entity_class id to accepted values for the
field

set_compound_auto_filter (self, field, auto_filter)
Sets the auto filter for given column in the compound model.

Parameters
e field (str) — the field name

* auto_filter (dict)— maps tuple (database map, entity_class id) to list of accepted
ids for the field

set_single_auto_filter (self, model, field)
Sets the auto filter for given column in the given single model.

Parameters

* model (SingleParameterModel) — the model

e field (str) - the field name
Returns True if the auto-filtered values were updated, None otherwise
Return type bool

_row_map_for_model (self, model)
Returns the row map for the given model. Reimplemented to take filter status into account.

Parameters model (SingleParameterModel, EmptyParameterModel)-—
Returns tuples (model, row number) for each accepted row
Return type list

_models_with_db_map (self, db_map)
Returns a collection of single models with given db_map.

Parameters db_map (DiffDatabaseMapping)—
Returns list

receive_entity_ classes_removed (self, db_map_data)
Runs when entity classes are removed from the dbs. Removes sub-models for the given entity classes and
dbs.

Parameters db_map_data (dict) — list of removed dict-items keyed by DiffDatabaseMap-
ping
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_items_per_ class (self, items)
Returns a dict mapping entity_class ids to a set of items.

Parameters items (1ist)—
Returns dict

receive_parameter_data_added (self, db_map_data)
Runs when either parameter definitions or values are added to the dbs. Adds necessary sub-models and
initializes them with data. Also notifies the empty model so it can remove rows that are already in.

Parameters db_map_data (dict) — list of removed dict-items keyed by DiffDatabaseMap-
ping
create_and_append_single_model (self, db_map, entity_class_id, ids)

receive_parameter_data_updated (self, db_map_data)
Runs when either parameter definitions or values are updated in the dbs. Emits dataChanged so the param-
eter_name column is refreshed.

Parameters db_map_data (dict) — list of updated dict-items keyed by DiffDatabaseMap-
ping
receive_parameter_data_removed (self, db_map_data)

Runs when either parameter definitions or values are removed from the dbs. Removes the affected rows
from the corresponding single models.

Parameters db_map_data (dict) — list of removed dict-items keyed by DiffDatabaseMap-
ping
_emit_data_changed_for_column (self, field)
Lazily emits data changed for an entire column.

Parameters f£ield (str) - the column header
db_item (self, index)
index_name (self, index)

get_set_data_delayed (self, index)
Returns a function that ParameterValueEditor can call to set data for the given index at any later time, even
if the model changes.

Parameters index (OModelIndex) —

Returns function
get_entity_class_id (self, index, db_map)
filter_by (self, rows_per_column)
filter_excluding (self, rows_per_column)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundObjectParams
Implements the interface for populating and filtering a compound object parameter model.

entity class_type

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundRelationshij
Implements the interface for populating and filtering a compound relationship parameter model.

entity class_type

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundParameterDe:
Handles signals from db mngr for parameter_definition models.
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item_type
receive_parameter_definition_tags_set (self, db_map_data)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundParameterVa.
Handles signals from db mngr for parameter_value models.

item_type

entity type
Returns the entity type, either ‘object’ or ‘relationship’ Used by update_single_main_filter.

Returns str
set_filter entity_ids (self, entity_ids)
set_filter alternative_ids (self, alternative_ids)

receive_alternatives_updated (self, db_map_data)
Updated alternative column

Parameters db_map_data (dict) — list of updated dict-items keyed by DiffDatabaseMap-
ping

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundObjectParams

Bases: spinetoolbox.spine_db_editor.mvcmodels.compound _parameter._models.
CompoundOb jectParameterMixin, spinetoolbox.spine_db_editor.mvcmodels.
compound_parameter._models.CompoundParameterDefinitionMixin, spinetoolbox.
spine_db_editor.mvcmodels.compound_ parameter_models.CompoundParameterModel

A model that concatenates several single object parameter_definition models and one empty object parame-
ter_definition model.

Initializes model.
Parameters
* parent (SpineDBEditor) — the parent object
* db_mngr (SpineDBManager) — the database manager
* xdb_maps (DiffDatabaseMapping) — the database maps included in the model
_make_header (self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundRelationshij

Bases: spinetoolbox.spine_db_editor.mvcmodels.compound parameter._models.
CompoundRelationshipParameterMixin, spinetoolbox.spine_db_editor.mvcmodels.
compound_parameter._models.CompoundParameterDefinitionMixin, spinetoolbox.
spine_db_editor.mvcmodels.compound_parameter._models.CompoundParameterModel

A model that concatenates several single relationship parameter_definition models and one empty relationship
parameter_definition model.

Initializes model.
Parameters
* parent (SpineDBEditor) —the parent object

* db_mngr (SpineDBManager) — the database manager
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* xdb_maps (DiffDatabaseMapping) — the database maps included in the model
_make_header (self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundObjectParams

Bases: spinetoolbox.spine_db_editor.mvcmodels.compound _parameter._models.
CompoundOb jectParameterMixin, spinetoolbox.spine_db_editor.mvcmodels.
compound_parameter._models.CompoundParameterValueMixin, spinetoolbox.
spine_db_editor.mvcmodels.compound_ _parameter_models.CompoundParameterModel

A model that concatenates several single object parameter_value models and one empty object parameter_value
model.

Initializes model.
Parameters
* parent (SpineDBEditor) — the parent object
* db_mngr (SpineDBManager) — the database manager
* xdb_maps (DiffDatabaseMapping) — the database maps included in the model

entity type
Returns the entity type, either ‘object’ or ‘relationship’ Used by update_single_main_filter.

Returns str
_make_header (self)

class spinetoolbox.spine_db_editor.mvcmodels.compound_parameter_models.CompoundRelationshij

Bases: spinetoolbox.spine_db_editor.mvcmodels.compound parameter._models.
CompoundRelationshipParameterMixin, spinetoolbox.spine_db_editor.mvcmodels.
compound_parameter._models.CompoundParameterValueMixin, spinetoolbox.
spine_db_editor.mvcmodels.compound_parameter._models.CompoundParameterModel

A model that concatenates several single relationship parameter_value models and one empty relationship pa-
rameter_value model.

Initializes model.
Parameters
* parent (SpineDBEditor) — the parent object
* db_mngr (SpineDBManager) — the database manager
* xdb_maps (DiffDatabaseMapping) — the database maps included in the model

entity type
Returns the entity type, either ‘object’ or ‘relationship’ Used by update_single_main_filter.

Returns str

_make_header (self)

spinetoolbox.spine_db_editor.mvcmodels.empty parameter models

Empty models for parameter definitions and values.
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authors
M. Marin (KTH)
date 28.6.2019

Module Contents

Classes
EmptyParameterModel An empty parameter model.
EmptyParameterDefinitionModel An empty parameter_definition model.
EmptyOb jectParameterDefinitionModel An empty object parameter_definition model.
EmptyRelationshipParameterDefinitionModAn empty relationship parameter_definition model.
EmptyParameterValueModel An empty parameter_value model.
EmptyObjectParameterValueModel An empty object parameter_value model.

EmptyRelationshipParameterValueModel An empty relationship parameter_value model.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyParameterModel (par
hea

db_
Bases: spinetoolbox.mvcmodels.empty row_model.EmptyRowModel

An empty parameter model.
Initialize class.
Parameters
* parent (Object) — the parent object, typically a CompoundParameterModel
* header (1ist) - list of field names for the header
* db_mngr (SpineDBManager) —

item_type
The item type, either ‘parameter_value’ or ‘parameter_definition’, required by the json_fields property.

entity class_type
Either ‘object_class’ or ‘relationship_class’.

entity class_id_key
entity class_name_key
can_be_ filtered
json_fields
accepted_rows (self)
db_item (self, _index)
item_id (self, _row)

flags (self, index)
Return default flags except if forcing defaults.

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the item referred to by the index.

Parameters
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¢ index (OModelIndex) — Index of item
e role (int)— Datarole
Returns Item data for given role.

_make_unique_id (self, item)
Returns a unique id for the given model item (name-based). Used by receive_parameter_data_added.

receive_parameter_data_added (self, db_map_data)
Runs when parameter definitions or values are added. Finds and removes model items that were success-
fully added to the db.

batch_set_data (self, indexes, data)
Sets data for indexes in batch. If successful, add items to db.

add_items_to_db (self, rows)
Add items to db.

Parameters rows (set) — add data from these rows

_make_db_map_data (self, rows)
Returns model data grouped by database map.

Parameters rows (set) — group data from these rows

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyParameterDefinitic

Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter._mixins.
FillInValueListIdMixin, spinetoolbox.spine_db_editor.mvcmodels.
parameter_mixins.FillInEntityClassIdMixin, spinetoolbox.spine _db_editor.
mvcmodels.parameter._mixins.FillInParameterNameMixin, spinetoolbox.
spine_db_editor.mvcmodels.empty_ parameter_models.EmptyParameterModel

An empty parameter_definition model.
Initializes lookup dicts.

item_type
The item type, either ‘parameter_value’ or ‘parameter_definition’, required by the json_fields property.

entity class_type
See base class.

add_items_to_db (self, rows)
Add items to db.

Parameters rows (set) — add data from these rows

_check_item (self, item)
Checks if a db item is ready to be inserted.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyObjectParameterDe:

Bases: spinetoolbox.spine_db_editor.mvcmodels.empty parameter._models.
EmptyParameterDefinitionModel

An empty object parameter_definition model.
Initializes lookup dicts.

entity class_type
See base class.
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class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyRelationshipParame

Bases: spinetoolbox.spine _db_editor.mvcmodels.empty parameter _models.
EmptyParameterDefinitionModel

An empty relationship parameter_definition model.
Initializes lookup dicts.

entity class_type
See base class.

flags (self, index)
Additional hack to make the object_class_name_list column non-editable.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyParameterValueMods

Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter._mixins.
InferEntityClassIdMixin, spinetoolbox.spine_db_editor.mvcmodels.
parameter_mixins.FillInAlternativeIdMixin, spinetoolbox.spine_db_editor.
mvcmodels.parameter._mixins.FillInParameterDefinitionIdsMixin, spinetoolbox.
spine _db_editor.mvcmodels.parameter _mixins.FillInEntityIdsMixin,
spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.
FillInEntityClassIdMixin, spinetoolbox.spine_db_editor.mvcmodels.
empty_parameter_models.EmptyParameterModel

An empty parameter_value model.
Initializes lookup dicts.

item_type
The item type, either ‘parameter_value’ or ‘parameter_definition’, required by the json_fields property.

entity type
Either ‘object’ or “relationship’.

entity id_key
entity name_key
entity name_key in_cache

_make_unique_id (self, item)
Returns a unique id for the given model item (name-based). Used by receive_parameter_data_added.

add_items_to_db (self, rows)
Add items to db.

Parameters rows (set) — add data from these rows

_check_item (self, item)
Checks if a db item is ready to be inserted.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyObjectParameterVa.

Bases: spinetoolbox.spine_db_editor.mvcmodels.empty_ parameter._models.
EmptyParameterValueModel

An empty object parameter_value model.
Initializes lookup dicts.

entity class_type
Either ‘object_class’ or ‘relationship_class’.
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entity type
Either ‘object’ or “relationship’.

class spinetoolbox.spine_db_editor.mvcmodels.empty_parameter_models.EmptyRelationshipParams

Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter._mixins.
MakeRelationshipOnTheF1lyMixin, spinetoolbox.spine_db_editor.mvcmodels.
empty_parameter_models.EmptyParameterValueModel

An empty relationship parameter_value model.
Initializes lookup dicts.
_add_entities_on_the_fly = True

entity class_type
Either ‘object_class’ or ‘relationship_class’.

entity type
Either ‘object’ or “relationship’.

add_items_to_db (self, rows)
Add items to db.

Parameters rows (set) — add data from these rows

spinetoolbox.spine_db_editor.mvcmodels.entity tree_item

Classes to represent entities in a tree.
authors
P. Vennstrém (VTT), M. Marin (KTH)
date 11.3.2019

Module Contents

Classes
EntityRootItem A tree item that may belong in multiple databases.
ObjectTreeRootItem An object tree root item.
RelationshipTreeRootItem A relationship tree root item.
EntityClassItem An entity_class item.
ObjectClassItem An object_class item.
RelationshipClassItem A relationship_class item.
EntityItem An entity item.
ObjectItem An object item.
RelationshipItem A relationship item.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.EntityRootItem (model=None,

db_map_id=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item.

MultiDBTreeltem

A tree item that may belong in multiple databases.
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Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager

* db_map_data (dict) — maps instances of DiffDatabaseMapping to the id of the item in
that db

item_type = root

display id
“See super class.

display icon
Returns an icon to display next to the name. Reimplement in subclasses to return something nice.

display data
“See super class.

_get_children_ids (self, db_map)
See super class.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.ObjectTreeRootItem (model=None,
db_map_id=N

Bases: spinetoolbox.spine_db_editor.mvcmodels.entity tree item.
EntityRootItem
An object tree root item.
Init class.
Parameters

* db_mngr (SpineDBManager) — a database manager

* db_map_data (dict)— maps instances of DiffDatabaseMapping to the id of the item in
that db

item_type = root

child_item_type
Returns ObjectClassItem.

set_data (self, column, value, role)
See base class.

_get_children_ids (self, db_map)
Returns a list of object_class ids.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.RelationshipTreeRootItem (mode
db_n

Bases: spinetoolbox.spine_db_editor.mvcmodels.entity tree item.
EntityRootItem
A relationship tree root item.
Init class.
Parameters

* db_mngr (SpineDBManager) — a database manager

* db_map_data (dict)— maps instances of DiffDatabaseMapping to the id of the item in
that db

item_type = root
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child_item_ type
Returns RelationshipClassItem.

set_data (self, column, value, role)
See base class.

_get_children_ids (self, db_map)
Returns a list of object_class ids.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.EntityClassItem (*args,

**kwargs)
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree item.
MultiDBTreeltem

An entity_class item.
Overridden method to declare group_child_count attribute.

display_icon
Returns class icon.

_display_icon (self, for_group=False)

data (self, column, role=Qt.DisplayRole)
Returns data for given column and role.

_get_children_ids (self, db_map)
See base class

fetch_more (self)
Fetches children from all associated databases and raises group children.

raise_group_children_by_id (self, db_map_ids)
Moves group children to the top of the list.

Parameters db_map_ids (dict) - set of ids corresponding to newly inserted group children,
keyed by DiffDatabaseMapping

_raise_group_children_by_row (self, rows)
Moves group children to the top of the list.

Parameters rows (set, 1ist) - collection of rows corresponding to newly inserted group
children

remove_children (self, position, count)
Overriden method to keep the group child count up to date.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.ObjectClassItem (*args,

**kwargs)
Bases: spinetoolbox.spine_db_editor.mvcmodels.entity tree item.
EntityClassItem

An object_class item.
Overridden method to declare group_child_count attribute.
item_type = object_class

child_item_type
Returns Objectltem.

default_parameter_data (self)
Return data to put as default in a parameter table when this item is selected.
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set_data (self, column, value, role)
See base class.

_get_children_ids (self, db_map)
Returns a list of object_class ids.

class spinetoolbox.spine_db_editor.mvcmodels.entity tree_item.RelationshipClassItem (*args,
**ewargs
Bases: spinetoolbox.spine_db_editor.mvcmodels.entity tree_item.
EntityClassItem
A relationship_class item.
Overridden method to declare group_child_count attribute.
visual _key = ['name', 'object_class_name_list']

item_type = relationship_class

child_item type
Returns Relationshipltem.

default_parameter_data (self)
Return data to put as default in a parameter table when this item is selected.

set_data (self, column, value, role)
See base class.

_get_children_ids (self, db_map)
Returns a list of object_class ids.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.EntityItem (model=None,

db_map_id=None)
Bases: spinetoolbox.spine db_editor.mvcmodels.multi_db_tree item.
MultiDBTreelItem

An entity item.
Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager

* db_map_data (dict)— maps instances of DiffDatabaseMapping to the id of the item in
that db

display icon
Returns corresponding class icon.

member_ ids

member_ rows

db_map_member_ids (self, db_map)
db_map_entity_groups (self, db_map)
is_group (self)

data (self, column, role=Qt.DisplayRole)
Returns data for given column and role.

_get_children_ids (self, db_map)
See base class.
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class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.ObjectItem (model=None,

db_map_id=None)
Bases: spinetoolbox.spine_db_editor.mvcmodels.entity tree_item.EntityItem

An object item.
Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager

* db_map_data (dict)— maps instances of DiffDatabaseMapping to the id of the item in
that db

item_type = object

child_item type
Returns RelationshipClassltem.

default_parameter_data (self)
Return data to put as default in a parameter table when this item is selected.

set_data (self, column, value, role)
See base class.

_get_children_ids (self, db_map)
See base class.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_item.RelationshipItem (*args,

*rkwargs)
Bases: spinetoolbox.spine_db_editor.mvcmodels.entity tree_item.EntityIltem

A relationship item.

Overridden method to make sure we never try to fetch this item.
visual_key = ['name', 'object_name_list']
item_type = relationship

object_name_list

display data
“Returns the name for display.

edit_data

has_children (self)
Returns false, this item never has children.

default_parameter_ data (self)
Return data to put as default in a parameter table when this item is selected.

can_fetch_more (self)
Returns whether or not this item can fetch more.

_get_children_ids (self, db_map)
See base class

is_wvalid (self)
Checks that the grand parent object is still in the relationship.
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spinetoolbox.spine_db_editor.mvcmodels.entity tree_models

Models to represent entities in a tree.
authors
P. Vennstrém (VTT), M. Marin (KTH)
date 11.3.2019

Module Contents

Classes
ObjectTreeModel An ‘object-oriented’ tree model.
RelationshipTreeModel A relationship-oriented tree model.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_models.ObjectTreeModel (parent,
db_mngr,
*db_maps)

Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db tree_model.
MultiDBTreeModel
An ‘object-oriented’ tree model.
Init class.
Parameters
* parent (SpineDBEditor) -
* db_mngr (SpineDBManager) — A manager for the given db_maps
* db_maps (iter) - DiffDatabaseMapping instances

root_item_ type
Implement in subclasses to create a model specific to any entity type.

_parent_object_data (self, db_map_data)
Takes given object data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)— maps DiffDatabaseMapping instances to list of items as
dict

Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

_parent_relationship_class_data (self, db_map_data)
Takes given relationship_class data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)— maps DiffDatabaseMapping instances to list of items as
dict

Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

_parent_relationship_data (self, db_map_data)
Takes given relationship data and returns the same data keyed by parent tree-item.
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Parameters db_map_data (dict)— maps DiffDatabaseMapping instances to list of items as
dict

Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids
Return type dict

_parent_entity_ group_data (self, db_map_data)
Takes given entity_group data and returns the same data keyed by parent tree-item.

Parameters db_map_data (dict)— maps DiffDatabaseMapping instances to list of items as
dict

Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids

Return type dict
add_object_classes (self, db_map_data)
add_objects (self, db_map_data)
add_relationship_classes (self, db_map_data)
add_relationships (self, db_map_data)
raise_entity_groups (self, db_map_data)
remove_object_classes (self, db_map_data)
remove_objects (self, db_map_data)
remove_relationship_classes (self, db_map_data)
remove_relationships (self, db_map_data)
update_object_classes (self, db_map_data)
update_objects (self, db_map_data)
update_relationship_classes (self, db_map_data)
update_relationships (self, db_map_data)

find next_relationship_index (self, index)
Find and return next ocurrence of relationship item.

class spinetoolbox.spine_db_editor.mvcmodels.entity_tree_models.RelationshipTreeModel (parent
db_mr
*db_m
Bases: spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree _model.
MultiDBTreeModel

A relationship-oriented tree model.
Init class.
Parameters
* parent (SpineDBEditor)—
* db_mngr (SpineDBManager) — A manager for the given db_maps
* db_maps (iter) — DiffDatabaseMapping instances

root_item_ type
Implement in subclasses to create a model specific to any entity type.

_parent_relationship_data (self, db_map_data)
Takes given relationship data and returns the same data keyed by parent tree-item.
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Parameters db_map_data (dict)— maps DiffDatabaseMapping instances to list of items as

dict

Returns maps parent tree-items to DiffDatabaseMapping instances to list of item ids

Return type dict

add_relationship_classes (self, db_map_data)

add_relationships (self, db_map_data)

remove_relationship_classes (self, db_map_data)

remove_relationships (self, db_map_data)

update_relationship_classes (self, db_map_data)

update_relationships (self, db_map_data)

spinetoolbox.spine_db_editor.mvcmodels. frozen_table_model

Contains FrozenTableModel class.

author
P. Vennstrom (VTT)
date 24.9.2019

Module Contents

Classes

FrozenTableModel

Used by custom_qtableview.FrozenTableView

class spinetoolbox.spine_db_editor.mvcmodels.frozen_table_model.FrozenTableModel (parent,

Bases: PySide2.QtCore.QAbstractItemModel

Used by custom_qtableview.FrozenTableView
Parameters parent (TabularViewMixin)—

headers

parent (self, child=None)

index (self, row, column, parent=QModellndex())

reset_model (self, data, headers)

clear_model (self)

rowCount (self, parent=QModellndex())

columnCount (self, parent=QModellndex())

row (self, index)

data (self, index, role)
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spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item

Base classes to represent items from multiple databases in a tree.
authors
P. Vennstrém (VTT), M. Marin (KTH)
date 17.6.2020

Module Contents

Classes

MultiDBTreelItem A tree item that may belong in multiple databases.

class spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_item.MultiDBTreeItem (model=None,

db_map_id=Nc
Bases: spinetoolbox.mvcmodels.minimal_ tree_model.Treeltem

A tree item that may belong in multiple databases.

Init class.
Parameters
* db_mngr (SpineDBManager) — a database manager
* db_map_data (dict)— maps instances of DiffDatabaseMapping to the id of the item in
that db
item_type
Item type identifier string. Should be set to a meaningful value by subclasses.
visual _key = ['name']
db_mngr

child_item_ type
Returns the type of child items. Reimplement in subclasses to return something more meaningful.
display_ id
“Returns an id for display based on the display key. This id must be the same across all db_maps. If it’s
not, this property becomes None and measures need to be taken (see update_children_by_id).

display data
“Returns the name for display.

display database
“Returns the database for display.
display icon
Returns an icon to display next to the name. Reimplement in subclasses to return something nice.

first_db_map
Returns the first associated db_map.

last_db_map
Returns the last associated db_map.
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db_maps
Returns a list of all associated db_maps.

db_map_ids
Returns dict with db_map as key and id as value

add_db_map_id (self, db_map, id_)
Adds id for this item in the given db_map.

take_db_map (self, db_map)
Removes the mapping for given db_map and returns it.

_deep_refresh_children (self)
Refreshes children after taking db_maps from them. Called after removing and updating children for this
item.

deep_remove_db_map (self, db_map)
Removes given db_map from this item and all its descendants.

deep_take_db_map (self, db_map)
Removes given db_map from this item and all its descendants, and returns a new item from the db_map’s
data.

Returns MultiDBTreeltem, NoneType

deep_merge (self, other)
Merges another item and all its descendants into this one.

db_map_id (self, db_map)
Returns the id for this item in given db_map or None if not present.

db_map_data (self, db_map)
Returns data for this item in given db_map or None if not present.

db_map_data_field (self, db_map, field, default=None)
Returns field from data for this item in given db_map or None if not found.

_create_new_children (self, db_map, children_ids)
Creates new items from ids associated to a db map.

Parameters
e db_map (DiffDatabaseMapping) — create children for this db_map
e children_data (iter) - create childs from these dictionaries

_merge_children (self, new_children)
Merges new children into this item. Ensures that each children has a valid display id afterwards.

has_children (self)
Returns whether or not this item has or could have children.

fetch_more (self)
Fetches children from all associated databases.

_get_children_ids (self, db_map)
Returns a list of children ids. Must be reimplemented in subclasses.

append_children_by_id (self, db_map_ids)
Appends children by id.

Parameters db_map_ids (dict) — maps DiffDatabaseMapping instances to list of ids

remove_children_by_id (self, db_map_ids)
Removes children by id.
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Parameters db_map_ids (dict)— maps DiffDatabaseMapping instances to list of ids

is_wvalid (self)
Checks if the item is still valid after an update operation.

update_children_ by id (self, db_map_ids)
Updates children by id. Essentially makes sure all children have a valid display id after updating the
underlying data. These may require ‘splitting” a child into several for different dbs or merging two or more
children from different dbs.

Examples of problems:
* The user renames an object_class in one db but not in the others —> we need to split
* The user renames an object_class and the new name is already ‘taken’ by another object_class in
another db_map —> we need to merge
Parameters db_map_ids (dict)— maps DiffDatabaseMapping instances to list of ids
insert_children (self, position, *children)
Insert new children at given position. Returns a boolean depending on how it went.
Parameters
e position (int) - insert new items here
e children (iter) - insert items from this iterable

remove_children (self, position, count)
Removes count children starting from the given position.

clear_ children (self)
Clear children list.

_refresh_child_map (self)
Recomputes the child map.

find children_ by id (self, db_map, *ids, reverse=True)
Generates children with the given ids in the given db_map. If the first id is True, then generates all children
with the given db_map.

find_rows_by_id (self, db_map, *ids, reverse=True)

_find unsorted_rows_by_ id (self, db_map, *ids)
Generates rows corresponding to children with the given ids in the given db_map. If the only id given is
None, then generates rows corresponding to all children with the given db_map.

data (self, column, role=Qt.DisplayRole)
Returns data for given column and role.

default_parameter_ data (self)
Returns data to set as default in a parameter table when this item is selected.

spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_model

A base model class to represent items from multiple databases in a tree.
authors
P. Vennstrom (VTT), M. Marin (KTH)
date 17.6.2020
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Module Contents

Classes

MultiDBTreeModel Base class for all tree models in Spine db editor.

class spinetoolbox.spine_db_editor.mvcmodels.multi_db_tree_model.MultiDBTreeModel (parent,
db_mngr,

*db_maps)
Bases: spinetoolbox.mvcmodels.minimal_tree_model.MinimalTreeModel

Base class for all tree models in Spine db editor.
Init class.
Parameters
* parent (SpineDBEditor) —
* db_mngr (SpineDBManager) — A manager for the given db_maps
* db_maps (iter) — DiffDatabaseMapping instances

root_item_ type
Implement in subclasses to create a model specific to any entity type.

root_item
root_index

build_tree (self)
Builds tree.

columnCount (self, parent=QModellndex())

data (self, index, role=Qt.DisplayRole)
Returns the data stored under the given role for the index.

headerData (self, section, orientation, role=Qt.DisplayRole)

find_items (self, db_map, path_prefix, parent_items=(), fetch=False)
Returns items at given path prefix.

is_active_member_index (self, index)
set_active_ member_indexes (self, indexes)

emit_data_changed_for_column (self, column, parents)

spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins

Miscelaneous mixins for parameter models
authors
M. Marin (KTH)
date 4.10.2019
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Module Contents

Classes

Convert ToDBMixin Base class for all mixins that convert model items
(name-based) into database items (id-based).

FillInAlternativeIdMixin Fills in alternative names.
FillInParameterNameMixin Fills in parameter names.
FillInValueListIdMixin Fills in value list ids.
MakeParameterTagMixin Makes parameter_tag items.
FillInEntityClassIdMixin Fills in entity_class ids.
FillInEntityIdsMixin Fills in entity ids.
FillInParameterDefinitionIdsMixin Fills in parameter_definition ids.
InferEntityClassIdMixin Infers object_class ids.
MakeRelationshipOnTheFlyMixin Makes relationships on the fly.

Functions

_parse_csv_1ist(csv_list)

spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins._parse_csv_list (csv_list)

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.ConvertToDBMixin
Base class for all mixins that convert model items (name-based) into database items (id-based).

build_lookup_dictionary (self, db_map_data)
Begins an operation to convert items.

_convert_to_db (self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) - the model item

* db_map (DiffDatabaseMapping)— the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter_mixins.FillInAlternativeIdMixin (*arg
**kw
Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter._mixins.
ConvertToDBMixin

Fills in alternative names.
Initializes lookup dicts.

build_lookup_dictionary (self, db_map_data)
Builds a name lookup dictionary for the given data.

Parameters db_map_data (dict) - lists of model items keyed by DiffDatabaseMapping

_convert_to_db (self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).
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Parameters

e item (dict) - the model item

* db_map (DiffDatabaseMapping) — the database where the resulting item belongs
Returns the db item list: error log
Return type dict

class spinetoolbox.spine_db_editor.mvcmodels.parameter _mixins.FillInParameterNameMixin
Bases: spinetoolbox.spine_db_editor.mvcmodels.parameter._mixins.

ConvertToDBMixin
Fills in parameter names.

_convert_to_db (self, item, db_map)
Returns a db item (id-based) from the given model item (name-based).

Parameters

e item (dict) - the model item

* db_map (DiffDatabas